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Product definition

1 Product definition

1.1 Product catalogue

Product name: IP Control

Application: Visualisation, IP Gateway
Design: REG (series installation)
Order no.: 7571 00 04

1.2 Purpose

IP Control forms the interface between an Ethernet IP LAN (LAN = Local Area Network) and the
instabus KNX system. Via the Ethernet connection, users with a local PC connected in a LAN or
with another suitable LAN device, such as a Tablet PC, can access their instabus KNX system.

IP Control operates as a server and is used as a central control, messaging and control unit.
Configuration and operation are performed via the web browser of a PC with JAVA Runtime
Engine version 1.5 or higher.

Access is also possible via the Internet. The connection to the Internet can be established via
DSL, LAN (RJ45 port) with a router and a directory server.
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2 Assembly, electrical connection and operation

2.1 Safety instructions

Electrical equipment must only be installed and assembled by qualified electrical
engineers. Always follow the relevant accident prevention regulations.

Knowledge of the relevant network technology is required for installation.
The reduced bus voltage must not be used as a 10-30 V DC operating voltage.

The PIN of the device can be found on a sticker in these instructions and on the back of
the device. Keep the PIN in a safe place. If you lose the PIN you will no longer be able to
access the configuration tool. In this case the device will need to be sent in and reset.

If the device is used to establish a connection to the Internet then corresponding safety
measures must be implemented to protect the network against unauthorised access.

Failure to comply with these instructions may result in damage to the device, fire or other
hazards.

2.2 Design and layout of the device

-+
10-30 V DC
Berker

)

P

n.'\s-,r8 LAN %
(2) EIB 8 (3)
un O
(4) (5)

—DO o
(G)E

Fig. 1. Overview of the device

(1) Voltage supply 10-30 V DC
(2) Signal LED (operation)

(3) RJ 45 jack for Ethernet LAN
(4) Programming button KNX

(5) Programming LED KNX

(6) Bus connection terminal KNX
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2.3 Assembly and electrical connection

CAUTION!
Risk of destruction of the device.

Fault voltages can occur when working under live voltages.
Before making the electrical connections, de-energise the installation
environment.

Assembly of the device

=  Snap the device onto a top hat rail according to DIN EN 60715.

[il The device will heat up during operation. Observe the maximum operating temperature.
Ensure that adequate heat dissipation is provided.

Connecting the device (Figure 1)

=  Connect the bus line to the bus connection terminal (Figure 1, 6).

= Connect the voltage supply according to the markings on the screw terminals (Figure 1, 1).

[i] The non-reduced output of a KNX voltage supply can be used as the voltage supply.

=  Connect the network line (LAN) to the RJ 45 jack (Figure 1, 3).

[i] When using a direct connection to a PC, use a crossover network cable.

2.4 Installation

Getting the system ready for operation
= Switch on the bus voltage.

[i] IP Control requires no ETS application. It is not necessary to program the bus coupling
unit.

= Switch on the supply voltage.

During the booting phase, the POWER LED will light up orange for about 30 seconds. At
the end of the booting phase all of the LEDs are tested. Once the booting phase has been
completed the LED lights up/flashes green. The device is ready for operation.

Performing the basic configuration

The following steps need to be carried out in order to perform the complete basic configuration.

Establishing PC access to the IP Control via the network
Launching the configuration tool

Selecting the basic settings

Adapting Java settings
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Establishing PC access to the IP Control via the network
The device is ready for operation. A PC is connected.
®=  Find out and make a note of the current network configuration of the PC.

= Set up the network address of the PC in the range 192.168.1.x., e.g. 192.168.1.25. The
standard Subnet Mask for 192.168.x.x is 255.255.255.0.

[i] IP Control has been pre-programmed at the factory with the LAN IP address 192.168.1.10.
If another network device/user needs to use this IP address then it should be separated in
order to avoid network conflicts.

If you are not sure whether this IP address is already being used, a direct connection
between PC and IP Control via a crossover cable will avoid potential network conflicts.

®=  Launch the browser of your PC.
®" |nthe address bar, enter the IP address of the IP Control (192.168.1.10).

The home page of the IP Control will open. PC access to the IP Control has been
established.

Launching the configuration tool

PC access to the IP Control has been established. The home page of the IP Control has been
opened.

=  Click on the menu item System.
The input window for the device PIN opens.

=  Enter the device PIN.
An encrypted connection is set up. The IP Control login window opens up.

[il The PIN of the device can be found on a sticker in the instructions enclosed with the device
and on the back of the device. It is used to identify the IP Control and is unique. It cannot
be changed and is requested every time the configuration tool is accessed.

=  Enter your user name and password in the login window.
The following access data have been set at the factory:
User name: admin
Password: berker

The configuration tool opens up. The interface for the Configuration tab can be seen on
the screen (Figure2).

Fig. 2: Configuration tool
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[i] The access data for the administrator should be changed in the user administration after
establishing the basic configuration in order to prevent unauthorized access.

Selecting the basic settings

The configuration tool is open. The Configuration view is in the foreground.

= Click on the menu option General in the left-hand pane.

The current settings are displayed (Figure 3).

Fig. 3: General information window

= Assign a name in the IP Control Name field.

[i] With the aid of this name the device can be identified via a Discovery Tool if there are
several IP Controls in the network.

= Enter the physical address of the BCU for the KNX.
[il Observe the conventions for assigning physical addresses in KNX.
=  Click on the menu item Network Settings.

A window showing the current settings is displayed (Figure 4).

Fig. 4: Network settings window
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Assembly, electrical connection and operation

Assign an IP address.
The device can be reached under this IP address in the network.

Use an IP address from the network area in which your PC was previously embedded if
you wish to continue using this network area.

Check first that the address is not being used by a different subscriber,

Enter the subnet mask.

A standard subnet mask for local networks is 255.255.255.0.

Enter the IP address of the Standard Gateway.

Here you should enter the external IP address of the router located in the network.
Enter at least one DNS Server.

If DNS servers are used to resolve hames then the corresponding IP addresses should be
entered here. The addresses can be obtained from your Internet provider. Otherwise, on
many router models it is possible to enter the internal router IP address (DNS routing) as
the DNS server no. 1.

Click on Save data to save the new configuration and close the browser.

Die Anderungen werden Gibernommen. Dazu fiihrt das Geréat einen Neustart durch. A
corresponding message confirms that the changes have been accepted. Die Grundein-
stellungen sind abgeschlossen.

If necessary, adapt the network settings of your PC. Its IP address must be located in the IP
address range of the IP Control in order to reach the device.

When the IP Control is next called up you will need to enter the new IP address in the
address bar of the browser.

Adapting the reserved Java memory

Java Runtime Engine version 1.5 or higher is required.

To adapt the reserved memory, a parameter in the Java VM software needs to be changed or
added. Proceed as follows:

In Windows, cklick on Start = Settings =» Control Panel
Double-click on the Java symbol.
Click on the Java tab.

Click on Displays in the Java Applet Runtime Settings (Figure 5).
x|
fllgemein  Java I Sicherheitl Erweitertl

Java-Applet-Laufzeiteinstellungen

Die Laufzeiteinstellungen werden bei der Ausfihrung eines Applets im
Browser verwendet,

Laufzeiteinstellungen Fir Java-Anwendungen

Fig. 5: Java Control Panel - Java
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® In order to get more working memory for JAVA under Windows, enter the following
parameter: -Xmx128M (Figure 6).

128 MB of working memory is reserved for Java.

& 1ava Runtime-Einstellungen x|

Jawa Runkime-Yersionen

Produktname Yersion Adresse Jawa Runtime-Parameter
RE 1.6.0_03 IZ:\Programmel Javalir. ..
IRE 1.6.0_0A IZ:\Programme Jawaljr. .. |-Xmx126M

(0’4 I abbrechen

Fig. 6: Java runtime settings

Adapting the settings for temporary Internet files under Java

Program files and data which are obtained by Java via a network connection are normally
stored in a temporary memory location. Java accesses this stored content again if identical
program parts and/or identical contents are required in order to shorten loading times and spare
network capacities. However, this process gets in the way during installation, parameter setting
and maodification of the visualisation tool with IP Control. Any changes which have just been
made would not be executed immediately because Java uses saved, out-of-date data.

During the initial installation period, it is therefore necessary to prevent the system from saving
temporary files so that IP Control always accesses the current status. In principle, you can
continue working with these settings, but the saving of temporary files should be reactivated for
the visualisation tool during normal operation so that WebStart can be used for accelerated
startup of the visualisation.

= In Windows, cklick on Start = Settings =» Control Panel

®=  Double-click on the Java symbol.
JTeTE
Allgemein | Java | Sicherheit | Erweitert |

Anwendungsinfo
Yersionsinformationen zu Java Control Panel anzeigen,

Anwendungsinfo...

Netzwerkeinstellungen

Die Metzwerkeinstelungen werden beim Aufbau einer Internet-Yerbindung
verwendet, Java verwendet standardmalig die Netzwerkeinstellungen
Thres Webbromwsers, Diese Einstelungen sallken nur erfahrens Benutzer
andern,

Netzwerkeinstellungen. ..

Tempaorare Inkernek-Cakteien

Dateien, die Sie in Java-Anmsendungen verwenden, werden in einem
speziellen Ordner gespeichert, um spater schreller wieder aufgerufen
werden 2u kénnen. Mur erfabrene Benutzer sollken Dateien [Gschen oder

diese Einstellungen dndern.
AnZEigeR .. |

Fig. 7: Java Control Panel — general information
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u Click on the General tab.

=  Click on the field Temporary Internet Files and Settings (Figure 7).

Einstellungen Fiir tempor&re Dateien x|

[~ Temporére Dakeien auf Compuber belassen .

Speicherart

Speicherart ik lemporare [ateien:

lungeninils. eckardtianwendungsdaten|Suni Java\Deployment cache Amderr..., |

Festplattenspeicher

Kamprimerungsarad Fir J6R-Dateien: IKeine ﬂ

Grolie des Festplattenspeichers fir temporare Datefen:

J I IDDDE: ME

Dateien ldschen. .. | Standardeinstellungen wiederberstelen |

QK I abbrechen |

Fig. 8: Temporary file settings

®  Uncheck the box marked "Leave temporary files on computer".
= Click on "Delete files...".
®=  Click on OK to confirm.
You will then return to the Java Control Panel.
= Click on OK to exit the Java Control Panel.
You will then need to restart your browser in order to enable the settings.

=] e

In order to be able to use the function WebStart after installation to accelerate the
visualisation startup procedure, you will need to undo this setting and reactivate the
checkbox again.

Setting up Java Web Start

The goal of this function is to allow more convenient and quicker work with IP Control.
[i] Before you use Web Start, the device should already be configured.

Web Start is a technology that is made available by Java. It makes it possible to start a Java
application directly without using a browser. The required program parts are administered on
the local PC. Updating is only performed when it is determined that new packages are available
from the IP Control.

The setting Leave temporary files on the computer is activated (see section Adapt settings
for temporary Internet files under Java).

= Open the browser and call up the home page of the IP Control.
= Click Web Start at the bottom of the navigation menu.

The Web Start configuration page opens. The IP address and port number have already
been entered.
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[il If you wish to use the IP Control with Web Start via an Internet connection, then please
enter the DynDNS address of the router here, and the http port number under which the IP
Control can be reached via the Internet.

= Click on "Install".
The dialog for downloading Web Start opens.

Fig. 9: Download dialogue for Web Start

= Select Open with and click on OK.

The file that is generated is then executed with the Java Web Start Launcher; a new
window opens with the configured start page. The menu items "Visualisation" and "Editor"
are visible.

[i] Later you can start Web Start directly by
— Via a shortcut (symbol) on your desktop. This is placed on the desktop during the Web
Start installation (Fig. 10).
— Via Start > Programs > Berker Apps > Berker IP Control Application.

Fig. 10: Desktop link for Web Start
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3 Application

No special software is required for the configuration of IP Control. For example, if you establish
a connection via a PC with IP Control then IP Control will make all the necessary components
required to assign the application data available to a standard Internet browser (Java Runtime
Engine version 1.5 or higher). You can configure the following internal functions for services.

Internal services

—  Visualisation

—  Clocks

—  Calling up network cameras
—  Logic

- WAP communications

— EIBlib/IP and KNXnet/IP

— Data collector

—  Light scenes

—  Fault message via e-malil

Applications

for automation

—  Clocks

- Logic

—  Light scenes

for monitoring

—  Visualisation

—  Communications

—  Data collector

— Netcam

—  Mobile phone visualisation with status feedback
— Integrated Bus Monitor

for remote switching
—  Visualisation via the Internet
—  Visualisation on a mobile phone

for maintenance

—  Communications

—  Data collector

—  EIBlib/IP and KNXnet/IP
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First steps

4 First steps

IP Control is equipped with a Web Server and incorporates a number of Java Applets. You can
edit their services when they are called up via the browser and save them permanently in the IP
control.

= Call up an Internet browser on e.g. your PC platform.

[il The following browsers can be used:
— Internet Explorer version 5 or higher
— Netscape version 4.77 or higher
— Konquerer from KDE 3.0
—  Mozilla Firefox

[i] Java Runtime Engine version 1.5 or higher must be installed and capable of running on all
browsers.

= After installing the IP Control, write the following URL in the address bar:
http://192.168.1.10 (default setting).
Alternatively, you can choose the IP address of the IP Control which you have changed.

The start window with the main menu appears. From here you can access the Visualisation
tool, the Editor and the Configuration Tool (system) of the IP Control.

Fig. 11: Start window

WARNING!

A Suitable additional measures must be put in place if there are special
requirements or arisk of injury or material damage which must be avoided
(functional safety).

These measures must have the required level of independence from the
operation of the IP Control and must always be available.

Risk reduction measures can be found e.g. in the tables entitled "Functional Safety" in the
"Building Services Engineering Systems Handbook — Fundamentals" from ZVEH/ZVELI.
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4.1 Passwords

Access to the Visualisation Editor and the System is protected with user names and
passwords. The passwords can be edited via System. The following default passwords are

active on delivery:

Area User name Password:
Visualisation Editor admin berker
System admin berker

[i] When you wish to change a password you will be prompted to enter the new password
twice. This prompt does not appear when no password is entered.
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page 15/176




Visualisation

5 Visualisation

Fig. 12: Visualisation homepage

The Visualisation button is used to access the selection of available visualisation interfaces.
The following are available: the two visualisation interfaces (external window and embedded) as
well as the IP Control Tablet Visualisation and the IP Control Mobile visualisation. Every
visualisation interface can be protected via the User Administration. This function is not
activated on delivery.

[i] To close the selection window, click on Visualisation again.

5.1 Visualisation
The visualisation can be called up in two different modes:

—  External window: the visualisation is opened in a separate window.
— Embedded: the visualisation is opened in the browser window which is currently open.
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Visualisation

LEGENDE:

Red area:
Visu ToolBar

Green area:
Page index

Blue area:

Visualisierungs-
oberflache

Fig. 13: Visualisation in an external window

Depending on the settings, the Visualisation ToolBar and the page index open together with the
visualisation. (See Fig. 14).

Key:

The project pages are shown in the left-hand pane of the window. On the division between the
page index and the visualisation there are small arrow symbols with the aid of which the
respective view can be displayed or hidden. If the page index is deactivated in the project
settings of the editor then it is not displayed in the visualisation.

Visualisation ToolBar

The Visualisation ToolBar is positioned above the visualisation. It simplifies navigation in the
visualisation. The ToolBar and its functions are configured in the project parameters in the
Visualisation Editor.

\_‘ Change page Restart, exit ’—‘

Change project
Kiosk mode
\_| Navigation

Fig. 14: Visualisation ToolBar

[i] The Visualisation ToolBar is not displayed in the IP Control Tablet Visualisation. It is only
intended for the Java Visualisation.

Navigation

The navigation enables the user to scroll through the project pages, while the house symbol can
be used to jump back to the homepage of the project at any time.
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Kiosk mode

With the aid of this button, the kiosk mode can also be activated while the visualisation is active.
The ToolBar settings and page index settings are retained.

Change project
If multiple projects have been created then this function can be used to switch between them.
Change page

All of the pages of the project are displayed. The change can be performed either via the arrows
or via the page overview. The latter appears when the page name is clicked.

Change user

If the User Administration is activated for the visualisation then it is possible to switch between
individual users without restarting the visualisation. All user names are displayed if you click on
the user who is currently logged in.

Restart/exit

This button exits or restarts the visualisation. After a restart the user will be asked to log in
again.

5.2 Important information
BMX protocol

The port for the BMX protocol is required for the visualisation. In the event that it is not enabled
(port routing), for example during access via the Internet, operation or feedback information via
the visualisation will not be available. The BMX port has the default number 1735. However, this
can be changed in the Configuration Tool (System > Configuration > Expanded EIB (yabus)
Settings).

Java cache

If the Java cache is activated while the visualisation or other parts of the IP Control are being
configured then it can happen that the visualisation stops being displayed correctly after a
certain amount of time. The Java cache accesses temporary files which are no longer current.
Delete the cache and open the browser again. (See "Adjusting Java Settings” > "Temporary
Internet File Settings").

Time stamp

If the time of the IP Control is no longer correct then the current telegrams and statuses are
saved with an incorrect time stamp in the State Table. As a result, the visualisation will have
incorrect reference times for evaluating the telegrams. This will lead to incorrect status displays.
Delete the State Table and restart the IP Control. (Refer to the "File" section under "IP Control
Editor").

5.3 IP Control Tablet Visualisation

IP Control Tablet Visualisation offers a visualisation option for devices which do not support
Java. IP Control Tablet Visualisation is platform-independent and can therefore be used for
Web Pads (e.g. iPad), mobile phones or even standard PCs. The IP Control Tablet Visualisation
is generated from the same data as the Java Visualisation. However, not all of the elements and
functions from the Java Visualisation are supported.
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Requirements

In order for the IP Control Tablet Visualisation to be displayed on a Client, it will need to support
Java Script. The necessary data in IP Control are generated when the visualisation project is
saved. For this purpose, the user is asked for which project the IP Control Tablet Visualisation is
to be generated. The IP Control Tablet Visualisation and the Java Visualisation use the same
user logon.

Important information
Support for the individual functions and elements

A clear overview of the supported functions and elements of the IP Control Tablet Visualisation
is presented in a table in the section entitled "Editor".

Setting up a connection/simultaneous connection

The IP control tablet visualisation is a server-related application. In contrast to Java, the
visualisation client queries the current status on the server regularly. We say that the client is
"polling”. This polling particularly limits the performance of the server, thus the number of the
simultaneous connection is limited according to the utilization level of the other resources.

The establishment of the connection can be optimised by browsers that support so-called
"Websockets". For this purpose, there is the possibility to call up the visualisation in the IP
control (see chapter "Configuration Tool" > "Configuration" > "Extended yabus (EIB) settings").

Use HARDware acceleration / css 3 Animations

The Browser Mobile Safari on Apple devices such as the iPad and iPhone does not use any
hardware acceleration for simple animations. For this reason, a jerky presentation might occur
with the slide effects. To avoid this, the IP control tablet visualisation supports CSS 3
transformations. As a result, animations are presented more smoothly because the hardware
acceleration is reverted to in this case. The activation takes place automatically once the IP
control tablet visualisation detects a corresponding browser. The application of CSS 3 can,
however, adversely affect the operation in the case of some terminals or browsers. To
deactivate CSS 3 in this case, a context menu that is displayed during the first 10 seconds is
provided in the bottom right corner in the visualisation. The logout from the visualisation can
also be initiated in this menu.

Figure 15: IP Control Table visualisation — context menu

5.4 |IP Control Mobile

IP Control Mobile is another visualisation which works without Java support. Its design is
deliberately simple and clearly laid out in order to make allowance for the small size of the
displays on mobile devices.
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Fig. 16:1P Control Mobile on the iPhone

Calling

The IP Control Mobile can also be called directly from a browser. The URL is:
http://<IP of the IP Control>/ipcm

Authentication

The user authentication for the IP Control Mobile is set in the Configuration Tool ("System" >
"User Administration"). Further information can be found in the section entitled "IP Control
Mobile".

Simultaneous connections

The number of simultaneous connections depends on the design of the system and the other
tasks of the IP Control.
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6 Editors

Fig. 17: IP Control - Homepage — Editor

The Editor is used to program the IP Control and generate the visualisation. It is divided into 4
different Editors:

Visualisation Editor

This Editor is used to create the visualisation for Java and IP Control Tablet. It consists of at
least one project and one page and can be protected via the User Administration. During
saving, the data for both the Java Visualisation and for the IP Control Tablet Visualisation are
generated (optional).

Job Editor

In the Job Editor you can configure the services which are to be executed by the IP Control. An
overview of the individual job types can be found in the corresponding section.

WAP Editor

The WAP pages are created and parameterised in the WAP Editor. With the aid of WAP it is
possible to send EIS 1 telegrams and have the status of EIS 1 objects displayed.

IP Control Mobile

Here the pages for the Visualisation IP Control Mobile are configured. IP Control Mobile works
with all standard mobile phone models, PDAs with Mobile Java (J2ME) or PCs with Microsoft
Windows Multimedia Center Edition (MCE). In contrast to WAP, different EIS types and camera
images can be embedded.

6.1 Things you need to know before starting

Group addresses - virtual and real

The IP Control offers a virtual address space. It ranges from 16/0/0 to 31/7/255. These
addresses are not sent to the bus. They ensure that jobs are linked to each other or that
visualisation elements are linked to jobs and vice versa. In this way, real address space is
saved, but the behaviour of the IP Control also changes: if real group addresses are used for a
job even though no real KNX subscriber exists for them, this can result in significant delays in
the program flow.
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The KNX bus system is designed to expect "ACK" as an acknowledgement for every telegram.
If this does not happen then the corresponding telegrams are repeatedly repeated. In the case
of a very "telegram intensive" job like the "SB Control", this can lead to significant delays in the
processing of the telegrams. This can be reduced wherever no real bus subscribers exist by
using virtual group addresses.

Communication objects

The IP Control replicates the structure of the communication objects of the KNX. This means
that up to 5 group addresses can be assigned to each object. In this way, the allocation of a
group address of e.g. an actuator channel can be directly replicated. This keeps IP Control
informed at all times about the actual status of the actuator (not the group address), thus
negating the need for complex working with return messages. This approach simplifies the task
of creating logical links, as up to 5 group addresses can be assigned to each input object of the
gates. In this case, all five group addresses can be allocated in the ESF dialogue. In the
process, they are automatically entered with the correct syntax in the selected object field.
However, in the case of outputs it is only possible to enter one address.

General Syntax

After the first group address, the remaining addresses should be placed in parentheses and
separated with commas.
Example: 2/12(2/13,2/14,2/15,2/16)

The Editor window is loaded during the initial start-up with the Visualisation Editor. The change
between the Editors takes place within this window. Basic settings are implemented in the menu
bar of the Editor window.

Fig. 18: Editor window - all Editors
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ETS 4 Compatibility

[i] Attention:
Limited compatibility to ETS4! In the ETS4, please only use the group address structure in
the normal three-stage or two-stage ETS2/3. An application with the extended group
address area or free group address structure is not possible.

6.2 Menu bar of the Editor window

The Editor window has a menu bar for the basic settings. This can also be used to change
between the editors and load data to the IP Control. All editors can be opened at the same time.
Minimised windows are shown at the bottom left edge of the Editor window. The address via
which the connection to the IP Control is established is shown in the lower bar on the window.

Fig. 19: Editor window - menu bar

File

The File menu is used for general settings, opening the Save dialogue or closing the Editor.

Fig. 20: Editor - menu bar - File

Localisation

The term 'localisation’ is used to describe the process of adapting software to the relevant
language environment. Language files are available in English and German. The language files
can be "downloaded" onto the user's PC.
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Fig. 21: Editor - localisation dialogue

The same dialogue can be used to import language files into the IP Control. In the "Upload"
dialogue the file is linked to the corresponding language code. The language setting needs to
be changed accordingly in the Java control panel so that Java uses the correct language file.
The localisation dialogue needs to be enabled with the character string of the IP Control.

[i] The localisation file must be saved in the character code UTF-8.

[il The enabling via character string always applies per Editor session and also applies to all
other dialogues which need to be enabled via character string.

Address levels

[i] The group addresses are displayed in the editors either with two or three digits. In the
Visualisation Editor, previously existing group addresses are converted if required.. This
does not happen in the Job Editor.

The Editor must be restarted for the changes to take effect.
Clock time of the IP Control

The internal time and date of the IP Control are queried under "Adjust Time". The first row
shows the current date and the time of the IP Control. In the row underneath you can adjust the
date and time. This is done either directly via the keyboard or via the button "Set to PC Time".
The latter transfers the current time from the user's PC to the IP Control.

Fig. 22: Editor - Setting the time
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Resetting the Client Settings

—  This function is used to reset the following user-defined settings to the default values:
— the position of the Editor windows and their sizes;

the start-up settings of the windows;

— whether or not the Save dialogue is displayed when the Editor window is closed;

the directory in which the backups are saved.
This function does not affect any other settings.
Deleting a telegram record

The IP Control has a ring buffer which can be used to record up to 500000 telegrams. These
telegrams are read out for the visualisation graph. This function deletes the record immediately.
The IP Control does not need to be restarted.

Deleting the State Table

The last status of all assigned group addresses is saved in this table. These data define the
behaviour of the visualization and the jobs which are created in the IP Control. The last status is
determined on the basis of a time stamp of the telegram. The State Table can be deleted
without needing to restart the IP Control.
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Window

The Window menu is used to call up an editor or switch between editors. In addition, there is a
link to the configuration interface of the IP Control (Configuration Tool).

Fig. 23: Editor — Window menu

Visualisation Editor

The Editor window for designing the visualisation interface is opened.

Job Editor

This editor window is used to configure and parameterise the Jobs (services) of the IP Control.
WAP Editor

The functions which are to be controlled via WAP are defined in this editor window. Only EIS 1
can be used here.

IP Control Mobile

Mobile phone visualisation is best realised using IP Control Mobile. The interface is set up with
this editor.

Configuration Tool

The Configuration Tool can normally be accessed via the IP Control homepage under "System".
The configuration of the IP Control is set up here. This link is used in order to be able to
configure directly from the editor. The IP Control character string is requested for access to the
Configuration Tool.

Tools

The Tools menu is used to load important files (ESF, pictures, freely definable switches) into
the IP Control or to delete them. In addition, the State Table and History (i.e. telegram records)
can be displayed.

Fig. 24: Editor — Tools menu

ESF upload & data management

All of the group addresses, their EIS types and identifiers are saved in the ESF file. This file is
generated in ETS 3.0 via File > Data Exchange > Export to OPC Server. The data of the ESF
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file correspond to the project which was created in the ETS. If the file is loaded to the IP Control
then the assignment and overview of the group addresses is simplified.

Fig. 25: Editor — ESF upload & data management

The address data also need to be managed in the dialogue for the virtual group addresses or
for changes to the existing master address file. It is also possible to enter new addresses and
identifiers during the project planning.

[i] If changes have already been made to the ESF file in IP Control and a newly generated
one is uploaded from the ETS then the changes will be overwritten by the new file!

Buttons

— Close Tree/Open Tree: a 'tree' is the complete address space of the ESF. If the tree is
closed then only the main groups are shown; if it is open then all of the groups and their
addresses are displayed. The views can also be opened or closed by clicking with the
mouse on the corresponding arrow symbol (on the left at the edge of the window).

— Open Node: a 'node' is the address space of just one main group. For a clearer overview,
this can be used to open just part of the otherwise closed tree.

— Add Data: this function is used to enter addresses which do not exist yet into the ESF file.
The address and the identifier can be entered.

— Change Data: the identifier can be changed for the highlighted address - but not the
address itself.

— Delete Data: the selected group address is deleted from the ESF file.

—  Save ESFx File: this saves the ESF file from the IP Control as an ESFx (xml type) into an
arbitrary directory.

— Upload ESF File: this opens a file browser so that the user can select the required ESF file.
When the user clicks on "Upload" the file is immediately loaded without further
confirmation.

Order no. 7571 00 04 page 27/176



Editors

Transfer Pictures

In this dialogue the pictures which are required for the visualisation are loaded to the IP Control
and managed. The pictures can be sorted in different categories or deleted again.

Fig. 26: Editor - Transfer Pictures

Select picture:

The uploaded pictures are managed in this tab. If a picture is selected then the information for
the picture is displayed in the "Preview" pane on the right-hand side. The picture can be
assigned to an existing or new category via "Category". The categories and the associated
pictures are displayed in the "Pictures" pane on the left-hand side. The selected picture can be
deleted by pressing the "Delete picture" button.

Upload picture:

This tab can be used to upload pictures. To do this, select a file in the right-hand part of the
window and give it a title. The picture is assigned to an existing category via "Category". The
picture information is displayed immediately after the picture is selected.

[i] The "Statistics" field shows the maximum permitted file size and the current memory used
for the pictures. The selected file is directly uploaded via "Upload".

Freely definable switches

This dialogue is used to load the switches which were created with the Component Builder into
the IP Control. Own switches and pictures are given the required functions in the Component
Builder.
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Fig. 27: Editor - Component Upload

Information:

To upload a switch it is highlighted via the file browser logo behind "File" in the corresponding
directory or dragged and dropped to the visualisation interface (Drag & Drop). A clear name
should be assigned to the file so that it can be clearly identified at any time. If the file size is
bigger than 100kb then a warning message is displayed to warn the user that a large file may
result in longer visualisation loading times.

Freely definable switches:

All files which have already been uploaded are shown in this window. The window shows the
name given to the switch during uploading and a "Delete" button which can be used to delete
the switch again.

Statistics:

The Statistics field shows how much memory has been used, as well as the overall memory
space which is available for freely definable switches and how much of it has been used.

History & State Table

The IP Control records the last 20,000 telegrams (ring buffer) in a table. The State Table shows
the current states of all group addresses.. If an address has not been used yet then no status is
assigned. The current status is determined for the time at which the telegram was received. The
State Table and the History (i.e. records table) are also saved during a backup.
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Fig. 28: Editor - State Table

Refresh:

Next to this button you can choose between History (i.e. the records table) and the State Table.
The "State Table" is the table which shows the states, while "History" is the table with the
records. Pressing the "Refresh” button initially loads the current data into the tables, and the
information is then displayed.

[i] Display: The data are shown sorted by date. On the right-hand side you can select or
deselect the checkboxes to choose which data fields you would like to be displayed. At the
border between the table pane and the data field selection there are some arrows with
which either of the views can be minimised.

Themes

All of the elements and icons of the IP Control software can be swapped using so-called
themes. You can either develop your own themes or use existing ones. The "Theme Editor" tool
is available for editing themes and for loading them from the IP Control. The theme files can
then be loaded via "Themes" to the IP Control. The changes will become effective the next time
the editor is restarted.

Fig. 29: Loading themes
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Loading themes:
The required themes file is selected from the hard disk in the file browser (file extension: *.thm).
Deleting a theme:

If the loaded theme is no longer required it can be removed again via the "Delete" function. The
system then uses the default theme.

[il Further information about the Themes Editor, e.g. about the graphics sets, can be found on
the CD which was provided with the IP Control.

Help

The Help menu only contains this one item:
Info

This dialogue shows the most important information about the IP Control. In the event of any
problems, a quick overview of the key data and settings is displayed here.

x

BERKER B
IP-CONTROL Bo rke'r
IP-Control Mame Berker IP-Control
Firmware yabus 1.4.0-pre2
Seriennr. BT0900019811

IP Adresse 192.168.1.10

HTTF Port 80

SSH Port 22

BMX TCF Port 1735

BMX UDF Port 1735

Client Java Version  1.6.0_22
OK

Fig. 30: Editor — Help > Info

The following are displayed:

— IP Control Name: this is assigned in the Configuration Tool.

—  Firmware: the Firmware version is displayed - this can also be seen in the Java Console.

—  Serial no.: the serial number of the device - this is also displayed in the Configuration Tool.

— IP Address: this can be changed in the Configuration Tool under Configuration > Network
Settings.

— Ports: these can be changed in the Configuration Tool under Configuration > Extended EIB
(yabus) Settings.

— Client Java Version: this displays the Java version of the Client PC.
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6.3 Visualisation Editor

The view and functions of the visualisation are configured with this editor. In the process, a
visualisation is generated via pages in projects. Multiple projects are possible. The visualisation
function can be simulated within the editor via the "Visu-Live Mode".

Fig. 31: Editor — Visualisation Editor

[i] Every button in the visualisation is given a so-called tooltip. If you hover over a field with
the mouse pointer then the corresponding Help text is displayed.

Menu bar of the Visualisation Editor

The central control elements for creating the visualisation are positioned in the menu bar of the
Visualisation Editor.

Fig. 32: Editor — Visualisation Editor menu bar
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Save/Reload

Whenever any changes are made the visualisation should be saved by clicking on the diskette
symbol. To call up the current memory status again use the blue arrow ("Reload"), as the Client
PC only provides an image. The changes are saved in the IP Control.

[i]l If more than one person attempts to make changes at the same time then the user who
saves last will define the status. This means that a user who has made no changes but
saves last will overwrite all previously saved changes with his old status.

Visualisation/Security Settings/Allocation Plan Module

These three buttons are used to change the view. By default the Visualisation Editor is set to
the view "Visualisation". Under "Security Settings" you can create users and define their rights.
The "Allocation Plan" button is used to open the editor area for the Allocation Plan module.

New Project/New Page

A new project or a new page is created. A visualisation comprises at least one project and one
page.
Grid/capture/colour

A grid can be overlaid onto the editing area of the visualisation so that it is easier to position the
elements. The grid is not displayed on the actual visualisation. The grid size is given in pixels. In
addition, it is also possible to define the colour of the grid. The "Capture" option is used to
automatically align the visualisation objects to the grid.

Distribute Objects/Align Horizontally/Align Vertically

With the aid of these functions, objects which have already been selected are arranged at equal
distances on the visualisation. Each button has a context menu with the aid of which the
selected object group can be positioned in different places.

Visu-Live Mode

If the Live Mode is activated the Editor simulates the visualisation. The jobs which are linked to
the visualisation elements are also executed so that all states can be correctly displayed in the
visualisation.

[i] In the Visu-Live Mode, telegrams are also sent to the bus. Consequently, actions in this
mode can also result in switching operations. By contrast, changing pages due to a fault
message or camera event does not work.

Window layout

The Visualisation Editor is the most complex of all windows in the editor. The window is divided
into the four panes Structure, Elements, Working Area and Parameters.
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Structure

The "Structure” window contains an outline view of your visualisation. A visualisation comprises
at least one project with at least one page. In addition, a project can also contain Master Pages
and Flip/Dialogue Pages. The Structure window is located in the top left-hand area of the user
interface.

Fig. 33: Visualisation Editor - "Structure" context menu

Operation

The context menu which is accessed via the right-hand mouse button is used to create New
Projects, Master Pages, Flip Pages and Pages. Projects and pages can also be created using
the two buttons in the menu bar. Once they have been created, the view can be used in the
same way as the directory tree in a file browser. The arrows in front of the folders can be used
to close or expand them.

Parameters

Once a structure has been created, the parameters of the projects/pages can be set in the
Parameters pane on the right-hand side. The parameters vary depending on the selection in the
structure.

Copy/Cut/Paste/Delete

Every element in the structure can be copied/cut, deleted or pasted via the context menu. The
"Copy" function can be used to speed up the process of configuring a visualisation process. It is
important to note that a copied element is initially given the same title as the original element.

Mouseover Help

A tooltip is available for more information about the elements.. This is a small window which
opens if the mouse pointer is briefly held over the corresponding element. It contains a short
and concise explanation of the function of the parameter.
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Elements

The Elements window is located underneath the Structure window. Both the standard elements
and the free components (if uploaded) are listed in the elements. To place an element in the
working area, simply click on it. It is automatically placed in the centre of the working area, and
the specific Parameters window opens up on the right-hand side.

Fig. 34: Visualisation Editor - Elements

IP Control Tablet support

A blue/light blue bar is sometimes shown to the right of the elements. This indicates to the user
which of the elements are supported in the IP Control Tablet Visualisation and which are not
supported or are only partially supported. The blue bar indicates full IP Control Tablet support,
the light blue bar partial support. If there is no bar at all, this means that the element is not

supported.

Order no. 7571 00 04 page 35/176



Editors

Parameters window

In this window the user makes all of the settings which relate to the currently selected project,
the page or the element.

Fig. 35: Visualisation Editor - Parameters

Global and specific parameters

A distinction is made between global, generic and specific parameters. Global parameters apply
across all projects and can be defined at a single position. Generic parameters constantly
repeat on all elements. Specific parameters are to applied to one specific element only.
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Working area

The actual visualisation interface is edited in the working area. As soon as a page has been
created, a field appears which can be changed via the Parameters Window.

Fig. 36: Visualisation Editor - working area

Operation

The usual keyboard commands can be used in the working area. For example, multiple
elements can be selected by pressing Ctrl and clicking on them with the mouse, and they can
then be copied by pressing Ctrl + C and pasted by pressing Ctrl + V. A context menu is also
available via the right-hand mouse button.

Visu-Live Mode

If the Visu-Live Mode is activated then the working area automatically serves as a visualisation
interface, and all elements can be operated.

[i] Caution! Real switching operations will be performed in the process.
Frames

The area outside the visualisation interface is the so-called frame. This is displayed if the screen
resolution of the Client is greater than the resolution of the visualisation project. Consequently,
the frame colour can be adapted to the background colour of the page. You can also define how
the visualisation interface should be horizontally and vertically aligned (project parameters).

Multiple projects

A visualisation always comprises at least one project and at least one page. However, it is also
possible to create multiple projects, e.g. for different buildings. During the startup or during the
visualisation itself, it is then possible to change between the projects. If a user login is active
then only the projects to which the user has access rights are available..

Detaching windows

The properties windows are positioned to the left and right of the working area (Elements
Window and Parameters Window). Depending on the size of the visualisation area and the
screen resolution of the editing computer, some users may find that these windows get in the
way. If this is the case then these windows can be "detached" from the Visualisation Editor. The
windows are detached by clicking on the grey header field. The window then becomes an
independent window on the task bar of the operating system and can be freely positioned. The
window can be permanently embedded again by clicking on the header field once more.
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Fig. 37: Editor - Detaching windows

Free resizing of elements

All elements in the visualisation are freely resizeable. In order to resize an object it is either
enlarged or made smaller via the corresponding marker points with the mouse. Alternatively, the
size can be changed via the Parameters Window on the right-hand side (the object must be
selected first). If the checkbox for "Retain Page Ratio" is ticked in the Parameters Window then
it is no longer possible to resize the element one-sidedly with the mouse. The option "Distortion-
free" determines whether or not the contents of the elements are resized with the background.
The "Soft Draw" option causes the element to shown in soft focus (i.e. blurred) during resizing.
Otherwise the resizing process can cause it to look very "pixelly”. The "Auto-resize" option can
be enabled on elements which also contain text in addition to a symbol. If this is enabled, the
font size is automatically adjusted to match the size of the element.

Copy/Paste/Delete

Visualisation elements can be copied, pasted or deleted together with their parameters. Right-
click on an element in the Visualisation Editor and select "Copy", "Paste" or "Delete".
Alternatively, the keyboard shortcuts Ctrl+C (Copy) and Ctrl+V (Paste) are also available, along
with the Delete key for deleting.

Drag & Drop

In order to quickly place pictures or free components (switches from the Component Builder) in
the visualisation, they can simply be dragged & dropped from another program window into the
Editor Area. When you "let go" of the file the corresponding dialogue for uploading the file is
automatically opened. All of the required information has already been entered. You then only
need to press the "Upload" button. Once the file has been uploaded it is automatically placed on
the corresponding visualisation page.
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Projects and Pages

The structure of a visualisation project is made up of so-called "Projects" and "Pages". There,
the individual parameters which are defined by the projects and pages are described.

Projects

The general project settings are defined in the Parameters Window of a project. This window
opens when the desired project is selected from the project structure.

Fig. 38: Visualisation Editor - project parameters

— Name: Name of the project.

—  Start Page: The selected page is displayed when the visualisation project is started.

— Display Page Index: If this option is enabled a page index is displayed at the side edge of
the visualisation; this can then be used to directly call up the visualisation pages.

—  Kiosk Mode: If this option is enabled the visualisation starts in full screen format. This mode
is used particularly in cases where the visualisation must not be closed (public access).

— Display Connection Problems: If this option is enabled any connection problems between
the Client computer and the IPC Control are indicated in the visualisation (red bar at the
bottom edge of the Visualisation window).

—  Colour Filter: The colour filter used to change the colour of the element graphics. The
background of the element is not affected as a result. The preview shows what the graphic
looks like when the object is actuated or not actuated. Three filter pre-settings are
available.
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Fig. 39: Editor — project colour filter settings

— Fade Between Pages: The transition from page to another can be configured with a fader.
This parameter defines the duration of the effect in milliseconds.

—  Soft Fade: This produces a soft fading effect and prevents potential flickering during fading.
On a slower computer the fade seems even softer.

[il During the fadeover no switching operations can be performed.

—  Optimise Memory: Only the elements of the visualisation page which is currently called up
are loaded. Less memory is required as a result, although the loading times for the pages
are increased slightly.

Object Style Configuration: Universal settings for design of the elements across the
entire project. An individual style can be assigned to every element via the Element
Properties:

No Background: all elements are drawn without a background and/or are transparent.
Background Theme: The Background Theme is defined in the Theme Editor and can
be defined globally for all elements via this option so that a standard 'look’ or style is
achieved across the entire project.

Background Colour: The colour selection field can be used to select a monochromatic
background.

Colour Ramp: A two-tone colour ramp can be selected via the two fields.

Alignment: The colour ramp can be implemented "vertically" or "horizontally".

CoIour The colours can be selected via the corresponding fields behind the lettering.

—  These settings can be changed individually for each element (Element Parameters).
— Visualisation Alignment: This can be used to align the user interface of the visualisation in
the Visualisation Window.

Visualisation Toolbar: Ticking the relevant checkboxes defines which of the Visualisation
ToolBar menus are displayed in the visualisation or whether the ToolBar is displayed at all.
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Master Pages

For most projects, the basic properties of a page are constantly repeated. To prevent the need
for setting up these parameters again for every project page, so-called master pages can be
created. However, it is also possible to ignore these pre-selected properties again in the
Parameter Options of the pages.

Fig. 40: Visualisation Editor - parameters of the Master Page

Settings in the Master Page:
—  Size: The Master Page defines the size of the pages. This setting cannot be ignored when
configuring the pages. It always applies when a Master page is used as a template.

— Background: the following are available for the design of the background:

— Background Theme: If this option is selected then the background is set to the
background colour selected in the 'Theme'. The opportunity of also adjusting the
background in the 'Theme' means that icons and pages can be centrally coordinated
with each other.

— Background Colour: A monochromatic background is defined via the Colour field.

—  Colour Ramp: The background is given a two-tone colour ramp. Here, the ramp
direction (vertical or horizontal) and the two colours need to be defined.

— Template: Irrespective of this, it is also possible to define a standard background
image. The Image Transfer dialogue is opened via the arrow symbol next to the
selection menu.

Alignment: this defines the alignment of the background image.

— These settings can be ignored in the Page Parameters.

— Frame: The frame around the defined visualisation interface can be designed with different
colours in order to standardise the representation for all screen resolutions. It can use the
page colour or its own colour.
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Flip/Dialogue Pages

The Flip/Dialog Page is a special page element which can be used to define smaller pages
which are then dragged by finger into an existing user interface or which can appear as a
dialogue element in the foreground. In this way, user-friendly operation of the visualisation can
be realised.

—  The following settings are possible:

— Name: A clear and unique name must be assigned so that the page remains clearly and
unambiguously identifiable at all times.

—  Size: The width and height can be defined in pixels. If the page is to be used for flipping
then a lower resolution is recommended. The higher the selected resolution, the more
processing power needs to be made available by the Visualisation Client.

— Background: The following settings are available for the background:

— Background: The background is displayed according to the colour configured in the
Theme Editor. The icons should already be designed with this in the Theme Editor.

—  Background Colour: A monochromatic background colour can be chosen.

—  Colour Ramp: A two-tone colour ramp can be chosen. The alignment can be switched
between "vertical" and "horizontal". There is a colour selection field for each of the two
colours.

— Template: Instead of a colour you can also use an image file as the background
image. The image file is selected from a drop-down menu. If the image is smaller than
the visualisation interface then the position of the image can be defined or the image
can be stretched. The transparency of the background image can be controlled with a
slider or via a numerical input field.

— Embedded Page/Dialogue: The number of elements in a page and the Start Page are
defined here. The Start Page is particularly important for configuration as a "Flip
Page". The system counts through from left to right.

Event Configuration: A particular page can be displayed in response to an event in the EIB. It is
then used as a Dialogue Page in order for example to display a warning message on the
screen. In addition to all standard data types, this element also supports various comparative
operations. In addition, it is also possible to define whether the element reacts only to a change
in value or whether it is a general response, and after what time interval the element should
again respond to an input value.

Usage of the Flip/Dialogue Page

In order to be able to integrate a flip element on a page, the page needs to consist of several
elements. Otherwise it cannot be "flipped". If the element is only to be used as a Dialogue Page,
e.g. for a fault message, then it is sufficient to define a page.
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Fig. 41: Visualisation Editor - Flip/Dialogue Page parameters

— Flip Page: Enter more than one page under "Number of Pages" and select a Start Page.
The pages are arranged side-by-side from left to right on the working area. A Flip/Dialogue
Page can consist of several individual pages or individual elements. On the flip side, the
required elements and background images can be positioned and configured similarly to
any other page. The element "Embedded Page (Flip)" is used to position a flip element on
a visualisation page. For more information about this please refer to the corresponding
element description.

Dialogue Page: If the Event Configuration of the Flip/Dialogue Page is activated then this
dialogue applies across the entire project, and the dialogue page is placed over every
visualisation page in response to the set KNX event. The visualisation itself moves to the
background and is "greyed out".
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Pages

Every project consists of one or more pages. If a page is selected in the project structure then
the page parameters are displayed in the right-hand window.

Fig. 42: Visualisation Editor - page parameters
—  General

— Name: A unique and unambiguous name must be assigned to every page.

—  Master Page: With the aid of this drop-down menu, previously created Master Pages can
be used as a template for the selected page. The size, background and frame settings for
the site currently being edited are defined via the definitions of the Master Page. For the
background and frame, the settings of the Master Page can be ignored by checking the
relevant boxes and then changed.

—  Width: side width in pixels
— Height: side height in pixels
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[il Tip: When calculating the size details, bear in mind that a task bar and a frame for the
visualisation may need to be added later on.

— Background: Several variants can be chosen for the background. These are:
— Ignore Master: The background setting of the Master Page is not used for the page.

— Background Theme: Via the process of creating a 'Theme' in the Theme Editor it is
possible to coordinate the background colour with the design of the icons across the
entire project. The Theme Editor is an additional program - a description is provided in
a separate document.

— Background Colour: A background colour can be freely defined via the colour field
underneath it. The colour can be selected in different modes (pattern, hasB, RGB).

—  Colour Ramp: The background is given a two-tone colour ramp. Here, the ramp
direction (vertical or horizontal) and the two colours need to be defined.

— Template: One of the images from the pool of uploaded files is displayed as the
background pattern. The dialogue "Upload Images" is displayed by clicking on the arrow
symbol. The alignment is also defined here.

— Frame: A frame ensures that the Visualisation Interface is always displayed in its full size,
regardless of screen resolution. If one of the Visualisation Clients has a screen with a
higher resolution than the Visualisation Interface then the frame is displayed in addition.
The colour of the frame can also be selected individually, as can the page colour.

—  Security: Every page can be protected with a PIN code. The menu in which the PIN codes
are created and managed opens above the arrow symbol to the right next to the PIN
selection. A new PIN is created with the aid of the "+" symbol. The PIN code should be
unique. Here, digits from 0-9 can be chosen in an arbitrary sequence. The information
about the expiry of the PIN code defines how long the user session is permitted to last
without the user being asked to input his password again. If the user remains on the page,
then - even after the time has elapsed - he will not be asked for the code again until he
leaves the page. The "-" symbol is used to remove a PIN code again. The parameters for
the PIN codes can be changed again in the user settings.

—  Event Configuration

— Activate Event: The relevant page is displayed on the screen after being triggered by a
telegram. The page change can only occur within the project.

— Address: This is where the group address for the event trigger is entered. Possible EIS
types: EIS 1, EIS 5, EIS 6, EIS 9, EIS 10, EIS 11, EIS 14.

— Comparison: The incoming group address can be compared to the saved address for
triggering the event. If the outcome is correct then the page change is performed.

non non non

Possible comparative operations are "equal to", "smaller than", "greater than", "smaller

than or equal to", "greater than or equal to" and "unequal to". If "*" is entered then no
comparison is performed. The page is triggered for every value of the input.

— Always Trigger: If this function is enabled then the page is triggered after every correct
comparison result. If it is not enabled then the page change is only performed after a
change to the comparison result.

Trigger Timeout: This defines the time in seconds during which the system is not to respond to
any further triggers.
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IP Control Tablet support

The form in which the visualisation elements and cross-project parameters are also effective for
the IP Control Tablet Visualisation is quick and easy to see via the tooltips. With the
visualisation elements, a visual marker (blue bar) is added before the element.

Fig. 43: Visualisation Editor - tooltip IP Control Tablet support

Visualisation elements

The visualisation elements include all of the elements of the standard library as well as,
optionally, also the switches created with the Component Builder. To place elements on the
visualisation, it is sufficient to simply click on them. They are automatically placed in the middle
of the relevant visualisation page and focussed with a frame, and the window with the
corresponding element parameters opens on the left.

Themes/Interchangeable Elements

The Visualisation, Operating, Job and IP Control Mobile elements can be exchanged. So-called
"Themes' are used for this purpose which contain the complete set of elements. A 'Theme' or
the individual elements can be edited with an additional piece of software - the Theme Editor.

General Element Parameters

Every element has specific parameters depending on its function. They are displayed if an
object is selected on the visualisation interface. In addition to the specific parameters, there are
properties which apply to all elements.
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Fig. 44: Visualisation Editor - General element parameters

Level: This indicates at which level the element is located. Every element has its own level.
The level of the element can be changed via the input field. This allows elements to be
processed more easily, for example if they need to be placed one above the other.

Position: The position of the element within the visualisation interface is defined by
specifying the pixels. This information can be entered via the keyboard or with the aid of
the arrow keys.

Width/Height: The width and height details can be changed via the arrow keys or via
keyboard entry. The option "Preserve Aspect Ratio" is not taken into account here.

Draw Shadows: Every element can be given a shadow if required. In the process, the
element is mirrored downwards by a defined value.

Shadow Height: The height of the shadow can be set to a value between 0-150%.

Resize Shadow: If this option is enabled then the complete element with shadow is drawn,
regardless of the size of the shadow. If it is not enabled then the element is only displayed
to the extent that corresponds to the size of the shadow.

Preserve Aspect Ratio: When this option is enabled, the aspect ratio is not changed when
the element is made bigger or smaller with the mouse.

Tip: The aspect ratio will remain unchanged if you press the Ctrl key while enlarging the
element. If the Shift button is pressed the midpoint of the element is kept the same.
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— Distortion-free: The graphics of the element are not distorted during the free resizing. Only
the background of the element is changed.

—  Soft Drawing: The edges of the element graphics are shown more "softly".

—  Transparency: The elements are made more or less visible (stepless adjustment) with this
function. Here, the value is either entered as a number or adjusted via the slider.

— Tooltip: A tooltip can be entered for better identification. It is displayed if the mouse pointer
briefly hovers over an object in the visualisation.

— Address Assignment: If no address is assigned this field is yellow; once there is a valid
address it is marked green. The field becomes red if the address is entered with an
incorrect syntax.

[i] During address assignment the space bar can be used as a "/" (slash) key. This makes the
input easier.

—  Address Assignment With ESF File: With the aid of the arrow key next to the address input
field, the dialog for administration of the ESF file is called up. In the lower area there are 5
fields for addresses which can be assigned to the element. Double-clicking on an address
in the overview copies it to one of the fields.

Fig. 45: Address assignment with ESF file

— Use ESF Data: With this option, the description of the group address from the ESF file is
used as the tooltip of the element for the visualisation.

[i] In order to have the description copied, first check the box and then select the group
address.

—  Object Style Configuration: The design of the background of the element is changed.
For the selected element, the cross-project style configuration in the Project
Parameters is overwritten.

— Graphics Set: When changing the elements in the Theme Editor, it is possible to
assign different graphics sets to the element. With the aid of the sets, it is for example
possible to have a power outlet displayed instead of a lamp.
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— No Background: The element has no background field. It is transparent.

— Background Theme: When creating a 'Theme' in the Theme Editor, it is possible to
define a background colour so that this colour can then be coordinated across the
project in the design of the icons. The Theme Editor is an additional program - a
description is provided in a separate document.

— Project Background: The background defined in the project parameters is used for the
element.

— Standard Background: The element is given the background defined in the global
project settings.

— Background Colour: The background colour of the element is selected via the colour
selection field.

Colour Ramp: The background is given a two-tone ramp. Here, the colour and type of ramp
(vertical; horizontal) can be defined.

Change Font Style: Some elements contain writing. Consequently, it is also possible to
change the font style under Style Configuration. It is possible to create various style
templates which can be reused repeatedly:

Fig. 46: Changing the font style

—  Create Style: A new font style can be created via the "+" button.
—  Style Properties: The necessary font adjustments can be made here.

—  Style Preview: A preview of the selected font style is shown here.
Delete Style: A font style can be deleted via the "-" button.

Ignore Font Style: The font style can be ignored for this element if required. The default font
style will then be used instead.

Font Colour: If the font style has been ignored then this option can be used to give the
default font style a different colour.

Auto Resizing: If this flag is enabled then the font size of the element is automatically
adjusted to its size.

If an existing font style is changed in an element then the changes are copied across to all
elements. This also applies to the DEFAULT font style.
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Visualisation elements 2

All elements which can be used for the visualisation are displayed in the Elements window. As
well as a standard library, there are free components which can be created using the software

"Component Builder".

The table below shows a listing of the elements in the standard library. The table also shows the
view in the visualisation and in the menu. In addition, it also contains a brief description and
information about the supported EIS data type and the bit value. In case a bus subscriber
already works with the new DPT data types, you will find a list in the appendix in which the DPT
data type designations of the still-current EIS types are described.

Some elements offer very comprehensive adjustment options.

Element Menu Visualisation

EIS-

Type Value

Description

Graphical
element

Venetian blind = =
+ status display I—_I ‘

Window contact

Room |: :|

Image

The graphical element makes

available 7 different functions:

. Change PIN code

. Jump between pages

. Page overview - -
. Open URL in browser

. HTTP request

. Open Room Allocation Plan

. Set IP Control time

NOoO O~ WNERE

Venetian blind element with
status display, position control
(EIS 6) and display of the slat
angle (EIS 6). The position
control and/or display is
dynamically divided up if the
option "Do Not Preserve Aspect
Ratio" is selected

EIS1 1 Bit

Approach position EIS 6 1 Byte
Slat position (angle) EIS 6 1 Byte

Element with inputs (EIS 1):

1. Open

2. Tilted EIS1 1 Bit
3. Glass breakage

The image can be mirrored.

Visualisation element for use of

the Allocation Plan Module. The

element controls a room. The - -
status can be changed, or the

calendar view can be called up.

Images which are uploaded to

the IP Control can be freely

positioned on the page and can EIS 1 1 Bit
also (optionally) be switched via

a group address. All uploaded
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ON/OFF switch

Button

Status

Venetian blind
button

EIS 14 push-
button

Status message

(bit bar)

Static text

Dynamic text

o

=

POV eV

1 oxo1
I ox02

images are available in the
selection menu.

A group address for ON/OFF
switching commands can be
assigned to the switch.

Toggle: "ON" and "OFF"
commands are sent alternately
every time the button is
pressed.

"ON" only: Every time the
button is pressed an "ON"
signal is sent.

"OFF" only: Every time the
button is pressed an "OFF"
signal is sent.

This indicates binary states.
(1 = ON, 0 = OFF)

Raise/lower

Slat adjustment
Mode: Wind Alarm

Sends a fixed, defined EIS 14
value to the desired group
address. The switch is shown in
yellow if the value (0-255) of the
group address matches the set
value.

Indicates the status of the
individual bits in a telegram.
Every bit position can be
displayed or hidden. Colours for
different states can be chosen.
Every bit can be labelled. The
individual bits can also be sent.
Application: Status display for
an actuator which sends a
status byte (EIS 14).
(Non-typified)

Used for labelling.

Text according to the input in
the Visualisation Editor. The
font style, font colour and font
size can be chosen. Note: The
font must be installed on the
Client computer.

Depending on the object value,
this displays the text for
ON/OFF. Depends on the
current value of the group

EIS1

EIS1

EIS1

EIS7

EIS7
EIS1

EIS 14

(un-

1 Bit

1 Bit

1 Bit

1 Bit

1 Bit
1 Bit

1 Byte

typisiert) | 8 Bit

EIS 14

EIS1

1 Bit
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EIS 15 text

EIS 15 display

Temperature
switch

Temperature -
display

Date/time N
display DATE

Analogue time | (<)

Slider

Button

Value display #

4 4

EIS 15 Text
110

4

EDIT

address. The font style, font
colour and font size can be
selected in the Visualisation
Editor.

The "EIS 15 text" element
shows the text received at a
group address. The text is
displayed without a frame, and
the font style, font size and font
colour can be freely chosen.

Received messages can be
displayed with the text display.
To transmit text information to
other KNX devices, click on the
text field and enter the text.

The target value can be
adjusted with the button.

Displays the current
temperature and the target
temperature.

Text display for time and date.
Both can also be displayed
separately; the preferred format
can be selected.

Displays the time in the form of
an analogue clock.

The clock can be adjusted
forward or back via the Hours
Offset.

Depending on the slider
position, a value between the
minimum and maximum value
is sent (EIS 5 floating point, EIS
6 0 to 100%).

Button in "Switch Mode™":
The "ON" or "OFF" switching
command is sent by briefly
pressing the button.

Button in "Dimmer Mode":
The "brighter” or "dimmer"
command is sent by pressing
and holding the switch.

This can display and - on
request - send various EIS
values. Limits can be defined.
Format: ##.## : Required digits
are shown.

Format: 00.00 : All digits are

14
EIS15 g

14
EIS15 Bl
EIS5 16 Bit
EIS5 16 Bit
EIS 3;
E[S4 | [SETe

EIS 3 3 Bytes

EIS 5 2 Byte
Ese (FP)

1 Byte
EIS1  |1Bit
EIS2 |4 Bit

EIS5  2Byte
EIS6  1Byte
EISO  4Byte
EIS10 2 Byte
EIS11 4 Byte
EIS14 1Byte
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Telegram time

Bus Monitor

Job Editor ()

Logic display [2]

Fault detector

Page link

RSS Feed

Camera 3

|_| Stérung

shown

This date/time field shows the
time stamp of the last telegram | All
at the indicated group address.

Opens a window which lists all
transmitted and received

telegrams. This can be directly
embedded in the visualisation.

Link to a weekly/yearly time
switch or to a light scene. The
linked jobs can be changed by
the user in the visualisation.

Displays the result of a logical
operation parameterised in the
Job Editor (1 or 0).

Properties window for the
visualisation which displays the
current states of the inputs and
the output.

EIS1

If the corresponding group
address is tripped, the page on
which this icon is positioned is
automatically shown in the
foreground. In addition, an
acoustic warning signal sounds.
This can be deactivated via the
"Beep enabled" flag. The fault
message can be acknowledged
via a separate group address
and/or with a click of the mouse
on the fault message.

EIS1

This serves for
changing/jumping to a different -
page of the visualisation.

Current messages from a
definable source are embedded
in the visualisation. Here, the
text is displayed which is
transmitted by the provider of
the RSS feed.

After being called up, the

images from a network camera
can be displayed in a separate -
window (as an icon) or directly

in the visualisation.

By triggering the corresponding
group address, the current
camera image is displayed for a
certain period of time. This

EIS1

All

1 Bit

1 Bit

1 Bit
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Graph

event is set in the
Parameterisation Window.

The Diagram function is used to
produce a clear overview of
curves (graphas) of values.
Depending on the diagram, up
to 3 graphas can be displayed,
and these can be individually
formatted (line colour, offset,
factor). A distinction is made
between two types of graph,
"Total' and 'Differentiated'. (See
also ™).

EIS 5
EIS6
EIS9
EIS 10
EIS 11
EIS 14

2 Byte
1 Byte
4 Byte
2 Byte
4 Byte
1 Byte
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Embedded page (Flip)
B

This element is used to place the Flip Pages (which were previously created in the
"Flip/Dialogue Pages" folder) on a Visualisation Page. This contains definitions about how many
individual pages and which functions are included.

Specific parameters

— In addition to the general element parameters, there are also element-specific parameters.
These define the design and behaviour of the flip element on the visualisation page:

—  Select Page: Here, you can select the required Flip/Dialogue Page which is to be placed on
the visualisation.

—  Visible Pages: Every Flip Page consists of at least 2 segments (individual pages). Via the
numerical input field you can define how many of the segments should be visible at the
same time. If only two segments are defined then only one segment should be visible so
that there is a visible effect when the user slides across to the other segment..

Fading Area In Pixels: Here, areas can be defined in pixels at the left and right-hand edges for
flip elements in which the segment that is disappearing is slowly faded out. The fading area is
added to the actual segment size.

Example:

A Flip Page as used in the Delivery Project comprises 4 individual segments. This is what the
configured 'Flip/Dialogue Page' looks like:

Fig. 47: Visualisation Editor — Flip/Dialogue Page from the Delivery Project

On the right-hand side you can see the specific configuration: the page comprises 4 segments,
whereby page 1 is the Start Page (numbered from left to right).

The second picture shows how this page was embedded in the visualisation via the "Embedded
Page (Flip)" element:

Fig. 48: Visualisation Editor — embedded page (Flip) in the Delivery Project
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Sequence button
This button can be pressed repeatedly to perform different actions. If it is pressed a

second time within a certain time interval then a different action is performed, and not the first
action again. This button is used e.g. for visualisations in apartments designed for disabled
people.

Fig. 49: Sequence button — specific parameters

Specific parameters:

In addition to the general element parameters, there are also element-specific parameters.
These define the behaviour and the design of the sequence button:

Standard Colour: This defines the colour of the button in its rest position.

Standard Title: The title is positioned in the middle of the button (optional). The standard
title is displayed in the rest state. The font style can be changed via a corresponding menu.

Delay (ms): The 'Delay' defines the time interval after which the sequence button reverts to
the rest state. If the button is pressed a second time during this period of time then the next
action is performed.

Function: The 'Function' menu is used to create the different actions which are to be
performed by the button. These are worked through from top to bottom. Configuration:

Fig. 50: Sequence button - editing the function

— Colour: This is the colour the sequence button changes to when performing this action.

—  Title: The title is displayed in the sequence button when it is performing this action.
The font style is the same as the one defined for the standard title.
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— Address: The group address can either be entered via the keyboard or selected from a
previously uploaded ESF file. The arrow button next to the address input field is used
for this purpose. The section entitled "ETS" describes how to load the ESF file into the
device.

— Data Type: A data type must be assigned to every address. Here, the types EIS 1, EIS
5, EIS 6 and EIS 14u (unsigned) are possible.

— Value: The value which is to be transmitted should be defined here. This depends on
the selected data type.

RTR display

The room temperature is controlled via the RTR display. In the process, the switch offers

the functions 'Standby/Comfort', 'Night-time Temperature Reduction' and 'Frost Protection'. The
element can be operated with EIS 1 or EIS 14.

Specific parameters

In addition to the general element parameters, there are also element-specific parameters.
These define the data type and the address for the RTR display.

Fig. 51: RTR display - specific parameters

Type EIS 14/EIS 1: In principle, the RTR display can be operated with EIS 14 or EIS 1
values. Depending on the selected data type, one or the other view is enabled.

Status Address: If EIS 14 is chosen as the data type then the address is entered here. This
can either be done by hand or via the address input dialogue. There you can access the
data from the ETS (see 'Uploading ESF Files').

Standby/Comfort/Night-time Temperature Reduction/Frost Protection Value: The required
EIS 14 value is entered in the input fields for every state.

Standby/Comfort Address: If EIS 1 is defined as the data type then the switchover between
Standby and Comfort is performed via this communication object.

Night-time Temperature Reduction Address: The system switches to 'Night-time
Temperature Reduction' via this address.

Frost Protection Address: The system switches to 'Frost Protection' via this address.
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Colour selection

—a
—_
—

The colour selection circle is used to mix colours in the RGB colour space. This makes it
possible to control e.g. coloured LED lamps with a so-called 'DMX Dimmer' via the visualisation.
The required values are transmitted by the IP Control via EIS 14 telegrams,

Specific parameters

In addition to the general element parameters, there are also element-specific parameters.
These define to which group addresses the required values are sent.

Fig. 52: Colour selection - specific parameters

— EIB 14 RED/GREEN/BLUE: The communication objects of the EIS 14 values for red, green
and blue are entered here. The addresses can be entered either via the keyboard or via the
address input dialogue. In the address input dialogue you will also find the data from the
ETS if they have been imported beforehand (refer to the section entitled 'ETS").

EIS 1 Send Ready: An EIS 1 confirmation telegram is sent to this group address if the colour
input has been performed. This allows the counterpart to identify without doubt that he has
received all values.

Top Consumers

The 'Top Consumers' is a display element which compares 4 incoming values to each
other and automatically lists them sorted by size. In the process, the values are compared in a
horizontal bar chart with each other. Consequently, the display is perfectly well suited to
displaying the top consumers in a building at a glance. KNX actuators with current value
detection are used preferably in order to measure the consumption figures. These supply the
instantaneous current (in amps), which is converted by the Integrator Job to a figure for energy
consumption (e.g. Watt-hours).

Specific parameters

In addition to the general element parameters, there are also element-specific parameters.
These define the units in which the 'Top Consumers' is displayed, and how many consumers it
represents.

Fig. 53: Top Consumers - specific parameters

—  Bar Colour: This defines the colour of the bar which is used to indicate the consumption
level.
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Values Format: The following entries can be made for the format of the value:
number of digits to the left of the decimal point, number of decimal places - via the
digits '0" and '#'. In the case of a '0‘ the digit is mandatory, i.e. even if no value is
present the system will still display a '0'. All digits which are marked with a '#' are
optional, i.e. if the relevant digit contains a '0‘ or no value then the corresponding digit
is not displayed.

An example:

—  Take the value of 0.2. If the value format is 0.0 then the system will also display 0.2. If the
format is #.#, then only the '.2' is displayed, as there is no value in the first digit.

— Data Source: The only option which is currently available is "Instantaneous (EIB)". The
information about the consumption is taken from current EIB telegrams.

— Consumers: The individual consumers are assigned to the element. For this purpose the
buttons "Add". "Edit" and "Delete" are positioned on the pages. The sequence can be
changed with the arrow keys. A further menu is opened via the "Add" button:

Fig. 54: Top Consumers - editing consumers

Title: The title is also displayed in the element. The name should be unique and
unambiguous.

Address: The input address of the consumption value. This can not only be entered via
the keyboard, but it can also be selected from an ESF file. The ESF dialogue is
opened by clicking on the arrow button next to the address input field.

Data Type: The element supports the following EIS types: EIS 5, EIS 6, EIS 9, EIS 10
(s+u), EIS11 (s +u), and EIS 14 (s + u).

Factor and Offset: The value is multiplied by the factor and added to the offset.

[il The configuration of the Integrator Job is described in the section entitled "JobEditor".

Notes on the Element Diagram

The visualisation element 'Diagram' produces a curve of values plotted over time. Application
examples for this include temperature curves, counter states, power curves etc. The telegrams
are taken from the ring buffer (20,000 telegrams) of the IP Control.

—  Special settings:

Axis Format: This text field influences the number format of the y-axis. The number of
permissible digits before and after the decimal point is defined. The following Syntax
applies here:

A '0' stands for a mandatory digit, i.e. the digit is still displayed even if no value is
present.

Order no. 7571 00 04 page 59/176



Editors

— A'# stands for an optional digit. The digit is only displayed if a value is actually
present. However, the system will never display more digits than indicated.

— A"." stands for the decimal point.
If, for example, a percentage sign is to be added, then this must be put after the number in
inverted commas ().
Examples:

— The number 21.2 is to be displayed. The number format is defined as 00.00. The number
21.20 is displayed.
If the number format is displayed as 0.## then the number 21.2 is displayed. A percentage
sign is inserted as follows: 0.##'%'.

— Axis Limit: Ticking this box sets the y-axis to a fixed value range. This range can be defined
in the fields underneath.

—  Graph Data By Time/By Quantity: The x-axis is dimensioned by time or by the quantity of
telegram packets. Details for the time period or quantity are entered in the corresponding
fields.

— Auto Update: While the visualisation is active the graph is automatically updated after this
interval. The system obtains current data from the IP Control history table and calculates
the graph from the new measurement points.

—  Graph Type: A distinction is made between two types of graph:

— Total: The value is shown as an absolute value plotted against time. In the case of a
counter status measurement the graph would rise continuously.

— Difference: The difference between two successive values of an object is plotted against
time. The frequency of the differential measurements in minutes can be adjusted under
"Interval". The smaller the time interval, the more accurate the graph.

Data Type: The display of the following EIS formats is supported: EIS 1, 5, 6, 9, 10, 11, 14.
Appendices 13 and 14 offer an overview of EIS types in conjunction with DTP data types.

Data from the EIB history table

The graph uses past values. To do this, it needs to use the ring buffer of the IP Control (EIB
history table). This has capacity for 20,000 telegrams. In the process, the oldest telegram is
replaced by a new one. In a KNX system, 20,000 telegrams may (in some cases) already have
been transmitted within the space of a few hours, as a result of which the graph might only
display the values for this short period of time.

A history recording filter needs to be set up so that the graph can also display consumption data
etc. for longer periods of time. This determines from which group addresses the data are written
to the ring buffer. The history recording filter is created under "System" Configuration Tool >
"Configuration" > "EIB History Recording Filter" via Rules. It is possible to specify either
complete group addresses or ranges. A wildcard character (*) is entered for ranges.

Example: "1/*/*" (without quotation marks) means that only the data of the main line 1 are
recorded. It is sufficient to enter "1/1/*" if you wish to filter by the middle group. When filtering by
a whole address, that address is simply entered.
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Functionality within the visualisation

Within the visualisation, the '‘Diagram' element offers further functions which can be called up by
right-clicking on the diagram:

Fig. 55: Visualisation - '‘Diagram’ context menu

— Refresh: refreshes the values in the diagram.

—  Export as Image...: Opens the file browser so that the diagram can be saved as a graphics
file (*.png).

— Exportas CSV...: Opens the file browser in order to save the values of the diagram as a
CSV file.

—  Show properties: This opens a dialog which allows users to change the display criteria. You
can define which telegrams the 'Diagram’ element should use as the basis for its
representation:

Fig. 56: Visualisation - Diagram - Show Properties

— Quantity: The diagram uses either the latest values or older values. The nhumber of
affected diagrams can be defined.

— Time: The 'Diagram' uses the values from the past X. The number of hours can be
freely adjusted.
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— Date: A period of time for determining the values is defined by entering the date. This
could be before or after a date, or between two dates. Depending on which of these
options is chosen, the date fields are either enabled or not enabled.

These settings are not saved. If the visualisation is started up again then the settings are
lost.

Notes on the "Image" element

With the aid of the image element, not only is it possible to position images from the IP Control
on the visualisation, but also images which are saved on the hard disk of the Client PC, on a
server or on another computer. Images can even by downloaded from Internet pages in this
way. As a result, this element has some additional parameters alongside the general parameter
settings.

To do this, the option "External Image" must be enabled in the parameter settings for the
element. The following settings are then possible:

Fig. 57: Editor - Special parameters in the 'Image’ element

External URL

The path to the required image or Internet page is entered. If an image is to be embedded from
the hard disk of the visualisation PC then the path to the image must be stated with the
following prefix: "file://". If a website is to be displayed then the complete URL must be entered
(with "http://").

Refresh in (sec.)

This defines the time in seconds after which the entered URL is reloaded. If the value "0" is
entered here then no update is performed.

Background Refresh

If this option is enabled then the URL is still reloaded at the defined interval even if the affected
visualisation page is not loaded on-screen.

Display Last Image

If the external URL which is entered cannot be reached then the last successfully loaded image
is displayed.

Test URL
This function can be used to test the specified URL.
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Cover Display in the Visualisation

This function is used to display existing album covers when using the visualisation to control
music playback. If a cover image file is available, the server software of the Squeezebox™
devices will make it available via a special URL.

http://<server>:<port>/music/current/cover.jpg?player=<playerid>

This URL is taken from the http API of the SqueezeCenter™ or Squeezebox Server™ software.
The assigned Squeezebox™ name is used as the player ID. If, for example, the
SqueezeCenter™ or Squeezebox Server™ software is running on a server with the address
192.168.1.10 on the port 9002, and the cover image of the song title currently being played
back on the Squeezebox™ Boom (with the name "sqgbboom") is to be displayed, then the URL
is:

http://192.168.1.10:9002/music/current/cover.jpg?player=sgbboom.

For the settings of the 'Image’ element, it is important to note that, although the image can be
refreshed, it does not necessarily have to show the cover of the current song, as the
reproduction of the cover is not directly tied to the music control. If an album does not contain
any cover information then the server software will provide a substitute image.

Notes on the Bus Monitor

Not only can the Bus Monitor be opened temporarily as a separate window, but it can also be
directly embedded in the visualisation page. In addition, the contents of its display can be
individually adapted and changed via control elements during the visualisation session and
saved. The following special parameters are available for this:

External Window

If this option is enabled then the Bus Monitor is opened as a separate window. If it is not
enabled then the display of the element in the editor changes; it then needs to be placed on the
interface and resized.

[il The option "Preserve Aspect Ratio" should be disabled so that the window can be adapted
to its surroundings.

Display Control Elements

If this option is enabled then the following control elements are displayed on the visualisation
interface:

Fig. 58: Bus Monitor - embedded in the visualisation

u Columns: Columns can be added or removed via this switch while the visualisation is
active.

= Export: The displayed telegrams can be archived as a *.csv file on the local PC.
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= Filter: With the aid of a set filter it is possible to selectively display individual group
addresses only.

=  Pause: The recording of the Bus Monitor can be paused with this switch.
= Empty: The content of the Bus Monitor is emptied. The recording starts anew.

Fig. 59: Editor - Bus Monitor parameters

Address Filter

An Address Filter can already be specified during parameter setting. The Bus Monitor only
displays the entered address in the visualisation.

Columns

The columns which are to be displayed by the Bus Monitor can be defined via the following
checkboxes. By default, the columns "Bus Repetitions”, "Bus Priority", "Bus Routing", "Bus
Counter" and "System ID" are not activated here.

Notes on the Graphical Element

So-called 'actions' can be defined for the graphical element which are executed on "pressing" or
on "release". Only one function can be defined for each function ("press”, "release"). It is also
not possible to define the same action for "press" and "release" at the same time.
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Fig. 60: Element parameters — action on "press mouse"

The following actions are available:

Change PIN Code: When the user clicks on the relevant graphical element, he is prompted
to change the PIN code of a page. Which PIN code is to be changed can be defined in a
selection menu.

Page Jump: A page jump is performed on "pressing"” or "releasing". The page to which the
system jumps is defined in a selection menu.

Page History: It is possible to navigate forwards or backwards a page at a time - similarly to
an Internet Browser. The navigation "forwards" only works after the "back" function has
been used. The "Page back" function depends on the page history generated by a user.

Fig. 61: Selecting the function for mouse clicks

Open URL in Browser: When this element is clicked the desired URL is opened in a new
browser window.

HTTP Request: A previously defined request is issued. This can be used e.g. to control an
IP Camera. This is independent of the job "HTTP Request".

Open Room Allocation Plan: The view of a previously defined Allocation Plan Module is
opened via the graphical element.

Set IP Control Time: The dialogue for adjusting the time is called up. In addition, it is also
possible to adjust the date and time or set the PC time similarly to the way this can be done
in the editor.

The menu on the left-hand side of the window is available for adding and editing an action. Use
"New" to add an action or "Del" to delete it again. An existing action can be changed via the
"Edit" function. The buttons "Up" and "Down" are used to change the order if multiple actions
have been defined (currently this function is not yet available).
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Security settings — user administration for the visualisation

Access rights to the visualisation project(s) are managed in the security settings in the user
administration. The access rights need to be set up individually for every user. It is possible to
release access to entire projects or just to individual pages. During the visualisation, it is
possible to change the user via the Visualisation ToolBar.

[i] The user settings for the editor and system are saved under "User Administration” in the
configuration tool.

Changing to the security settings/User Administration

Two buttons in the menu bar can be used to switch between the Visualisation Editor and the
User Administration / security settings. The button for the selected view is highlighted.

Fig. 62: Switching between the Visualisation and the User Administration

Settings

The User Administration can be activated or deactivated. If it has been deactivated then the
user login stage is skipped. This corresponds to the default status. If the User Administration is
activated then the display of individual users during login can be suppressed "Display User List
in Login Dialogue". The user name needs to be typed in.

Create/Delete User

A new user is created via the corresponding icon. As the first step, a unique user name needs
to be assigned. This is automatically copied to the field "User Name" and "User Title". To delete
a user, it needs to be selected beforehand in the User Overview. The user is deleted without a
safety warning.

Fig. 63: Editor - Create/Delete User

User
All users which have been created are displayed here one below the other.
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Fig. 64: Editor - User Administration

User Details

General settings need to be made for every user:

User Title: The title is displayed in the User Selection Menu. The user is identified with this
during start-up of the visualisation.

User Name: This is queried during login. If the user list is enabled during login then the
user name is copied to the login dialogue during selection of the user title.

Password: This is the password that the user needs to identify himself with.

Automatic Logout: If this function is enabled then the user is asked to log in again once the
set time has elapsed.

Project Setting Parameters: For every user, individual settings can be assigned in the
project parameters "Visualisation Toolbar", "Kiosk Mode", "Page Index" and "Connection
Problems". The administrator can assign individual settings (Yes/No) or the project settings
to the user (Use Project Settings). The "Yes/No" settings overwrite the project settings.

Skip PIN Request: If this option is enabled then the user is not asked to enter his PIN.

Hide User: This user is not displayed in the User List during login.

Project Access

All created projects are displayed. A project is assigned to the user by ticking the corresponding
checkbox. If multiple projects are assigned to the user then a project selection will be displayed
after the login.

Page Access & Start Page

In order to be able to assign just individual pages of a project to a user, the desired project is
highlighted in the column. All of the pages in the project can be individually assigned by ticking
the checkboxes. After the page name the start page is selected which is to be displayed first for
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the user. If the pages of various projects are affected then a project selection will again be
displayed for the user after login.

Saving Settings

The created user is saved by clicking on the "Save" button in the menu bar (diskette icon).
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6.4 Job Editor

The Job Editor is opened via Window > Job Editor. The window does not appear in full-screen
mode. It can be minimised, maximised or closed in the right-hand corner of the window.

Fig. 65: Job Editor

The Job Editor is used to configure the services (Jobs) of the IP Control. The job types which
are made available vary depending on the firmware version of the IP Control. A toolbar and a
tree structure are available for creating the jobs. The job window which is currently being
configured is shown in the middle.

Job Toolbar

Fig. 66: Job Editor - Job Toolbar

The Job icons are located in the upper toolbar. Every job has its own icon. When you click on
an icon, the relevant job window appears in the middle of the window.

The “Documentation” icon is for the documentation of the job configurations. In the process, a
new dialogue opens up in which the existing jobs for the documentation can be selected. This
can be done manually for each individual job or for all jobs via the option "Select All".

Via the function "Create Report”, an html page is created which summarises the configuration of
all selected jobs. This file can be printed out (Print) and archived.

Tree Structure

On the left-hand side of the Job Editor window, the Job Overview is displayed in a tree
structure. Every job type has its own folder which can be opened or closed via the arrow. Every
job is displayed as a page. If multiple jobs are defined then they are automatically sorted in
alphabetical order.

A new job is created by right-clicking on the job folder. The relevant job window appears in the
middle of the window.
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Jobs - Save/Copy and Delete

Fig. 67: Job Editor - Job Administration

Administration of the jobs is handled via the job window. In the top right-hand corner of each job
window there are icons for the functions Delete, Copy, Reload, Save and Exit. If a job is copied

the job name is not copied across as well. Clicking on the "Delete" icon deletes the selected job
without a safety prompt!

Notes on the Job Editor
Tabs

If several job windows have been opened in the window then they are displayed with the aid of
tabs. In the process, a job which has not yet been saved will not yet have a name. You can call
up as many job windows as you like.

Parameters

Every job window has specific parameters. All parameters marked red are mandatory and must
be filled in, as otherwise the relevant job cannot be saved. Every job has an enable object. With
the aid of this object, jobs can be blocked without having to delete them. An enable object is
always defined according to the EIS 1 convention - "1" means "enable issued", "0" means "no
enable issued". If an address is entered which has not been assigned beforehand then the job
will be disabled until the group address is given a value. If this address had a value previously
then the status of the enable object will correspond to this value.

Fig. 68: Job Editor - creating a report
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Assigning group addresses

Group addresses can be entered directly via an input field or via an address table. When
entering the addresses directly, the space key can be used as a "/" symbol. The Addresses
table is a matrix from which an address can be selected. The dialogue which opens also makes
it possible to upload an ESF file which has been exported from the ETS and to use it for the
address assignment. In this way, the project data from the ETS is made available in the IP
Control, and the risk of mixing up addresses is avoided. The section entitled "ETS" describes
how to export an ESF file and load it into the IP Control.

Fig. 69: Job Editor - ESF dialogue

Virtual Group Addresses

The IP Control not only manages the address space of the main groups from 0 to 15, but also
the address space of the main groups from 16 to 31. These addresses are so-called virtual
group addresses. With the aid of these addresses, it is possible e.g. to link jobs with each other
without using up addresses from the real address space to do this. Virtual group addresses are
not transmitted on the KNX.

Communication objects

The IP Control replicates the structure of the communication objects of the KNX. This means
that up to 5 group addresses can be assigned to each object. This allows the assignment of the
group address of e.g. an actuator channel to be directly replicated, and the IP Control is
informed at all times about the actual status of the actuator (not the group address). Complex
and time-intensive working with feedback messages is not necessary. This approach simplifies
the task of creating logical links, as up to 5 group addresses can be assigned to each input
object of the gates. In this case, all five group addresses can be allocated in the ESF dialogue.
In the process, they are automatically entered with the correct syntax in the selected object
field. However, in the case of outputs it is only possible to enter one address.

General Syntax

After the first group address, the remaining addresses should be placed in parentheses and
separated with commas.
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Logic

All logic gates perform logical operations on EIS 1 values. For the output, you can
[2] | choose whether it should be transmitted if there is a change in the gate calculation or
whenever an input telegram is received.

In addition, you can also set which values the output is permitted to transmit to the bus after the
condition occurs.

Type of operation Description

AND operation (AND) The gate has up to 32 inputs which are logically combined in an
"AND" operation to return an output object.

OR operation (OR) The gate has up to 32 inputs which are logically combined in an
"OR" operation to return an output object.

XOR-operation The gate has up to 32 inputs which are logically combined in an

(EIS 1) "EXCLUSIVE OR" operation to return an output object.

The operation returns a 0 whenever all input objects are 1 or they
are all O (i.e. whenever they are all the same).
Ist ein Eingangsobjekt unterschiedlich, ist der Ausgang 1.

Object The output has the state of the value last sent to any of the inputs.
NAND, NOR NXOR The output of the calculation is negated and transmitted.
NObiject The output value is of type EIS 1.:

0 for an input value not equal to O
1 for an input value equal to 0

If there are multiple input objects then the input should be
determined on which a telegram was last received.

Clocks

(7 T IP Control includes an easy-to-configure
< < weekly and yearly time switch.

HEAR WEEK

IP Control includes a weekly and yearly time switch with weekly and yearly view:
Weekly time switch

A 24-hour profile is assigned to the subscribers. In addition to the 7 days of the week, it is also
possible to parameterise 3 special days. The switch-on time is set by clicking on the timeline.
Double-clicking sets the switch-off time. Clicking three times deletes a point which has been set.
The enable for the weekly time switch is controlled via a link to the yearly time switch. In the
yearly time switch the switching times are set to inactive, and the weekly mode and special days
1 to 3 are set. The yearly time switch thus determines which day in the month which weekly time
switch configuration is "played back”. "W" is used for the weekdays Mon-Sun, "S1" to "S3" for
the special days and "Inactive" for no function.

Yearly time switch

Clock Type: this links the weekly time switch (non-EIS), and the weekly time switch which is
linked via the corresponding group address is controlled. On the monthly timeline you configure
which weekly time switch mode applies: "W" for the normal weekdays, "S1-3" for the special
days or "Inactive" for no function. First, select the mode and then position it on the monthly
timeline.

Clock type: active/inactive (EIS1) - the yearly time switch is not linked to a weekly time switch. It
activates or deactivates one or more subscribers itself. For configuration, select the status
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("ON" or "OFF") and position it on the monthly time switch. The clock always switches at 0.00
a.m. on the corresponding day..

Parameters
Monitor Time Jumps:

It is possible for a switching time to be skipped (e.g. due to a new time signal being received
from an NTP server). This can result in switching operations not being performed. These time
jumps can be optionally monitored so that proper operation is still ensured.

On-site Operation:

If this checkbox is ticked then no on-site operation is possible. The telegram value of the output
address is only defined by the clock.

Initialise Clock

If the checkbox is ticked then the clock transmits the current telegram value after an initialisation
phase (e.g.: restart of the IP Control, changes to the clock parameters). If this function is not
enabled then the telegram value is only transmitted at the defined switching times.

[i] The yearly time switch always switches at 0.00 a.m., so changes only become effective on
the following day.

Astronomical Clock

Fig. 70: Astronomical Clock - creating a new job

The Astronomical Clock determines the different times at which the sun adopts defined
positions during the course of a year. In this way, it is e.g. possible to operate a Venetian blind
to deliver the same brightness level regardless of whether it is winter or summer. Correct
position and time information is required for the calculation.

The Astronomical Clock Job in the IP Control offers a choice of a standard input window and a
complex input window for advanced users. The following data types are available for the output:
EIS 1, EIS 5, EIS 6, EIS 14 and EIS 15:

Twilight Phases

The term 'twilight' is generally used to describe the transition periods between night and day
and day and night. These periods are the result of light reflections in the atmosphere and are
longer in the summer and shorter in the winter. Sunrise and sunset can be divided into various
twilight phases for improved definability:

—  Geometric Twilight
This describes the phase in which the sun geometrically crosses the horizon. The sun's
position is at 0 degrees. It is still almost as bright as broad daylight.

—  Civil Twilight
According to definitions, the so-called civil twilight starts when the midpoint of the sun is
approximately -0.83 degrees below the horizon. This twilight phase continues until the sun
reaches a position of -6 degrees. As the light is curved by the atmosphere, it remains light
enough to read a newspaper out in the open.

—  Nautical Twilight
During this phase there is less light, and the brightest stars may be visible. We refer to this
phase when the sun is between 6 and 12 degrees below the horizon.
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— Astronomical Twilight
The sun is more than 12 degrees below the horizon. It is so dark that almost all of the stars
can be seen. The range for the astronomical twilight is between 12 and 18 degrees.

— Night-time
From an astronomical point of view, we do not talk about night-time until the midpoint of the
sun is more than 18 degrees below the horizon. During this phase it is completely dark, and
all of the stars can be seen.

Dimensions for Sun Position Information
The position of the sun can be stated in degrees, or also in arc minutes. Here, 60 arc
minutes correspond to one degree.

1 degree = 60 arc minutes

The numerical values after the twilight designations in the Twilight Phase selection indicate the
limit of the twilight phases in arc minutes.

Position and Time Information

For the position and time information of the Astronomical Clock Jobs, the IP Control can either
fall back on its installation location, which is already set up, or it can be entered manually. The
installation location can be changed under "System" > "Configuration" > "General" > "Installation
Location". If this setting is used then the IP Control automatically determines the correct
degrees of longitude and latitude (geographical midpoint of the relevant country) and the
matching time zone. The specifications in the job window are shown in the greyed out field and
cannot be changed. Advanced understanding is required for manual entry. In addition, you must
follow the syntax which is displayed in the mouseover help for "Longitude" and "Time Zone".

Fig. 71: Astronomical Clock - global settings

Simple Astronomical Clock:

When a new Astronomical Clock job is created, a selection window appears for the two possible
configuration windows of the job. If you select the option "Astronomical Clock - Simple" then the
standard configuration window will open for the job. In addition to the mandatory position and
time information, a name and enabling object can be assigned to the job. This is followed by the
settings for sunrise and sunset:

Twilight - Weekdays
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Here, the time is defined at which the sunrise signal is to be sent from Mondays to Fridays. The
time can be defined either by selecting a Twilight Phase or by entering a time. If a Twilight Zone
is selected the "Time" button can be used to check the switching times of the current settings. If
a switching time is defined via the Time dialogue, then the arc minute value which corresponds
to the switching time on the relevant day is entered in the Twilight Phase selection field.

Twilight - Weekend

Here, the switching times for both days of the weekend (Saturday and Sunday) are defined.
This is done in exactly in the same way as the settings for "Twilight - Weekdays".

Fig. 72: Astronomical Clock - configuration of the Simple Astronomical Clock

Fixed Offset (min)

This defines a period of time in minutes by which the switching time is to be advanced or
delayed. If the switching operation is to be performed earlier then a negative value should be
entered, while a later switching time is achieved with a positive value.

Random Offset (min)

With this offset, the defined switching time is delayed by a random amount. The range within
which this random offset may take place should be stated here in minutes. This function can be
used to simulate the presence of occupants.

Earliest Time

This time setting defines the earliest time from which the output may be transmitted. With the
aid of this setting it is possible to prevent switching times before a certain time, e.g. never
before 7.00 a.m. in the morning or never before 8.00 p.m. in the evening.

Latest Time

With the aid of this setting it is possible to prevent switching times after a certain time, e.g.
never later than 8.00 a.m. in the morning or 10.00 p.m. in the evening.
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Output Switching Time - Weekdays

With the aid of this EIS 3 output object, the determined switching times for the relevant weekday
are sent. The output is sent at 0.00 a.m. at the start of every day. Above the arrow next to the
address field it is possible to select an address matrix or - if available - an address from the
imported ESF file of the ETS (see "Exporting Group Addresses from ETS").

Output Switching Time - Weekend

With the aid of this EIS 3 output object, the determined switching times for the relevant day of
the weekend are sent. The output is sent at 0.00 a.m. at the start of every day. Above the arrow
next to the address field it is possible to select an address matrix or - if available - an address
from the imported ESF file of the ETS (see "Exporting Group Addresses from ETS").

Output Address

Mandatory field. The defined output is sent to this output address at the determined time. The
EIS type and the value of the output are defined in the fields underneath. Above the arrow next
to the address field it is possible to select an address matrix or - if available - an address from
the imported ESF file of the ETS (see "Exporting Group Addresses from ETS").

EIS Type

The EIS type of the output is defined here. The following types are possible: EIS 1, EIS 5, EIS
6, EIS 14 and EIS 15.

Value
This defines the value of the telegram. The value must correspond to the selected EIS type.

Complex Astronomical Clock:

In comparison to the "Simple Astronomical Clock", the "Complex Astronomical Clock" offers
more complex adjustment options and a trigger object. The "Simple Astronomical Clock"” job
window should be used to realise simple astronomical functions. In addition to the mandatory
position and time information, a name and enabling object can be assigned to the job. In
addition, it is also possible to specify an EIS 14 trigger object here.

Trigger Input

Via the Trigger Input, it is possible to trigger three special times which are defined later on in the
job window. This object can also be linked to the yearly time switch. Above the arrow next to the
address field it is possible to select an address matrix or - if available - an address from the
imported ESF file of the ETS (see "Exporting Group Addresses from ETS").

Configuration of Times

In this configuration field, the times are defined which are subsequently to be used in the
"Configuration of Outputs". A maximum of 8 times can be created. To create a time, it is
selected in the "List of Times" and configured accordingly. The times must be assigned a clear
and unique name.

Example: If a Venetian blind is to be opened at sunrise, then one time should be created here
for weekdays and one for weekends, e.g. with the names "Weekday Sunrise" and "Weekend
Sunrise”.

In the "Configuration of Outputs", one time is linked to each of the outputs for weekdays,
Saturdays/Sundays and/or the three triggers. The times must therefore be created beforehand
and assigned a clear and unique name.
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Fig. 73: Complex Astronomical Clock - configuring times

List of Times

The defined times are displayed with their names here. To display the configuration of a time,
click on it with the mouse to select it. The settings are displayed in the corresponding fields.

Description

This is the unique and clear name for a time. Via this descriptive name, the time can be
identified when it is linked with the outputs (List of Times).

Reference Time

This time forms the starting point for all further calculations (offset etc.). Furthermore, it is also
defined here whether the time is a sunrise, sunset, the highest position of the sun or a fixed
switching time.

Fixed Time

If "Fixed Time" is selected for the Reference Time then a fixed switching time can be entered
here. Otherwise this field is greyed out.

Twilight

Here you can select the five twilight phases. The Reference Time can be checked via the
"Time" button. After the twilight phases, the twilight value is shown in arc minutes.

Time

With the aid of the Clock button, the times of the twilight phases can be displayed or,
conversely, a twilight value can be entered in arc minutes. To do this, a switching time is
entered in the Clock dialogue. After clicking on "OK" to confirm, a value is displayed in arc
minutes. If, for example 06.15 (6.15 a.m.) is entered in the Clock dialogue, then a twilight value
of -570 arc minutes is displayed. The calculated value varies from day to day.

Fixed Offset (min)

With the aid of this input field the previously selected Reference Time can be shifted by a fixed
length of time (in minutes). A negative value advances the switching time, while a positive value
delays it.

Order no. 7571 00 04 page 77/176



Editors

Random Offset (min)

Here, the Reference Time can be shifted by a random length of time (in minutes). The
adjustment is performed in 5-minute time intervals. The random time is then at some point
within the delay time. This function can be used to simulate the presence of occupants.

Earliest Activity/Earliest Time

The output is not switched any earlier than this time; it can be used for example to make sure
that a Venetian blind is never opened before 7.30 a.m.

Latest Activity/Latest Time

This defines the latest time at which the output may be sent; it can be used for example if a
Venetian blind is to be closed no later than 10.30 p.m.

Raw Time Output

This EIS 3 output object is used to output the pure reference time (raw time). This time does not
take into account any fixed or random times or the earliest/latest times. Above the arrow next to
the address field it is possible to select an address matrix or - if available - an address from the

imported ESF file of the ETS (see "Exporting Group Addresses from ETS").

Output Switching Time

This EIS 3 output object is used to output the actual switching time. This time takes into account
all offsets and the time limitations. It is the time at which the telegram is sent. Above the arrow
next to the address field it is possible to select an address matrix or - if available - an address
from the imported ESF file of the ETS (see "Exporting Group Addresses from ETS").

Configuration of Outputs

Once all of the required switching times have been defined in the "Configuration of Switching
Times", they are linked to the outputs in this configuration area. A maximum of 48 outputs can
be created.

Fig. 74. Complex Astronomical Clock - configuring outputs

List of Outputs

The created outputs are displayed in this table. Here, the output address, the EIS type, the
value of the output and the linking of switching times are displayed.

Order no. 7571 00 04 page 78/176



Editors

Add Output

In order to add a new output, a new entry must be inserted in the list by clicking on the button
"Add Output”. A highlighted entry entitled "unknown" appears in the List of Outputs, and the
input fields underneath are enabled.

Output Address

Mandatory field. The actual output address is entered in this field. The address of the object
which is to be controlled should also be entered here. Above the arrow next to the address field
it is possible to select an address matrix or - if available - an address from the imported ESF file
of the ETS (see "Exporting Group Addresses from ETS").

EIS Type

The EIS type of the output is defined here. The following are available: EIS 1, EIS 5, EIS 6, EIS
14 and EIS 15.

Value
This defines the value of the telegram. The value must correspond to the selected EIS type.
Weekday Time

The output address defines which object/device is operated. The time selection determines
when the command to operate the device is sent. The selection menu now shows the List of
Times which was previously configured. If the time is set to "Inactive" then no actions are
carried out.

Example: If a Venetian blind is to be operated on weekdays at the configured time "Weekday
Sunrise”, then this needs to be selected from the selection menu.

Saturday/Sunday Time

The switching times for operations at weekends can be defined in these two selection menus.
For example,. if the time that applies during the week should also apply at the weekend then the
"Weekday Time" is simply entered. If different times are to apply at the weekend then they must
first be configured in the List of Times.

[i] Save Output: To save a configured output, either click on "Add Output" again or select a
previously defined output from the List of Outputs.

Delete Output
To delete an output, it needs to be selected in the list (it is then highlighted in blue).
Trigger Configuration

In order to use the "Trigger" function or the link to the yearly time switch, a Trigger Address
must be entered in the input object of the job. The triggers are not displayed in the "List of
Outputs" overview, but instead are only displayed when the corresponding output is highlighted
in the list.

Link to the Yearly Time Switch

In order to establish a link to the "Yearly Time Switch" job, the trigger object of the Astronomical
Clock must be linked to the output of the yearly time switch. In the yearly time switch, the
Special Days 1 to 3 can be placed on a calendar timeline (refer to the "Yearly Time Switch" job).
This will then initiate the corresponding trigger settings in the Astronomical Clock via the EIS 14
values 2-4. In the Astronomical Clock the trigger values are pre-set accordingly.

[il A maximum of three trigger objects can be assigned to each Astronomical Clock job. If
multiple special times are required then multiple Astronomical Clock jobs will need to be
created for this.
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Trigger (e.g. Special Day 1, 2, 3)

The trigger is activated via this checkbox. The trigger will react to the trigger address indicated
in the job.

Trigger Value

In this field, the EIS 14 value needs to be entered via which the trigger is to be initiated (0-255).
The following values are possible for a link to a yearly time switch:

— Inaktiv=0

-  Weekmode =1

— S1=2(S = Special day) 2
— S 2=3(S = Special day) 3
- S3=4(S = Special day) 4
Time (Trigger)

Similarly to the standard output configuration, a time needs to be assigned to every trigger. This
is selected under "Time" and accesses the same list which was created under "Configuration of
Times".

Edit 'Trigger Only'

With the aid of this checkbox you can define whether an output should only be controlled by the
triggers, or whether the triggers and the standard weekday/weekend configuration should run in
parallel. If this option is checked then the time selection for weekdays and Saturdays/Sundays
is disabled.

Switch ON/OFF delay timer (EIS 1)

+ Gate with one input and one output. The output is sent with a time delay. The input
'CD object starts the timer. The format is EIS 1:

—  Time range from 1 to 65,000 seconds

— Delay Type: This defines which telegrams are sent with a delay. By default, all telegrams
are delayed at the input by x seconds. If required, the service can also restrict the delay to
just "ON" or "OFF" telegrams.

[i] If the input is different to this then the output is switched without a delay.
—  Enabling Object

Stair light time switch (EIS 1)

N When an ON telegram is received at the input, the OFF command is sent
L-._ automatically

after a configurable length of time.

— Time range from 1 to 65,000 seconds

— Enabling object

— Invert output: An OFF telegram received at the input becomes a delayed ON telegram at
the output

— Triggering: when another ON telegram is received at the input the delay time is restarted.

—  Stopping: this telegram at the output stops the automatic function.

Order no. 7571 00 04 page 80/176



Editors

Light scenes (EIS 1, EIS 5, EIS 6)

L Up to 28 KNX participants can be combined into a group. Here, you can assign to

J_ each participant an individual value which is to be transmitted by the participant. The
light scene is triggered via a start object. The triggering value (0 or 1) needs to be

specified for every group address. This means that 2 different light scenes are available for

each group address.

—  Enabling Object: The execution can be blocked or enabled via the enabling object (e.g.
time switch).

—  Start Object: The light scene is started via an EIS 1 telegram.

— Light Scene Triggering: This defines the value of the EIS 1 telegram which starts the light
scene.

— Memory Object: This object saves the current states of the light scene subscribers. If the
value of a subscriber has been changed and saved then the light scene is immediately
executed with the changed value. A save can be performed for an "ON" or "OFF" telegram.

—  Stoppable: The light scene can be stopped by a telegram at the input. This telegram must
not satisfy the start condition.

— Delay (s): The delay time is adjusted in seconds. A delay time of less than 1 second is
impossible for safety reasons (bus overload).

—  EIS types: The output addresses can be of type EIS 1, EIS 5, EIS 6, EIS 9, EIS 10, EIS 11
or EIS 14.

[il The light scene should always have just as many outputs set up as are actually used.

Receiving the time and date

IP Control can receive time telegrams (EIS 3) and date telegrams (EIS 4) in
@ E order to set the internal system clock. If the discrepancy between this

date/time and the IP Control system clock is too large the system clock is
adjusted. You can assign enabling objects.

With time telegrams you can also set the date to be taken into account, while with date
telegrams you can also set the time to be taken into account. The discrepancy which should be
tolerated before the system clock is corrected is entered in seconds.

Transmitting the time and date

1w Control can send time telegrams (EIS 3) and date telegrams (EIS 4). You
@ - can assign enabling objects. The time between the transmission of two
— | telegrams (telegram pause) is entered in seconds.

Service (clocks, light scenes)

Normally, clocks and light scenes can only be edited in the Job Editor. In order to enable the
end customer to also make changes himself to clocks and light scenes in the visualisation, it is
possible to position the Link Job Editor element in the visualisation editor.

Under Destination you can choose the clocks and light scenes that you wish to enable and
choose names you should agree with the customer. The clocks and scenes positioned in the
Visualisation Editor can also be changed subsequently in the visualisation.
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Threshold switch

As can be seen in the graphic below, there are two important switching events for the
| threshold switch:

First switching event: value exceeds switching point 1

In this case the upper threshold is exceeded. When the upper threshold is exceeded the Dead
time timer starts. If, once this timer has elapsed, the input condition Value above switching
point 1 is still satisfied then the output value parameterised in the column Upper threshold is
transmitted on the KNX. The associated KNX group address is entered in the Output
Parameters window. The output value can be EIS 1, 5 or 6. The aim of this dead time is to
prevent the threshold switch from constantly transmitting the output value on the KNX if the
input value fluctuates around the upper (lower) threshold.

After the output value has been transmitted on the KNX, the Repeat time timer starts. If, after
the Repeat time has elapsed, the input condition Value above switching pointl is still
satisfied, then the output value is transmitted on the KNX again. The system keeps running
through this program loop until the input condition Value above switching point 1 is no longer
satisfied. In our example this is the case after switching point 1.1.

If the input value is between the upper and lower threshold then the threshold switch transmits
nothing on the KNX.

Second switching event: value below switching point 2

When the value drops below the lower threshold the Dead time timer starts. If, once this timer
has elapsed, the input condition Value below switching point 2 is still satisfied then the output
value parameterised in the column Lower threshold is transmitted on the KNX. The output
value can be EIS 1, 5 or 6.

After the output value has been transmitted on the KNX, the Repeat time timer starts. If, after
the Repeat time has elapsed, the input condition Value below switching point 2 is still
satisfied, then the output value is transmitted on the KNX again. The system keeps running
through this program loop until the input condition Value below switching point 2 is no longer
satisfied.

Fig. 75: Switching points for the threshold switch
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Comparator

This job compares the value of an input object with that of a different one or with that
< of a static value. The result is assessed as being "True" or "False". The output can be
parameterised independently of the input.

Input 1 and 2

The two inputs are compared according to the selected comparison operations. Depending on
the outcome, the output is sent either as "True" or "False". The input objects contain the
following parameters:

Group address
The group addresses of the input object.
EIS format - input

— Here, the EIS type of the input object is selected. The following EIS types are supported by
the comparator:

—  EIS 1 (switching, 1 bit)

- EIS 2 (dimming, 1/4/8 bits)

- EIS 3 (time, 3 bytes)

- EIS 4 (date, 3 bytes)

—  EIS 5 (floating point, 16 bits)

— EIS 6 (percentage 0-100%, 1 byte)

—  EIS 8 (priority, 2 bits)

- EIS 9 (floating point, 32 bits)

—  EIS 10 (counter, 16 bits)

—  EIS 11 (counter, 32 bits)

—  EIS 14 (counter, 8 bits)

EIS 15 (text, 14 bytes)
Static

If this entry is active then the value from the adjacent field is used instead of the value of the
group address for the comparison operation.

Factor and offset

With the aid of these two parameters you can format the value of the group address. The value
is multiplied by the factor and the offset is added.

Comparison operations
The following comparison operations are available:

- ,="equalto

- ,<>"not equal to

- >"greater than

- ,<"less than

-, >="greater than or equal to
- ,<="less than or equal to

With each received telegram on the input object the comparison operation is carried out once
again.

Output ("true” or "untrue")

The corresponding output is transmitted depending on the result produced by the comparison
operation. The outputs can contain the following parameters:
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Group address
A group address is assigned to each output. Both outputs can also have the same address.
EIS format output

If the output is marked as static, the following EIS types are available:
—  EIS 1 (switching, 1 bit)

—  EIS 2 (dimming, 1/4/8 bits)

— EIS 3 (time, 3 bytes)

- EIS 4 (date, 3 bytes)

— EIS 5 (floating point, 16 bits)

— EIS 6 (percentage 0-100%, 1 byte)
—  EIS 8 (priority, 2 bits)

— EIS 9 (floating point, 32 bits)

—  EIS 10 (counter, 16 bits)

—  EIS 11 (counter, 32 bits)

—  EIS 14 (counter, 8 bits)

—  EIS 15 (text, 14 bytes)

Static

The value entered in the adjacent field is sent as the output value. The value must correspond
to the selected EIS type.

Dynamic output

The output does not have a fixed value. One of the following values is used as the output value:
—  Triggering telegram (input 1 or input 2)

— last telegram from input 1

— last telegram from input 2

If an input is static, no telegram received on the input object can be transmitted to the output.
Non-overwritable

If an input is static, no telegram received on the input object can be transmitted to the output.
Changes only

The changes only relate to the value of the relevant output object. Ist das Ausgangsobjekt
statisch, erfolgen keine Anderungen des Ausgangswertes. This setting is only meaningful in
conjunction with a dynamic output.

Mathematik

IP control contains a mathematic job. Apart from all conventional mathematical operations, this
also provides lots of other mathematical functions.

EIS Formats
The mathematic job supports the following data types on the input and output object:

- EIS1(1bit)

— EIS 5 (2 bytes FP)

- EIS 6 (1 byte)

- EIS 9 (4 bytes FP)

— EIS 10s (2 byte value)

— EIS 11s (4 byte value)

—  EIS 14u (1 byte unsigned)
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—  EIS 15 (14 bytes text)

Additionally, the job has an enabling object as well as an EIS 14 output for an error code and an
EIS 15 text output for an error text. They are output when the checkmark is set to "output
runtime error".

Inputs

All input fields titled in red mark mandatory data without which the job cannot be saved.
Flags

The job contains 2 flags:

—  Output runtime error: During activation, error codes are output per EIS 14 and error texts
per EIS 15. The address for this are entered in the fields below. An overview of the error
codes is already available at the end of the job description.

— Always calculate values: During activation of this flag, the output of the job is calculated for
each incoming telegram regardless of whether the value has changed or not. If the flag is
deactivated, a calculation only takes place when the value changes.

Inputs

There are 12 input objects available per mathematic job. These can correspond to the data
types mentioned above. The keyboard or ESF dialog are available for the input of a group
address. The latter is opened using the arrow key next to the address input field as an overview
of the data from the ETS, which was previously loaded into the IP control (see chapter ETS).

Fig. 76: Job-Editor - Job Mask Mathematic

Access to the inputs in the mathematical expression

The following syntax applies in order to use the values of the input objects for the mathematical
expression:

—  Theinputs 1-12 have the index numbers 0-11.

—  The respective value of the input object is brought to the mathematical expression by
entering "eo(indexnummer)". Thus, "eo(0)" for input 1.

— If, conversely,then the index of the object should be output (and possibly continue to be
used) on which a telegram was last received, then "eoi()" must be entered.
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Mathematical expression

The mathematical expression is combined in this field. The usual mathematical rules apply
here. During the output of the result, it should be born in mind that the level of the result does
not exceed the range of the data type from the output object! The following operations are
possible:

Mathematical operations:

Symbol Description

+ Addition (or stringing together of strings)

- Subtraction

* Multiplication

/ Division (real value)

% Modulo (remainder after an integer division)
& Bitwise "and*®

| Bitwise "or*

A Exponentiation

Logical (boolean) operations

Symbol Description

Il logical OR

&& logical AND

> Comparison operation "greater than"

>= Comparison operation "greater than or equal to"
< Comparison operation "less than"

<= Comparison operation "less than or equal to"

== Comparison operation "equality”

Other operations

Symbol Description
= Assignment
'(tand )’ Parenthesis for change of the operator priority
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Integrated functions

Symbol Description

sgrt(x) Square root calculation

sin(x) Sine calculation

cos(x) Cosine calculation

tan(x) Tangent calculation

max(X,...) Maximum determination of a (finite) quantity of values

min(x,...) Minimum determination of a (finite) quantity of values

rad(x) Conversion of degree to radiant (arc calculation)

asin(x) Calculation of the arc sine

acos(x) Calculation of the arc cosine

atan(x) Calculation of the arc tangent

ceil(x) Calculation of the smallest integer value that is not less than the
argument ("round up")

floor(x) Calculation of the greatest integer value that is not greater than the
argument ("round down")

abs(x) Calculation of the absolute value of an argument

exp(x) Calculation of the exponential function for the base 'e' (Euler's constant)

l0g10(x) Calculation of the logarithm of 10

pow(X,y) Exponential function calculates xy

time() Returns the system time in seconds since the beginning of the epoch
(00:00:00 UTC, January 1, 1970)

srand(x) Sets the (pseudo)random generator to a defined initial value

rand() Returns the next random number

eo_sum(x,...)

Adds up the EIB objects with the numbers according to the arguments

integer(x) Truncates the real number and returns the integer value only

fraction(x) Returns the decimal part of a real value (the places after the decimal
point)

round(x) Returns a correctly rounded integer of a real argument

Number types/classes and strings:

Class Notation

Integer numbers 42

Hexadecimal numbers O0x12ab

Real numbers 1.23

Exponential numbers 1.23e3 for 1.23 * 10”3 or 1023.0
Texts "text"
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Predefined constants:

Symbol Description

M_PI The constant Pi (3.14.....)

M_E The Euler's constant (base of natural logarithms)
M_LOG2E Logarithm for base 2 of ‘e

M_LOG10E Logarithm for base 10 of ‘e’

M_LN2 Natural log of 2

M_LN210 Natural log of 10

M_PI_2 Pi divided by 2 ("Pi-half")

M_PI_4 Pi divided by 4 ("Pi-quarter")

M_1 PI Reciprocal value of Pi (1 divided by Pi)
M 2 PI 2 times 1 divided by PI

M_2 SQRTPI 2 times 1 divided by the square root of Pi
M_SQRT2 Square root of 2

M_SQRT1 2 The reciprocal value of the square root of 2 (square root of 1/2)

Self-defined variables and several expressions in succession:

"a=10" assigns the value 10 to the variable "a". "a=1; b=2; a+b" assigns the values 1 or 2 to the
variables "a" and "b" and returns "3" as the result.

[i] Self-defined variables have a limited validity only within the calculation of an expression!
Examples:

Here are a few examples so that the use of various functions and operations is more
comprehensible:

— "eo(1) + 100" -> returns the value of the EIB object with the number 1 (in the following
EO_1) plus 100. It is important to always keep to the possible value range for the EIB
output object!

- "eo(3)*eo0(4)" -> multiplies EO_3 and EO_4. If EIB objects are used in an expression which
are not provided with GA in the editor, an error is reported. This should already have been
reported during the configuration, however.

— "100/eo(1)" -> divides 100 by EO_1. Caution: If a zero is sent to input 1, the calculation of
this expression will return a runtime error! ("Division by zero").

- "sgrt(eo(0)"2+eo(1)"2)" -> Calculates the length of the hypotenuse in a right-angled triangle
if on EO_0 and EO_1 the lengths of the sides are sent. ("Pythagoras' theorem")

- "eoi()" -> Returns a 2 if something is received on the EIB object with the number 2.
— "eo(eoi())" ->Returns the received value.

- "eo(eoi())"2" -> Calculates the square for every telegram value received.

— "rand()" -> Returns a random value.

—  "rand() & Oxff" -> Limits this value to a value range from O up to a maximum of 255. Hence,
the result would be representable in EIS_14.
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— "srand(time())" -> Returns nothing (or zero) but initialises the random generator with a
pseudo random initial value.

-  "eo(0)+eo(2)+eo(3)+eo(l)+eo(5)+eo(6)+eo(4)" -> Calculates the sum of several EIB
objects.

- "eo_sum(0,1,2,3,4,5,6)" -> As above, but much more "runtime friendlier" and insightful.

- "foo" + "bar" -> Returns "foobar" as result. This can only be output as EIS 15 on the
output, however.

Error codes and error texts

Number (error  Meaning or EIS 15 text output (in English)
codes EIS 14)

0 No error
42 Syntax error
43 General runtime error (e.g. division by zero or tan(Pl/2))
1 Missing right-hand bracket
2 Missing left-hand bracket (in the case of integrated function)
3 Missing right-hand bracket (expression found instead)
4 Unknown variable
5 Unknown keyword
6 Error in the string expression, must not contain any mathematical
operator
7 Division by zero
8 String cannot be raised to an assigned power
9 Error in the string expression, cannot be reconciled with operator
10 Error in the string expression, cannot be reconciled with operator
11 Missing comma
12 Missing argument
50 Error in EO function: Wrong number of arguments
51 Error in EO function: Wrong index
52 Error in EO function: EO is empty
Counters

Eight input objects can be counted with a counter job. There are 7 different counting operations
available for this purpose. In addition, the job can be controlled by an enabling object.

EIS Formats
The counter job supports the following data types on the input and output object:

- EIS1 (1 bit)

- EIS 5 (2 bytes FP)
— EIS 6 (1 byte)

- EIS 6 (1 byte)
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— EIS 10s (2 byte value)
— EIS 11s (4 byte value)
— EIS 11s (4 byte value)
—  EIS 15 (14 bytes text)

Mandatory fields
All input fields titled in red mark mandatory data without which the job cannot be saved.

Fig. 77: Job-Editor - Job mask counter

Address fields

If an address field has a yellow background, no valid group address has been entered yet. A
group address can be entered via the keyboard or via the ESF dialogue. This is opened via the
arrow symbol adjacent to the input field. The address can then be selected from the ETS data
imported previously (more information can be found in the chapter ETS).

Input type
The counter-job can execute various counting operations by selecting the input type:
— Inactive: The input is not counted.

— Increment: On receipt of a telegram, the result is increased by one regardless of data type
and value. The number of incoming telegrams on the input objects is counted.

— Decrement: On receipt of a telegram, the result is reduced by one regardless of data type
and value. The number of incoming telegrams on the input objects is counted.

— Add value: The value of the incoming telegram is added to the currently calculated value.

—  Subtract value: The value of the incoming telegram is subtracted from the currently
calculated value.

— Output value: If an input is detected on this object, the result of the counter is reset to this
value (the output value).

— Initial value: With this option an initial value can be used for further calculation. This
enables a kind of offset value to be defined.

— Accept value: The value of the input object is also used as the value for the output object.

Initial value
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The initial value can be defined if the corresponding counter operation was selected. This value
is used as a basis for further calculations. The initial value thus creates a kind of offset value.

[i] With the output object care must be taken to ensure that the counted value does not
exceed its value range.

Integrator

This job executes the mathematical function of the integration. The area calculation below the
graphs of a function is meant here (specific integral). The function here is the input value over
the time. Consequently, the job is particularly suitable for calculating the energy consumption
from the current values of the actuators with current value detection. An example for this is also
described below.

EIS Formats
The integrating job supports the following EIS formats on output and input:

- Input
— EIS1 (1 bit)
— EIS 5 (2 bytes FP)
— EIS 6 (1 Byte)
— EIS 9 (4 bytes FP)
— EIS 10s (2 byte value)
— EIS 11s (4 byte value)
—  EIS 14u (1 byte unsigned)

—  Output
— EIS 5 (2 bytes FP)
— EIS 6 (1 byte)
— EIS 9 (4 bytes FP)
— EIS 10s (2 byte value)
— EIS 11s (4 byte value)
— EIS 14u (1 byte unsigned)
A special feature of this job is the fact that the output can also send the result formatted in EIS

15. Hence, the places before and after the decimal point can be influenced via control
characters. The following syntax applies with the control characters:

—  Open control character - '%

—  Close control character - 'f'

—  Optional digit - '#

— Mandatory digit - '2' (example)

Example: A number with only 2 places before the decimal point but at least 3 places after the
decimal point is to be displayed: %2.###f

Mandatory fields

All input fields titled in red mark mandatory data without which the job cannot be saved.
Address fields

If an address field has a yellow background, no valid group address has been entered yet. A
group address can be entered via the keyboard or via the ESF dialog. This is opened via the
arrow symbol adjacent to the input field. The address can then be selected from the ETS data
imported previously (for more information see chapter ETS).

Interval

Order no. 7571 00 04 page 91/176



Editors

Since the integrator is based on a function over time, the time intervals of the x-axis can be
defined here. At the same time, the interval also determines how often the result is sent to the
output.

[i] The integrator's calculation is based on a constant corresponding to the input value that is
within the interval!

Reset

If this option is activated and no further input is detected within the set timeout, the output of the
job is reset.

Inputs

Each integrator can use 4 inputs. The different input values are added and integrated. There are
several things to bear in mind during the input configuration.

—  Factor: The input value is multiplied with the factor. Since this also determines the
conversion into the individual units, several factors are preset for this job. They can be
selected via the menu. The following are available:

—  mA in Ws (milliamperes in watt seconds)

— mA in Wh (milliamperes in watt hours)

— 100 mA in Ws (100 milliamperes in watt seconds)
— 100 mA in Wh (100 milliamperes in watt hours)

— Ain Ws (milliamperes in watt seconds)

A in Wh (milliamperes in watt hours)
Durlng selection, the correct factor is entered automatically.

—  Offset: The offset is added to the input value.

-  Minimum/Maximum value: Can determine a value range, in which the value of the input
object must lie.

— Timeout: Determines the time in seconds, after whose expiration a timeout is sent. If the
"reset" flag is activated in the output, the output is reset due to the timeout.

— Initialize: If activated, the input uses the information from the address status table when
initializing the job. After the interval time has expired, data is sent to the output according to
the information from the status table even if the actual value might differ in the meantime.

Example

As described in the "Top consumers" visualisation element, the integrator is primarily intended
for converting the current current sent to the KNX bus from the actuators with current value
detection into the energy consumption (e.g. in watt hours).

Here is a small example for this:

The configuration of a job for calculating the values to display in a "Top Consumers"
visualisation element:
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Fig. 78: Job-Editor - Configuration example for integrator

In the example presented, the job receives a milliampere value from an actuator with current
detection and calculates the watt hours from this. The output of the integrator is transmitted to
the "Top Consumers" element of the visualisation via a virtual group address.

Configuration of the "Top Consumers" Element

Fig. 79: Visualisation Editor - Configuration example for Top Consumers

The virtual group address is linked to a consumer in the visualisation element. Apart from the
correct data type and value format, nothing else needs to be considered.
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Sending e-mails

The IP Control can send out e-mails in response to events in the KNX.
@ An e-mail can be sent out to multiple recipients simultaneously.

Input object

This object launches the job, i.e. the dispatch of an e-mail. The exact details, e.g.
the ON edge, are defined under the "Conditions for sending".

Value object

The value of this object can be displayed in the body of the e-mail text with the aid of a control
character

. Detailed information about use of the control character can be found in Appendix 2: Control
characters. The value can be calibrated with the aid of a factor and an offset.

Conditions for sending

The sending of an e-mail can be instigated under different conditions. The following choice is
available: edge change, OFF, edge OFF, ON, edge ON, ON of OFF and edge ON of OFF.

E-mail provider

Here you should choose the entry for the e-mail provider via which the e-mails should be sent
out. The entry is directly linked to the e-mail providers created in the configuration tool (see
Appendix 9).

Type

Here the type of e-mail is specified for the corresponding recipient. If the entry "Inactive” is
chosen then this recipient is no longer taken into account.

Name/e-mail address

The name and e-mail address should be entered here. If no name and no e-mail address are
specified for the sender then the IP Control uses the address from the configuration.

Subject
This text will appear in the Subject line at the recipient.
Text

This field is where the actual body of the e-mail text is entered. You can have values entered via
value objects (see also Appendix 2: Control characters).

Settings in the configuration tool

In order to make proper use of the job e-mail dispatch function, you will need to create an e-mail
provider in the configuration tool. You can do this in the configuration tool under Configuration >
E-mail.

=  Click on the Add button to add one or more e-mail providers.

= After entering the name, you will need to select the settings for the SMTP server and the
TLS encryption.

[i] The settings depend on the particular provider. The address entered in the configuration
tool or the name of the sender is the default setting for the job. These settings are used if
no sender address or name is given for the job e-mail dispatch function. E-mail provider
settings which are no longer required can also be deleted again by clicking on the Delete
button.
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® In addition, you will also need to enter the IP address of the DNS server of your e-mail
provider. This setting can be found in the configuration tool under the "Network settings"
(see Appendix 5: Network settings).

Device linkage

The IP Control can be used for the device linkage. The IP Control can be used for the device
linkage. Address overlaps in the area of the physical addresses are not relevant here. The
address overlap of KNX group addresses is prevented here by using virtual KNX group
addresses.

Hardware installation
The IP Control devices are connected to each other via the Ethernet (LAN).
Parameterisation

The parameterisation of the device linkage takes place via the integrated Job-Editor — Job
"Device linkage". All parameters of the device linkage are always parameterised in the direction
of the KNX target system from the perspective of the local KNX system.

[i] If a KNX system 1 should be linked to a KNX system 2 and vice versa, the service device
linkage must be configured in both IP Control devices respectively.

Enable

Group address (format EIS 1) for enabling (value 1)/disabling (value 0) the function device
linkage. If nothing is entered here, this service is always active.

Host name or IP address

Host name or IP address of the IP Control target device of the device linkage (as soon as a
DNS server can be reached by the IP Control, the name of the target device must be entered.).

Delete host name immediately

— active: A name resolution takes place immediately when commissioning the IP Control
— not active: the name resolution first takes place during activation of the device linkage
service

Resolve host name each time

— active: during each start of the device linkage service, the host name is resolved once
again. (only useful for dynamic name resolution)
— not active: The host name is only resolved during the first start of the device linkage service

Feedback allowed

— active: allows feedbacks via LAN
— not active: Feedbacks via LAN are suppressed

Connection type

—  Direct (LAN): device linkage via Ethernet

Target System ID

Unique KNX system ID (0 - 255) — with no entry: Target system-ID =0
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Rules for device linkage

Wild characters can be used for fast entry of the rules for device linkage. The ™" symbol is used
as a wild card. Depending on the position (before or after the "/") the " represents the KNX
main group or subgroup.

Rule Severity

A All main groups and subgroups of the KNX system 1 are linked one-to-
one to the KNX system 2.
Caution: This function may only be used with a device linkage via
Ethernet!

6/* -> 6/* All group addresses of the main group 6 of the KNX system 1 are
linked one-to-one in the main group 6 of the KNX system 2.

7+ > 17/ All group addresses of the main group 7 of the KNX system 1 are
linked in the virtual main group 17 of the KNX system 2.
= No KNX address overlap is possible in system 2!

1 -> *1 The addresses 0/1; 1/1; 2/1...32/1 are linked one-to-one in the KNX
system 2

Virtual group addresses

Virtual group addresses are the main groups 16-32. They are only available in the IP Control
and cannot be used for the parameterisation of a system with the ETS. Virtual group addresses
are used during device linkages in order to avoid address overlaps. If, for example, a light scene
is to be started from system 1 in system 2, the light scene in system 2 receives a virtual group
address (e.g, 17/1). In the IP Control of system 1, the following rule is then parameterised:

e.g. 2/3 -> 17/1. The real group address in system 1 (e.g. assigned to a push-button) is
translated into the virtual group address in system 2 (the light scene).

UDP sender

s This job sends UDP datagrams to LAN patrticipants as a function of the input object.
(UDF | One application in this context is the sending of IR commands to any infrared devices
(refer to the section entitled Applications).

Input object

The group address is entered here which should trigger the transmission of the UDP
datagrams. The value of the input object determines which of the maximum of 8 UDP
datagrams is transmitted upon receipt. The EIS types EIS 1 (1 bit) and EIS 14 (8 bits) are
automatically interpreted — see Input/trigger value.

Host name/IP address
This is where the IP address of the recipient is set, e.g. the IP address of the IRTrans.
Port number

The port used by the recipient should be entered in this field. Check the port settings for the
recipient. In the case of IRTrans, you can do this via the web interface of the device.

[i] You can access the web interface by entering the IP address in your Internet Browser.
There, you will also be able to change all other settings for the IRTrans.
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Command mode

Here you can choose the command type. The IRTrans uses ASCII commands to send IR
commands from the database of the IRTrans (refer to "Transmission data" for information about
syntax).

[i] If the entry Disabled is selected then the corresponding line is not processed.
[i] Inthe command mode Hex the transmission data must be specified in hexadecimal.
Wildcard

If this entry is active then the IP Control transmits this UDP datagram every time the input object
is received.

Input/trigger value
This value specifies whether this UDP datagram is sent on receipt of the input object.

Example:

If the input object of type EIS 14 with the value 147 is received, the IP Control transmits the
UDP datagrams with the input/trigger value 147. The value range of the input/trigger value is
0-255 (EIS 14).

Transmission data

The sent data/commands are entered in this field. The syntax of the ASCII string for the IR
Trans is:

snd <remote>,<command>,<ledselect>

— remote - name of the device or remote control; this is specified during the process of
learning the commands (e.g. dvdplayer)

— command — name of the command; this is specified during the process of learning the
commands (e.g. play)

— ledselect — selection of the internal or external transmission LED
(I = internal, E = external, B = both)

Example: snd dvdplayer,play

[i] The parameter ledselect is optional and does not necessarily need to be used. If it is not
specified then the LED selection in the Device Settings is used.

[i] In the command mode Hex the transmission data need to be entered in hexadecimal.
Example: OA 39 F2 21 46 DE C4

SB Control

With SB Control it is possible to use several MP3 streaming clients to set up a multi-
SE(| room solution that can be controlled via KNX operating units.

SB Control is a job for remote control of Logitech Squeezebox devices and of the centralised
music server software SqueezeCenter. Operation is via a KNX push-button, room control units,
KNX panels or the IP Control visualisation. With SB Control it is possible to use KNX operating
units to switch a Squeezebox on or off, to mute it, to make it louder or softer, to navigate among
the titles in the playlists, or to select playlists. Titles of songs, playlists, status information such
as volume or muting can be displayed, for example via the text display of the B.IQ RTR room
control unit or via display elements in a MasterControl or or in the IP Control visualisation.
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Requirements for the operation of Squeezebox via IP Control:

a functioning SqueezeCenter on a PC or a network hard drive (NAS)

an installed and running ExPL plugin under the SqueezeCenter

(from the IP Control CD or from the Berker download area)

a running xPL hub on the SqueezeCenter PC or the network hard drive (NAS)

one or more Squeezeboxes connected with the SqueezeCenter with instance names that
differentiate them (e.g. room designations)

a Gateway address entered under the network settings in IP Control (configuration tool). If
no gateway is present, an unused dummy address must be entered e.g. 192.168.1.254)
Compiled playlists in the SqueezeCenter

Before setting up the SC Control job, read the documentation for the SqueezeCenter
software and the Squeezebox devices.

Before continuing commissioning of the Squeezebox control, make sure that at least one
playlist is defined in the SqueezeCenter.

Installing the ExPL plugin:

Copy ExPL directories from the CD or from the download area to the SqueezeCenter folder
Plugins

Fig. 80: Plugins folder for SqueezeCenter

Restart SqueezeCenter (restart PC) and check under SqueezeCenter — Settings — Plugins
if the ExPL Plugin has started.

Fig. 81: SqueezeCenter settings
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Install xPL Hub

SqueezeCenter is runs on a Windows System

=  Download Freeware Hub f.e. from www.xplmonkey.com and install it as a Windows

Service.

[i] More Hubs for different systems (f.E. Linux by using a network attached storage (NAS)) will
be found at http://wiki.xplproject.org.uk/index.php/Core_Software.

Creating the SB Control job

An SB Control job is defined for each Squeezebox that is to be controlled via KNX.

Parameters for SB Control

Element Name
Enable Object

SB Name

Max. Volume

Max. Vol. Input
Min. Volume
Min. Vol. Input

Vol. Dimming
Dimming Spd. per s

Vol. In Steps

Vol. Step Size
Output Volume

Set Volume

Zone On/Off
Pause/Play

Title Forward/Back
Forward/Reverse

Forward/Rev. Spd.

Name of the job in IP Control (e.g. "SC living room").

The enable object can be used to block or activate the execution
of the job.

Instance name of the Squeezebox that is to be controlled using
this job.
Absolute limit for the maximum volume of this Squeezebox (in %).

Object for defining the maximum volume via the bus, e.g. via
telegrams from a visualisation

(0% — 100%, 1 byte, EIS 6, DPT 5.001).

Absolute limit for the minimum volume of this Squeezebox (in %).

Object for defining the minimum volume via the bus, e.g. via
telegrams from a visualisation
(0% — 100%, 1 byte, EIS 6, DPT 5.001).

Object for controlling the volume via relative dimming telegrams
(dimming, 4 bits, EIS 2, DPT3.007).

When the volume is dimmed up/down, the volume is dimmed each
second by the set amount (in %).

Object for increasing or decreasing the volume in steps by
pressing a button briefly when there is a button with a dimming
function; via switching telegrams (louder = on)

(switching, 1 bit, EIS 1, DPT 1.001).

Size of steps for changing volume in steps (in %).

Object for outputting the current volume as an EIS6 telegram (0%
—100%, 1 byte, EIS 6, DPT 5.001) .

Object for setting an absolute volume with a telegram. Is limited by
the max. and min. volume (0% — 100%, 1 byte, EIS 6, DPT 5.001).
Object for switching the Squeezebox on/off

(switching, 1 bit, EIS 1, DPT 1.001).

Object for switching the pause function on/off (Pause = on)
(switching, 1 bit, EIS 1, DPT 1.001).

Object for navigating in the track list (Forward = on)

(switching, 1 bit, EIS 1, DPT 1.001).

Object for controlling the search function within the track (Forward
= brighter) (dimming, 4 bits, EIS 2, DPT3.007).

Parameter for setting the size of jumps for the search function
within the track. The unit of measurement depends on the end
device.
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Playlist Forward/Back
Text Display Output

Text Input Infotext

Reset Text Display

Reverse Reset
Reset when Zone Off
Reset when Mute
Display "no playlist"
Display "no title"

Time Playlist Visib.

Time Mute, On/Off

Time Volume

Object for selecting the next or previous playlist (Forward = on)
(switching, 1 bit, EIS 1, DPT 1.001).

Object for transmitting the text information to a single-line text
display (ASCII text, 14 bytes, EIS 15, DPT 16.000).

Object for showing additional texts from an external source from
the bus, e.g. fault messages
(ASCII text, 14 bytes, EIS 15, DPT 16.000).

Object for resetting the alarm text line of the B.1Q display. The
alarm text line can be used for the text information of this
Squeezebox control. If the Squeezebox is switched off, the alarm
function of the B.1Q display is reset and the normal display
contents are shown again.

Alternatively the B.IQ display can also be configured right away
with a text line, or a different KNX display with a text function can
be used, in which case this object is superfluous

(switching, 1 bit, EIS 1, DPT 1.001).

This flag can be used to invert the output of the Reset Display
object (similarly to the settings for B.1Q).

Selects whether the display is reset when the Squeezebox is
switched off.

Selects whether the display is reset when the mute function is
switched on.

Controls whether "no playlist” is displayed when no playlist is
available for selection.

Controls whether "no title" is displayed when no title is available for
selection.

Time (in s) after which the text display of the selected playlist
name returns to the standard display (as a rule the title of the song
being played at that moment). All other text displays to which none
of the other timeout rules apply also come under this parameter.

Time after which the text display of the on/off and mute status
returns to the standard display.

Time after which the text display of the volume status returns to
the standard display.

The following job parameters define the interface to a high-performance visualisation interface
that is capable of depicting up to four text displays on a single screen. Here SB Control depicts
an extract of all of the available playlists. "Page PL Fwd/Back" can be used to display the next
four or previous four playlist names. Transmitting a value from 0 to 3 selects the corresponding
line and plays the selected playlist.

Current Playlist

Select PL Line 1
Select PL Line 2
Select PL Line 3

Select PL Line 4

Object for text output of the current playlist name
(ASCII text, 14 bytes, EIS 15, DPT 16.000).

Object for text output of the first item in the playlist selection
(ASCII Text, 14 Bytes, EIS 15, DPT 16.000).

Object for text output of the second item in the playlist selection
(ASCII text, 14 bytes, EIS 15, DPT 16.000).

Object for text output of the third item in the playlist selection
(ASCII text, 14 bytes, EIS 15, DPT 16.000).

Object for text output of the fourth item in the playlist selection
(ASCII text, 14 bytes, EIS 15, DPT 16.000).
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Current Title
Current Album
Current Artist

Page PL Fwd/Back

Select PL

Command Input

xPL sender

Object for text output of the current title
(ASCII text, 14 bytes, EIS 15, DPT 16.000).

Object for text output of the current album
(ASCII text, 14 bytes, EIS 15, DPT 16.000).
Object for text output of the current artist
(ASCII text, 14 bytes, EIS 15, DPT 16.000).

Object for going to the previous or next page in the playlist
selection (the next or previous 4 playlist names) (Forward = on)
(switching, 1 bit, EIS 1, DPT 1.001).

Object for selecting a playlist from the playlist selection. (Values
0-3 for selecting lines 1-4)
(0 - 3, 1 byte, EIS 14, DPT 5.010)

Object for accepting control commands
(1 - 67, 1 byte, EIS 14, DPT 5.010).

2 — Update playlists. If the playlists in the SqueezeCenter have
been modified, this command can be used to apply the
changes in IP Control.

21 — Next playlist

22 — Previous playlist

23 — Next title

24 — Previous title

25 — Lower volume using dimming speed, stop with 27
26 — Raise volume using dimming speed, stop with 27
27 — Stop volume changing

28 — Lower volume by one step

29 — Raise volume by one step

30 — Zone off

31 - Zone on

32 — Play (Mute Off)

33 — Pause (Mute On)

34 — Transmit display contents again

35 — Start forward until stop with 37

36 — Start reverse until stop with 37

37 — Stop forward/reverse

38 — (B.1IQ) Reset display

39 — Forward by one step

40 — Reverse by one step

62 — Display the current title

63 — Display the current playlist

64 — Display the current volume

65 — Display the switching state of the zone

66 — Display the play/pause state

67 — Display information: SB Control version, ExPL plugin version,

current playlist source, current volume, minimum volume,
maximum volume, zone status, mute status
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The IP Control can send xPL datagrams as a function of the KNX telegrams. These

I* datagrams can be heard and processed by other XPL participants in the LAN. One
application in this context is the control of music playback via a SlimServer (refer to
the section entitled Applications). The SB Control job is a job which is optimised for
the control of the Squeezebox, and which performs the functions of the xPL transmitter (see SB
Control job and the chapter "Applications").

Input object

The input object determines which of a maximum of 16 commands are executed. The EIS types
EIS 1 (1 bit) and EIS 14 (8 bits) are automatically interpreted — see Input/trigger value. On
receipt of the input object the list of commands is worked through in full from the top to the
bottom.

Value object

If text is sent to one or more XPL subscribers, a value from the KNX value can be added to the
text via this function - such as a temperature value Almost all EIS types are available for the
value object:

- EIS1
- EIS2
- EIS3
- EIS4
- EISS5
- EIS6
- EIS8
- EIS9
- EIS10
- EIS11
- EIS14
- EIS15

Furthermore, each value object can be calibrated with factor and offset.
Service type

The service type defines the type of XPL datagram we are dealing with. There are three
different types to choose from:

- Command
—  Status message
- Event message

The entry Command nearly always makes sense, as most xPL commands originating from the
IP Control are intended to be executed. If the status Disabled is selected the command is
ignored during execution.

Wildcard

If this entry is active then the IP Control transmits this command every time the input object is
received.
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Input/trigger value

This value specifies whether this command is sent on receipt of the input object. To do this,
either an EIS 1 or EIS 14 value must be received at the input.

Example:

If the input object of type EIS 14 with the value 147 is received, the IP Control transmits the
command with the input/trigger value 147. The value range of the input/trigger value is 0—
255.

xPL broadcast
If this entry is active then this command is transmitted to all xPL devices in the LAN. For
example, this can be used to simultaneously stop or start multiple SlimServers in the LAN.

xPL manufacturer/devicel/instance

These settings are used for clear and unique addressing of a device for which the xPL
datagram is intended. The address is made up of the xPL manufacture, the xPL device and
the xPL instance.

The syntax is: [manufacturer]-[device].[instance]
For the SlimServer, this yields the following address: slimdev-slimserv.instance.

These values can be found in the xPL Hal Manager under xPL device. The instance
corresponds to the name of the Squeezebox, e.g. LIVING_ROOM. The names of the
Squeezeboxes can be assigned via the SlimServer (Settings > Player).

[i] When assigning a name to the Squeezebox, please note that it must not exceed a length of
15 characters.

The IP control always transmits under the following address: berker-ip-control.[serial number]
xPL sheme

The xPL scheme describes the device type/class and defines the associated commands. In
some cases, a device may support multiple schemes. As well as the scheme Audio.Slimserv
for audio control, the SlimServer also supports the schemes Remote. Basic and OSD.Basic.
With the scheme OSD.Basic it is possible to control the display of a connected Squeezebox.

xPL command

This is where the actual command is specified which is to be transmitted. The commands are
linked to the selected scheme. Most of the commands do not require any further parameters, in
which case there is no need to input the additional data.

Additional data

This field is intended for the input of additional text parameters which are required for some xPL
commands. This is, for example, the case with the scheme/command Audio.Slimserv/play list.
The name of the playlist which is to be started is entered here.

Some of the commands are marked with (VALUE). These can display the value of a value
object in the command with the aid of a control character (%f). Detailed information about use of
the control character can be found in Appendix 2.

If OSD.Basic is chosen as the xPL scheme and write as the xPL command then the text
entered here is output on the display of the Squeezebox.

SlimServer receiver

. This job translates the title information transmitted by the SlimServer onto the KNX.
This information is then displayed in the visualisation or on KNX displays. The title
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information is sent by the SlimServer as XxPL datagrams into the network. The SB Control job is
a job optimised for integration of the Squeezebox, and which performs the functions of
displaying the title information on KNX displays (see SB Control job and the chapter
"Applications").

IP Control receives these datagrams and then broadcasts them as an EIS 15 value on the KNX.
For this job, the services described in Appendix 8: (xPL requirements) must be installed and
running.

Settings
The name and enabling object have the same meaning as for the other jobs.
xPL broadcast?

If this setting is active then the xPL datagrams are evaluated by all of the Squeezeboxes in the
network. In this case, the xPL instance does not need to be set.

XxPL instance

The xPL instance defines which Squeezebox is used as the source. This differentiation makes it
possible to evaluate the title information of just one Squeezebox even if there are multiple
Squeezeboxes in the network. This value can be found in the xPL Hal Manager under xPL
device.

The instance corresponds to the name of the Squeezebox, e.g. LIVING ROOM. When
assigning a name to the Squeezebox, please note that it must not exceed a length of 15
characters. The names of the Squeezeboxes can be assigned via the SlimServer (Settings >
Player).

Outputs

Here you choose the group address to which one of the pieces of information (artist, album,
song) is to be sent. The value of the object has the type EIS 15.

Mode/display

The text can be displayed in different ways. You can choose between the following display
variants:

—  Left-aligned
- Right-aligned

The following display variants are still being implemented:

—  From start character

—  From start character (maximised)

—  From start word

—  From start word (maximised)

— Rolling to the left (by character)

— Rolling to the right (by character)

— Rolling to the left (by word)

— Rolling to the right (by word)

— Rolling to the left and right (by character)
— Rolling to the left and right (by word)
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Speed

This setting allows you to set the rolling speed. A distinction is made between the following
speeds:

—  Stationary (no rolling)
- Very fast

- Fast

—  Normal

—  Slow

- Very slow

"Start" character/word

In planning.

XPL Remote. Basic receiver

Not only can the IP Control send xPL datagrams to control other xPL devices and
applications, but it can also receive them. This job then translates them onto the KNX.

In this way, switching processes can be also instigated on the KNX by other xPL
devices and applications. The requirement for this is that the scheme Remote. Basic is
supported.

Element name and enabling object
The element name and enabling object have the same meaning as for the other jobs.
xPL broadcast?

When this entry is enabled the xPL datagrams from all XPL devices and applications are
processed. If only the datagrams from one particular device should be processed, then this
entry must be disabled and the full name (xPL manufacturer/device/instance) specified.

XPL manufacturer/devicel/instance

These values are used for clear and unique addressing of the xPL devices, and they can be
taken from the xPL Hal Manager under xPL Device. (Appendix 8: XPL requirements).

Zone "broadcast"?

When this entry is enabled all xPL datagrams from all zones are processed. If the entry is
disabled then attention is only paid to the XxPL datagrams from the zone whose name is
specified.

Zone name

The zone name is either fixed or can be freely changed depending on the device or application.
The zone for the SlimServers is called slimserver.

Zone "broadcast"?

When this entry is enabled all xPL datagrams from all terminal devices located in the LAN are
processed. If the entry is disabled then attention is only paid to the xPL datagrams from the
terminal device whose name is specified.

Terminal device name

For most devices, the terminal device name can be freely chosen. The choice of names that
can be assigned and the specifics of how they need to be set up depend on the device and the
manufacturer. Please refer to the operating manual supplied by the manufacturer. In the case of
the Squeezebox, the terminal device name is the same as the xPL instance.
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[i] xPL settings:
It is easiest to access the xPL settings via the monitor of the xPL Hal Manager. There you
will be able to see all of the xPL datagrams in the network and derive the individual
parameters (see Appendix 8: xPL requirements).

Power status

Here you can define what the status of the device should be for the xPL datagram to be further
processed.

ON  The xPL datagram is only processed if the device is switched on.

OFF The xPL datagram is only processed if the device is switched off. When switched off, the
Squeezebox will only send the key code dead when any of the buttons on the remote
control are pressed.

ANY The xPL datagram is processed regardless of the status.
Entry no.

With the send mode EIS 14, the entry No. is sent as a value to the corresponding group
address.

Outputs
The entered group address is transmitted when the corresponding command is received.
Send mode

The send mode determines what is sent to the selected group address. The following send
modes are available:

EIS1 Switch over
EIS1 ON
EIS1 OFF

EIS 14 Entry no. equal to value

EIS 15 The key code is sent to the group address. If the key code "+" is entered then all
received key codes are sent to the group address.

Key code

The key code which should be entered here depends on the xPL device. You can look it up in
the documentation or manual for the xPL device, or you can use the monitor of the xPL Hal
manager for observation. There you will be able to see the individual xPL datagrams in plain
text.

The key code can also be made visible on the bus monitor or on displays. To do this, select the
send mode EIS 15 and enter "RE:.+" (RE colon dot plus) as the key code. Then all received key
codes will be sent as text to the selected group address and can be made visible on the bus
monitor or on displays.

IRTrans receiver

N This job makes it possible to trigger events in the KNX in conjunction with the IRTrans
with any IR remote control. To do this, the IP Control receives the UDP datagrams
transmitted by the IRTrans and then broadcasts KNX telegrams according to its
configuration. The IRTrans with Ethernet connection and database is required for this
application.
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[il The processes of setting up remote controls and learning the IR commands are performed
with the aid of the IRTrans software. In the process, names are assigned to the remote
controls and commands. These need to be known during the configuration of this job.

Element name and enabling object
The element name and enabling object have the same meaning as for the other jobs.
Port number

Only the UDP datagrams received via this port are processed. Use of port 21001 is preferred for
IRTrans. Check the IRTrans settings in the web interface of IRTrans.

IRTrans "Broadcast"

When this entry is enabled all UDP datagrams from all IRTrans modules located in the LAN are
processed.

If the entry is disabled then attention is only paid to the UDP datagrams from the IRTrans
module whose name is specified.

IRTrans name

The name of the IRTrans which is to be listened to is entered here. If the entry IRTrans
Broadcast is enabled then the name is ignored and all IRTrans modules are listened to. The
name of the devices is assigned with the IRTrans software.

[i] Only use alphanumeric characters for the names.
"RC" broadcast

Multiple remote controls can be set up in one IRTrans. This entry must be enabled if all of the
remote controls are to be processed by this job. Otherwise only the remote control whose name
is entered will be used.

"RC" name

The name of the remote control which is to be listened to exclusively. If the entry RC Broadcast
is enabled then the name is ignored and all remote controls are responded to.

Entry no.

With the send mode EIS 14, the entry no. is sent as a value to the corresponding group
address. For example, this might be done in order to call up a particular light scene.

Outputs
The entered group address is transmitted when the corresponding command is received.
Send mode

The send mode determines what is sent to the selected group address. The following send
modes are available:

EIS1 Switch over
ON
OFF

EIS 14 Entry no. equal to value

EIS 15 The key code is sent to the group address. If the key code "+" is entered then all
received key codes are sent to the group address.
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Key code
The name for the learned command assigned with the IRTrans software is entered here.

[i] Important! The processes of setting up remote controls and learning commands for the
IRTrans are performed via the IRTrans software. Changes are not implemented until the
database is loaded (flashed) into the IRTrans.

Check the port settings for the recipient. In the case of IRTrans, you can do this via the web
interface of the device.

[i] You can access the web interface by entering the IP address in your Internet Browser.
There, you will also be able to change all other settings for the IRTrans.

Fig. 82: Web interface IRTrans
Check the settings IR Relay Configuration. Enter the following parameters there:

— UDP port =21001
— Broadcast address = 255.255.255.255
—  Enable UDP relaying

[i] In order to avoid any mix-ups and improve flexibility, when using several IRTrans modules
we recommend loading them all with the same database (flashing). This has the major
advantage that all set up remote controls with commands are available in every IRTrans.
This also means that the process of learning the commands, which can be lengthy, only
needs to be done once. Changes to the assignment can be made quickly and easily in the
Job Editor.

UDP receiver

The IRTrans receiver job is a job which receives UDP telegrams and then sends out KNX
telegrams on the basis of this. Thees UDP telegrams do not necessarily have to be sent from
an IRTrans module, but can instead also come from other devices (e.g. from a PC in the
network). In this way switching processes can also be triggered in the KNX by other devices Auf
by means of UDP telegrams.
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UDP datagram

In order for the IP Control to be able to process the UDP datagrams, they need to comply with a
particular syntax:

<Name or remote control>,<Name of command> 0d Oa

The two placeholders (<Name of the remote control> and <Name of the command>) stand for a
freely chosen device PIN. The hexadecimal values 0d and Oa stand for return and line-feed.

Example:
living, light 0d Oa — This example telegram must be sent to the IP address of the IP control on
the selected port.

Job Parameters

The following parameters and values should be entered in the window of the IRTrans receiver
job:

Port number

Enter the number of the port here to which the UDP datagram is to be sent. Enable IRTrans
broadcast.

"RC" name

Enter the name of the remote control here (see UDP datagram).
Key code

Enter the name of the command here (see UDP datagram).

The remaining settings and parameters should be used in the same way as for a standard
IRTrans receiver.

Wake on LAN

With the aid of the job Wake on LAN it is possible to "wake up" up to 8 PCs or other

f’l'"'l clients via the network, i.e. to switch them into operating mode.
LAM

Parameters

Active

Selection of the active or enabled entries

Wildcard

If this flag is set then the WOL packets are transmitted for every input value.
MAC address

MAC address of the device which is to be woken up

Transfer type

Standard setting: UDP broadcast.
It is possible to switch over to UDP unicast in order to reach devices which are behind a router.

Broadcast IP

IP address of the device which is to be woken up
Standard: 255.255.255.255
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UDP port

The port can be changed to allow the packets to pass a router.
Standard: 40.000

RSS Feed Sender

The RSS Feed Sender sends item headings of RSS feeds in the form of 14-character
ASCII texts to the bus, whereby the text runs through letter-by-letter or in block steps

of up to 14 characters. A maximum of 8 different RSS feeds can be worked through in
sequence, whereby a navigation and control can be implemented with EIS 14 telegrams.

Enabling object
Optional control object for activation [1] and deactivation [0] of the service.
Command

Optional control object for control and navigation. Control commands [EIS 14 values]:

[100] New retrieving of all entries RSS from the Internet
[101] Jump to next entered feed

[102] Jump back to previously entered feed

[103] Jump to next item heading within the current feed
[104] Jump back to previous item heading within the feed
[107] Accelerate the text display

[108] Slow down the text display

[109] Stop and continue the text display

[110] Switch to the character-by-character running text display
[111] Switch to the block-by-block display

1. Output

Object for outputting the RSS feed texts onto the bus.

Update

[15 .. 120 .. 3825] minutes

The feeds are updated from the Internet after the specified time.

Speed

[1..2..255][g]

The time in seconds until the next text fragment is displayed.

Pause

[1..4. 255]s]

The time in seconds during a changeover until a further feed in the RSS feed list
Jump width

[1 .. 14] [characters]

The length of the string of characters which is skipped during the display of the next text
fragment.

RSSFeed 0..7
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URL
The URL for the desired feed (e.g. http://www.tagesschau.de/xml/rss2 ).

Quantity

[1..100]

The maximum quantity of displayed item headings per feed.
Max. age

[600 .. 35.791.394] [minutes]

The maximum age of a feed in minutes since the last update from the Internet. If the feed
cannot be updated in this time then it is no longer displayed until the update.

Fault displays

Displays fault messages instead of the feed if it was not possible to retrieve the feed from the
Internet.

Announcements
Displays the name of the feed before the display of the corresponding item headings.

HTTP- Request

Contents of web servers can be retrieved and processed or data sent to a server by means of
http Requests. A valid Request consists of a URL with one or more parameters. The URL
(Uniform Resource Locator) is composed of three parts - basic URL, target and value object(s).
These can be freely configured in the job. Mandatory fields are element name, input object and
Up to ten value objects can be defined.

Fig. 83: Job-Editor - HTTP Request

Element Name

Mandatory field. A uniqgue name by which the job can be identified unequivocally
Enabling Object

The job can be controlled by an enable (EIS 1).
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Input object

Mandatory field. The input object must correspond to type EIS 14. The various entries are
resolved in the target objects based upon its value. If the "wildcard" option is set in the target
objects, the triggering EIS 14 value is not relevant.

Error text

If the query is not successful, the server usually displays an error message. The job can
reproduce this as EIS 15 text message.

Protocol

"http", "https" (http-Secure) can be used as protocol. Https transfers the data encrypted. The
server and client (IP Control) must exchange certificates and keys for this purpose. The
establishment of a connection therefore takes much longer.

Basic URL

Mandatory field. The address of the server to be addressed is entered here. DNS names or IP
addresses can be used. With a DNS name, the DNS settings in the IP Control must be correct
or the entered DNS server must be reachable.

[i] A DNS request might take slightly longer. The IP address of the server can be entered to
accelerate the execution of the job. The DNS request is then not necessary.

[i] If the IP address of a DynDNS account changes, this might differ for a short period of time
from the address stored in the internal DNS table. Then the request is set to the wrong
address.

Auth Name and Auth Password

User name and password can be entered here for an http authentication if necessary. If the
"http" protocol is activated, the http Basic Authentication is used. User data and password are
transferred unencrypted. In the case of "https", the same logon is used, but the transfer of the
authentication data is encrypted, too.

Number of targets (target objects??)

Several targets can be assigned to each basic URL The variable part of the URL that changes
for the different function calls is entered in the targets. A maximum of 8 targets is possible.

Wildcard

If this option is activated, the corresponding target and the job is triggered by any EIS 14 trigger
value.

[i] Only one target is "retrieved" per http request so that there can only be one wildcard entry
per job
Trigger value

Is an EIS 14 value that triggers the request with the respective target. EIS 14 can have a value
from O to 255.

URL

The basic URL is completed with this field. The variables "\0" to "\9" must be used in order to
transfer the value objects entered in the following part. Whereby the "backslash" 'announces' a
value object and the following number determines the value objects 1-10. "0" is value object 1
and "9" is value object 10

[il The separation by a "/ (slash) character is not added automatically between basic URL
and URL completion. This must be set by the user either at the end of the basic URL or at
the beginning of the URL completion.
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Value objects
Up to ten value objects can be defined. Every value object can contain the following EIS types:

- EIS1
- EISS5
- EIS6
- EIS9
- EIS10
- EIS11
- EIS14
- EIS15

Fig. 84: Job-Editor - HTTP Request Value Object
Address

Specify the group address here that the corresponding value object should transfer.
EIS Type

The format field behind changes with each EIS type.

Format

The format field is set depending on EIS type. The format field is used for giving the incoming
value object the desired formatting. The format is an expression that must be entered according
to the output value in the URL completion. Thus, "ON" or "OFF" can be used instead of "1" or
"0" for EIS 1.

— EIS 1: Atext can be specified for "1" and "0".

— EIS 5 and EIS 9: Factor and offset are adjustable. The value is multiplied by "Factor" and
added with "Offset".
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— EIS 6: Isinterpreted as a percentage value from 0% to 100%. The percent sign is not
transferred. This must be entered in the URL completion (by means of "%%").

- EIS 10, EIS 11 and EIS 14: Are copied directly to the URL completion as text values.

— EIS 15: These values are copied directly as text values. Consequently, completely free
completions can be realised from the KNX. EIS 15 allows a maximum of 14 characters.

Graph

The visualisation element Graph produces a curve of values plotted over time.
Application examples for this include temperature curves, counter states, power
curves etc. The telegrams are taken from the ring buffer (500,000 telegrams) from IP

Control.

Supporting the IP control tablet visualisation

[i] This element is also displayed in the Ajax visualisation. The graph provides several
additional functions there that cannot be used with the Java visualisation. The
corresponding functions are marked in the parameter window with an "*".

Figure 85: Graph - Parameter

Updating at the start

The graph updates its entries immediately when starting the visualisation.
Grid Line Colour / Axis Colour

Determine the colour from the grid and axes.
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AXxis Format

This text field influences the number format of the y-axis. The number of permissible digits
before and after the decimal point is defined. The following Syntax applies here:

- A"0" stands for a mandatory digit, i.e. the digit is still displayed even if no value is present.

-  A'# stands for an optional digit. The digit is only displayed if a value is actually present.
However, the system will never display more digits than indicated.

— A'"."stands for the decimal point.

— I, for example, a percentage sign is to be added, then this must be put after the number in
inverted commas ().

Examples:

The number "21.2" is to be displayed If the number format is defined as "00.00", then the
number "21.20" is displayed. If the number format is defined as "0.##", "21.2" is displayed. A
percentage sign with "0.##%" is inserted

Axes Limit

The y-axis is set to a fixed value range with this checkmark. The range can then be set in the
fields below.

[i] Care must be taken to ensure that the graph with the corresponding data setting also finds
values in the history table. If the data of a corresponding group address is assigned with a
time stamp long before the current time e.g. due to an incorrect eibPort time, the data will
not be seen in the graph (or the graph will have to be scrolled backwards until this date).

Auto. Update

Once the visualisation is opened, the graph updates itself automatically after this interval (in
minutes). At the same time, current data is retrieved again from the IP control history table and
new measurement points are calculated.

Time range
Determines the underlying time frame of the graph The following choice is possible:

— 1 hour

— 3 hours
— 6 hours
— 12 hours
- 1lday

- 2days

- 1 week

Fixed time range

When activated, the time range is always displayed continuously from beginning to end. If the
option is deactivated, the time range is always calculated back from the current time.

Lead time / delay time

Determines the time interval in minutes, in which data is taken into account even before and
after the beginning or end of the time range. If, for example, the time range is set on a day,
values will also be taken into account that were active before or after 0:00. Otherwise, the graph
would not accept any value ("0") at this point and would display incorrectly.

Range "Scroll" (also available under Java)
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With this option, the user can scroll forwards or backwards in the visualisation by the respective
set time range if data is available at this time.

Calculation
A distinction is made between two different types of calculation:

— Total: The value of the object is plotted absolute over time. In the case of a counter status
measurement the graph would rise continuously

— Difference: The difference between two sequential values of an object is plotted over time.
The frequency of the differential measurements in minutes can be adjusted under
"Interval". The smaller the time interval, the more accurate the graph.

Data type
The display of the following EIS formats is supported:

- EIS 1 (1 bit)

- EIS 5 (2 bytes FP)

— EIS 6 (1 byte)

- EIS 9 (4 bytes FP)

— EIS 10s (2 byte value)

—  EIS 10u (2 byte unsigned value)
— EIS 11s (4 byte value)

— EIS 11u (4 byte unsigned value)
— EIS 14s (1 byte value)

—  EIS 14u (1 byte unsigned value)
— DPT 29 (8 byte signed value)

[i] The appendix offers an overview of EIS types in conjunction with DTP data types.
Title

Enter a legend for the curve here. The text is displayed below the graph in the curve colour
selected.

Factor / Offset

The input value can be formatted in any way required by means of Factor and Offset. The value
is multiplied by "Factor" and added with the "Offset".

Colour
Determines the colour and curve of the title.
Curve type (only with IP control tablet visualisation)

Curve type determines which form of diagram is displayed. The following is available for
selection:

— Line: A line diagram is drawn

— Area: An area diagram is created in which the area below the line is marked
correspondingly.

Drawing levels (only with IP control tablet visualisation)

If activated, levels are drawn instead of curves. This is interesting, for example, when
representing EIS 1 values.

Drawing points (only with IP control tablet visualisation)

The various measuring points are drawn on the line of the graph upon activation.
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Continuing value (only with IP control tablet visualisation)

If no value for a group address is recorded for a group address for some time, this can result in
the graph displaying "0", for example, (when intermittently changing the time range) even
though the previous value of the group address is still actually active. With this option, the value
is presented so that the value currently in the chart is displayed.

Functionality within the JAVA visualisation

Within the Java visualisation, the 'Diagram' element offers further functions which can be called
up by right-clicking on the diagram:

— Refresh:
Refreshes the values of the diagram.

—  Export as image...:
Opens the file browser so that the diagram can be saved as a graphics file (*.png).

— Exportas CSV...:
Opens the file browser in order to save the values of the diagram as a CSV file.

Information for the history table (ring buffer)

The graph uses past values. To do this, it needs to use the ring buffer of the IP Control (EIB
history table) This has capacity for 500,000 telegrams. In the process, the oldest telegram is
replaced by a new one 500,000 telegrams may not be enough for the desired time period
sometimes. This is remedied here by the history recording filter:

Figure 86: ConfigTool - EIB history recording filter

A history recording filter needs to be set up so that the graph can also display consumption data
etc. for longer periods of time. This determines from which group addresses the data is written
to the ring buffer. The recording history filter is created under "System" > "Configuration" > "EIB
History Recording filter” via rules. It is possible to specify either complete group addresses or
ranges. A wildcard character (*) is entered for ranges.

Example: "1/*/*" (without quotation marks) means that only the data of the main line 1 are
recorded. It is sufficient to enter "1/1/*" if you wish to filter by the middle group. When filtering by
whole address, that address is simply entered.
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6.5 Berker IP Control Mobile (IPCM)

IP Control Mobile is an IP Control visualisation for mobile terminal devices such as the iPhone,
iPod Touch or mobile phones/PDAs with suitable Internet browsers (e.g. Opera mobile). This
means that you can use mobile terminal devices to switch lights, change temperatures or query
values, as well as to integrate the image of a webcam and to control multimedia. You can set up
and configure the IP Control Mobile using the IP Control Mobile Editor.

The user interface of IP Control Mobile is accessed via the browser of your mobile phone.

URL:
http://172.70.60.18/ipcm

Fig. 87: Example of user interface for mobile applications

IP Control Mobile Editor

You can use the IP Control Editor for IP Control Mobile to create the project for your mobile
phone, PDA or iPhone. Directories and elements are available for setting up a visualisation in IP
Control Mobile.

Directories
The directories are located inside of a view; they can be used to reproduce any desired tree
structures (directory > subdirectory > subsubdirectory...> element).

Element

An element has certain properties (see element types), and is located in a directory. Each
element has assigned to it a group address that it listens to and also transmits to in the event of
active operation.

Available element types
EIS 1 on/off

On/off is transmitted when operation is activated. When operation is deactivated, this element
can be used as a simple status display.

EIS 5 temperature

This element has actual and setpoint displays that indicate the values of the assigned group
addresses. When operation is activated it is possible to change the setpoint temperature in the
specified steps using +/-.
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EIS 5 value floating point

Depicts values of the type EIS 5. It is also possible to define maximum and minimum values and
steps for the operation.

EIS 6 value 0-100%

Depicts values of the type EIS 6. It is also possible to define maximum and minimum values and
steps for the operation.

EIS14 value 0-255

Depicts values of the type EIS 14. It is also possible to define maximum and minimum values
and steps for the operation.

Camera

Displays the image of a webcam; to enable this the parameters of the URL for the freeze frame
of the camera must be entered in the parameters (e.g.: http://<camera_IP>/jpg/image.jpg).
Please refer to the user instructions for your camera.

Shutter

Element for controlling a Venetian blind / roller blind.
MediaControl

Controls the media player connected to the system.

List

Element for starting playlists (e.g. from SqueezeCenter™)

Working with the IP Control Mobile Editor

Calling up the IP Control Mobile Editor

= Using a PC, establish a connection with IP Control and open the Editor on the IP Control
start page.

u Use the menu Window > IP Control Mobile to access the IP Control Mobile Editor.

Fig. 88: IP Control Mobile — editor and pop-up menu
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Functions
The following commands can be accessed quickly via the menu bar:

© | Load - The current IP Control Mobile Project is loaded from IP Control.
B Save - Saves the IP Control Mobile project in IP Control.

| New Element — Opens a selection list that can be used to add a new element of the desired
type
Left column - Element overview

In the element overview, all necessary elements are first added via the corresponding button in
the control menu. Each element is created automatically in a category folder. Hence, the
element "EIS 14 value" is stored in the "Value" folder, for example. In this column, all necessary
elements are sorted by their category and can be configured via the parameterisation window
(right column). The context menu is used for deleting an element or entire folder.

Fig. 89: Mobile Editor - Element overview

Middle column — Visualisation view

The middle column corresponds to the view in the visualisation. The division made here can
also be seen later in the mobile phone browser. The division made here can also be seen later
in the mobile phone browser. A folder is created via the context menu (right-click in the column).
The elements parameterised previously in the left column are dragged into the desired folder by
"drag & drop". The display can, for instance, be allocated according to floors and rooms and/or
functions. The context menu is used for deleting an element or entire folder.

Fig. 90: Mobile Editor - Visualisation view

Right column - Parameterisation window

In the right column, the parameters of the elements are entered. These are displayed as soon
as a selection is made in the left or middle column. During the parameterisation, it makes no
difference in which column the element is selected.
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Fig. 91: Mobile Editor - Parameterisation window

Address assignment

The addresses in the IP Control Mobile Editor can be assigned comfortably via the ESF
dialogue as in the case of the other editors. This dialogue is opened by clicking on the arrow
symbol adjacent to the address input field. An overview is displayed via the addresses of the
uploaded ESF file or address matrix. An address is assigned to an object by double-clicking. A
maximum of five addresses can be assigned to each input object. Feedback addresses are
entered in brackets behind the address used, separated by commas.

Protecting access to IP Control Mobile using a password

To prevent unauthorised access to the IP Control Mobile visualisation, you can activate a
password. This can be done in the configuration tool in the area User Administration using the
button IPCM Password. (Figure 23)

Fig. 92: Assigning passwords in the configuration tool

[i] If no characters are entered, IP Control Mobile can be accessed without a password query.
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[i] If a password has been entered, a password query appears in the browser when the IP
Control Mobile page is called up. The username here is always "ipcm" (Figure 23).

Fig. 93: Password query in mobile applications
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7/ System

With the aid of this menu item you can access the configuration tool. There you can
select/change the basic parameters and various settings for the integration of IP Control in
network routing, password administration etc. The chapter "Initial installation" covers these
settings in detalil.

Device PIN

Before you can access the configuration tool you will be asked to enter a device PIN. The PIN
of the device can be found on a sticker in these instructions and on the back of the device. Itis
used to identify the IP Control and is unique.

[i] The device PIN cannot be changed and is requested every time the configuration tool is
accessed. The device PIN is used to protect the IP Control settings against misuse. Please
note that the device PIN input is case sensitive.

Passwords

In addition to the device PIN, access to the configuration tool is also protected with user names
and passwords. The passwords can be changed in the System area.

The following default passwords are active on delivery:

Area: User name: Password:
Visualisation Editor admin berker
System admin berker

[il To change a password the new password needs to be entered twice. This prompt does not
appear when no password is entered. Access rights to the visualisation pages are assigned
under the user management in the Visualization Editor.

7.1 Configuration tool

Adjustments of settings and parameters for the IP Control are performed independently of the
ETS via the configuration tool. All settings are implemented here: uploading images and files,
setting up users, creating backups, ...

Configuration

The parameter categories are contained in the panel on the left. Click on a category to have the
parameters displayed in the right-hand panel. The number of displayed parameters depends on
the user rights. The Online help function will assist you with parameter setting.

To display the Online help function, click on a parameter name with the mouse. In this chapter
you will find more in-depth information about the following categories:

General

This is where fundamental settings like names, physical addresses and assembly/installation
locations are defined.

Expanded KNX (bxd) settings

Further settings are selected here. These include for example the port selection for
communications.
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Fig. 94: Configuration tool window

Network settings
Use DHCP

If Use DHCP is enabled then the following four parameters (IP address, subnet mask, ...) are
not taken into account. The IP Control does not receive these parameters from the DHCP
server in the network. The IP Control will reboot after these settings are changed. This process
will take a moment.

DNS server
If you are using a DNS server to resolve the names then you can enter its IP address here.
Time server

[i] If no time server is used, the clock of the IP Control must be set manually (see Section 4.1
Setting the clock); otherwise errors will occur in the transmission of commands between
the PC and IP Control.

The IP Control can be used as an KNX clock. It gets the current time from an NTP server
(Network Time Protocol) and adjusts its own internal clock accordingly. This time can then be
sent via a time transmitter to other KNX participants. For this function, enter the IP address or
the name of one (or preferably two or even three) NTP time servers.

Public NTP servers:

— Physikalische Technische Bundesanstalt ptbtime2.ptb.de
—  Technical University of Berlin ntps1-0.cs.tu-berlin.de
— University of Erlangen ntp0.fau.de

Please note that the IP Control must establish a connection to the Internet before you can use
this function. Make allowance for this in the network administration. The IP Control will attempt
once a day to reach a time server in order to match its time. If the attempt at reaching a
registered NTP server fails repeatedly then the IP Control will attempt this process again at
particular intervals.

KNX group address filter

The IP Control saves the last 10,000 telegrams in its ring memory. Rules can be defined here
as to which group addresses are stored in the memory. In this way, individual group addresses
can be selectively acquired or entire middle groups/main groups can be acquired in this way.
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E-mail

In order to send out e-mails, additional settings need to be selected as well as configuring the e-
mail job. The necessary providers need to be set up via whom the e-mails are sent out.
Instructions on how to set up e-mail providers can be found in Appendix 9.

File transfer

Pictures and graphics, IP Control components and ESF files can be loaded into the IP Control
here.

Loading pictures

Pictures and graphics for the visualisation are loaded here. The following formats are
supported: JPEG, BMP, TIFF and PNG.

= Click on Choose File and select an image file.
= Enter a description in the Description field and click on Start Upload.

Progress is indicated on the bottom edge of the window. The overview window shows a list
of loaded pictures and graphics.

=  Click on Refresh list to update the list.
Loading IP Control components

Here files are loaded from freely definable switches. Freely definable switches are created and
saved with the separate ComponentBuilder.

= Click on Choose File and select a file.
= Enter a description in the Description field and click on Start Upload.

Progress is indicated on the bottom edge of the window. The overview window shows a list
of loaded pictures and graphics.

= Click on Refresh list to update the list.
Login an ESF file

Data can be loaded from ETS projects in order to facilitate the assignment of group addresses
in the different editors. The address table then shows the available group addresses in the ETS
project together with a description. Please refer to the help files provided with the ETS for more
information on how to export data from ETS into an ESF file.

= Click on Choose File and select a file.
=  Click on Start Upload.
The ESF file is loaded into the IP Control.
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Save/Restore

The configuration files as well as all jobs, visualisation files and pictures can be saved and
subsequently restored.

Performing a save

The save file can contain the following information:

Configuration files data:

Saving of the configuration files

All files:

Saving of configuration files, jobs, visualisation data and pictures/graphics

= Click on Save.

=  Enter a clear and unique name and click on Save.
The save is performed.

Restoring saved data

=  Click on File and select a saved file.

=  Click on Restore.
The saved data are restored.

[i] IP Control will reboot after restoring a project. This process will take a short time (around
1 — 2 minutes). During the boot process IP Control cannot be reached and changes are not
adopted.

Control of IP Control

Cold start: Complete restart (corresponds to disconnecting the power supply)
Warm start:  Restart of the KNX kernel

LED test: Test of the Signal LEDs

BCU reset:  Restart of the BCU

User administration

The user administration in the configuration tool is independent of the user administration in the
Visualisation (Visualisation Editor). In the Visualisation Editor the user rights are defined for
access to visualisation data. In the configuration tool the user rights are defined for access to
the configuration tool functions.

Creating a new user
= Click on Add User and enter a user name.

If the option "Visible" is selected then the user name is displayed in the selection list during
user logon.
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Assigning user rights

Fig. 95: User administration view

®=  Right-click on a user name and select Edit from the context menu.

Fig. 96: User settings

Order no. 7571 00 04 page 127/176



System

User

The name of the user.

User name

The user name used to log on (this is defined when a new user is created).
Password/Repeat password

User logon password and repeat input of the password for verification.
Change password

If this is set then you will be prompted to define a new password during every user logon.
Visible

If this is set then the user name is displayed in the selection list during logon.
Visualisation Editor

The user will only be granted access to the Visualisation Editor if this option is selected. The
user name and password are then requested when the user accesses the Visualisation Editor.

User administration

If this option is set then the user is granted access to the user administration of the configuration
tool. The following parameters define whether the user is to have access to the different areas
of the configuration tool.

=  Check the boxes for the areas for which the user is to be granted access.
Areas for which access has not been granted will be hidden in the configuration tool.
Save/Restore
Access to the Save/Restore data area.
Control of IP Control
Access to the IP Control restart functions.
Data transfer

Access to the functions for loading pictures, own switches created with the ComponentBuilder
and ESF files.

Configuration

In the Configuration area you can assign the following user levels to the individual parameter
categories.

User level Effect/function

Not visible The parameter category is hidden.

Level 1 Initial start-up; only the parameters required for initial start-up are displayed.
Level 2 Standard

Level 3 Expanded access

Level 4 Full access to all parameters

[i] The MouseOver help function shows which parameters can be edited at the respective
levels.
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Delete user

® Right-click on a user name and select Delete from the context menu.

Database

The IP Control can establish a connection to a database and write numerous types of
information to that database. As well as telegrams and the current status, log information can
also be recorded in the database.

Establishing a database connection
® Right-click in the left-hand field.

A popup menu will appear for creating a new database connection.

Fig. 97: Database connection window

= Enter the following parameters in the window:

Description | This is the name used to set up the database connection in IP Control.

Enable This checkmark is used to enable and disable the database connection.
Database At present, IP Control only supports MySQL databases.

type

Host The IP address of the computer on which the database is stored.

Port The port for the database communications; the default port is 3306.

Database The name of the database.

User name | User names
The user must be given the rights INSERT, DELETE and UPDATE in the
administration of the MySQL server.

Password Database password

=  Save the parameters by clicking on the Save button.
The information is saved in a table in the database.

The following table types are available (they only differ in terms of the information written to
them by the IP Control):

Status table

Table showing the current states in the KNX.
Telegram table

All telegrams are collected in this table.
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Log table
Numerous types of log information are collected in this table.

Adding a table to the database connections

= Add the table by right-clicking on the database connection.

Fig. 98: Database connection configuration tool

= Next please enter the following parameters:

Fig. 99: Database connection parameters

Description This is the name used to set up the database connection in
IP Control.
Enable This checkmark is used to enable and disable the database connection.
Type Table type
Name Name of the table

In the table underneath you can define which types of information are to be written to the
database table. With the aid of the Generate SQL Statements button you can generate
the SQL commands with which the corresponding database is created on the server.

[il Important! The information can only be written to the database if it is possible to establish
a connection to the database. Physical interruptions (disconnected mains plug, failure of a
router or other network components) will result in the loss of information.
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Status table

This table collects the current states of the KNX group addresses and their time stamps. This
table type is also necessary for the IP Control Mobile (previous version 0.8.5) Visualisation.

Telegram table
All KNX telegrams (group address, value and time) are collected in this table.
Log table

Log information is collected in this table. The recording depth of these log messages can be set
in the configuration tool.

Telegram table Status table Log messages
System ID Serial number IP Control time
Serial number Group address Relevance

Group address Data Serial number
Data Telegram ID Origin

Telegram ID Process ID Text

Process ID IP Control time Process ID

IP Control time Initial time The most recent time
The most recent time The most recent time Log ID

Source type Source type Repetition counter
Source address Source address

Routing counter Routing counter

Update counter

Generate SQL instruction

The appropriate instructions that cause a database server to create the database with the
corresponding tables are generated with the "Generate SQL instruction" button. The instruction
can be changed via the checkbox in the upper part of the window if an existing database of the
same name should be deleted.
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Fig. 100: Configuration Tool - database connection- generate SQL instruction

Start page

The start page of the IP Control can be loaded with various options or with your own picture or
graphic. The following options are available:

Display standard page

The familiar start page with the buttons Visualisation, Editor and System is displayed.
Open visualisation in a separate window

The visualisation is launched directly in a new window.

Opening visualisation in a browser window

The visualisation is launched directly in a browser window.

User-defined start page

The background image uploaded here is used as the background image.

[i] Regardless of the settings chosen here, the standard page can be reached directly under
the following URL.:
http://<IP-Control>/bmxJava2/default.php (see also Appendix 10: URL parameters)

KNXnet/IP

To couple the IP Control to KNXnet/IP gateways, activate KNXnet/IP. As a result, all KNX
telegrams are broadcast to all KNXnet/IP gateways, and all KNX telegrams are received by all
gateways.

Filter rules can be defined by clicking on Advanced. This means that only entered group
addresses are transmitted or received.
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8 Object Structure

IP Control replicates the structure of the communication objects of the KNX. This means that up
to 5 group addresses can be assigned to each object. This allows the assignment of the group
address of e.g. an actuator channel to be directly replicated. This keeps IP Control informed at
all times about the actual status of the actuator (not the group address), thus negating the need
for complex working with return messages. This approach simplifies the task of creating logical
links, as up to 5 group addresses can be assigned to each input object of the gates.

IP Control supports 32 main groups (with 2 or 3-digit syntax). These are
divided up as follows:

IP Control address space

0-15 Real KNX address space

[i] The real KNX address space is sent by the IP Control to the KNX.
16-31 Virtual KNX address space

[i] The virtual KNX address space is used by the IP Control in the network and internally in the
IP Control.

On the basis of this division of addresses the real KNX bus load can be reduced. A centralised
visualisation which is connected to the network can e.g. selectively activate/deactivate timers in
the IP Control without placing a strain on the KNX.

General syntax

After the first group address, the remaining addresses should be placed in parentheses and
separated with commas.

Example: 2/12(2/13,2/14,2/15,2/16)
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9 ETS

9.1 Inserting the IP Control into the ETS

There is no ETS application for the IP control, and this means that it cannot be inserted directly
into the ETS project.

A dummy device should be inserted into the project to ensure that the physical address is
reserved in the project and so that, if necessary, filter tables can be correctly generated.

9.2 Exporting group addresses from ETS3

In order to transfer the group addresses from the project which is to be visualised to the IP
Control, the group addresses are exported into an esf file with the OPC Export function of the
ETSS3. In the process, all of the group addresses which are linked in the project are written to
the esf file.

In the ETS3, the export of the group addresses is selected via the "File" menu and the "File
Exchange (e.g. OPC)..." menu option. Here, the esf file with the used group addresses is
generated in the "Export to OPC Server" area via the "Export" button. This is then loaded into
the IP Control in the editor of the IP Control under "File Transfer".

9.3 Connection settings in the ETS

A new communication interface must be set up in order to establish a connection to the iETS
server in the ETS. The following parameters must be used:

Communication type

IP (EIBlib/IP) must be selected as protocol for the connection.
Server

The IP Control or DynDNS address of the IP Control.
Protocol

A TCP or UDP can be selected (since version 0.8.5, previously only TCP). UDP should only be
used if the packet runtime of the connection is very high. In this case, the establishment of a
connection via TCP might fail due to longer runtimes. UDP can reduce the runtime here.

Ports

The ports must not be changed. It is only possible for the IETS server in the IP Control to
establish a connection on these port numbers (50000 — 50002).

Connection

These settings are determined by the serial interface that should be addressed in the bus
coupler of the IP Control. This setting can be ignored.
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9.4 Notes on using the iIETS server

When using the IP Control as a programming interface, important information must be taken
into account:

Disconnection

The iIETS server in the IP Control must be terminated correctly. The server needs the
termination signal from the ETS. If the client computer has crashed or the ETS was not
terminated correctly, the iETS server will continue running. After a waiting time of 5 minutes, the
iIETS server can be terminated by triggering a telegram. Alternatively, the device can also be
restarted.

KNXnet/IP Tunneling

Fig. 101: Configuration tool - KNXnet/IP Tunneling

KNXnet/IP Tunneling has been implemented since the firmware, version 0.8.5. KNXnet/IP
Tunneling must be activated in the configuration tool in the KNXnet/IP settings (System >
KNXnet/IP). The checkbox "activate KNXnet/IP for EIB* and "EIB for KNXnet/IP* must be
activated there. It cannot be used for programming. It is intended for communicating with other
devices that also have a Tunneling interface e.g. B+O Mediagateway).

[i] Itis intended for communicating with other devices that also have a Tunneling interface
e.g. B+O Mediagateway).

Connection quality

The connection quality can play an important role particularly in the case of connections via the
Internet. Normally, the connection with EIBIlib/IP is established via TCP. TCP first establishes a
virtual connection between client and server before the actual communication begins. In the
case of longer package running times in the Internet, the connection might be interrupted
constantly. The use of UDP as protocol can solve this. In contrast to TCP, UDP has no control
mechanisms (data loss etc.)

Port forwarding

If a connection to the iETS server should be established via Internet, it is necessary to provide
the router in the receiving network appropriate port forwarding. The ports 50000, 50001 and
50002 must be forwarded.
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Activating/deactivating iETS server

The function can be activated or deactivated in the IP Control. The setting can be carried out in
the configuration tool under Configuration > Extended EIB (yabus) Settings> EIBIlib/IP Server.
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10 Cameras and IP Control on the Internet

This chapter describes the settings required to reach IP Control and cameras on the Intranet
and Internet. The IP addresses mentioned here are examples and may need to be modified.

10.1 Network structure diagram

IP Control settings

IP address:

Standard gateway
address:

Ports:
Camera settings
IP address:

Standard gateway
address:

Port:
PC settings
IP address:

Standard gateway
address:

Router settings
IP address:

Fig. 102: Network structure

192.168.1.10

192.168.1.200
80, 1735, 50 000 - 50 002

192.168.1.2

192.168.1.200
81

192.168.1.3

192.168.1.200

192.168.1.200
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In the network, a distinction is made between internal and external IP addresses:

[i]

The internal IP addresses are fixed IP addresses and are assigned to the devices in the
Intranet (IP Control, camera, PC, router).

The Intranet can be reached from the Internet via the external dynamic IP address. The
Internet service DynDNS.org manages these external IP addresses. The router translates
the external IP addresses into internal IP addresses.

Important! A routing table needs to be set up in the router. Depending on the model, the
corresponding function can be found in different locations in the menu of the router. Look
for menu items like DMZ or Port Forwarding.

The function for the DynDns.org service needs to be enabled and set up in the router. Entry of
the routing rules is different for every router, but follows the following layout:

[Port Number] -> [Internal IP Address]:[Port Number]

The IP control and the camera are distinguished via the port number. In the example, the IP
control can be reached via port 80 (standard) and the camera via port 81.

The inner IP address is the address which has been assigned to the IP Control or the camera.
With the IP Control, port 80 is for the visualisation and port 1735 is for the Java applets. For the
camera, you will need to specify the port assigned to the camera in the routing rule.

Example of a routing table with DynDNS service:

80

= 192.168.10.1:80 (visualisation)

1735 =>» 192.168.10.1:1735 (Java applets)

81

= 192.168.1.2:81 (camera)

10.2 Settings for the camera element in the visualisation

The URL address for the demonstrations is:
http://www.berkerbeispiel.dyndns.org:81

[1]

So that the camera can also be reached from the Intranet, the router must support internal
enquiries to external IP addresses. Please refer to the operating manual for the router. If
the router does not support this function then you will need to insert a further camera
element. This will need to have the internal IP address of the camera:

Example: http://192.168.1.2:81
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11 IP addresses on the Internet

Usually the IP control is connected via a router to the Internet. In order to be able to reach the
gateway, the gateway must be given its own IP address:

Static IP address

A static IP address always remains unchanged. An IP Control with a static IP address can be
reached under this IP address via the Internet. You can request a fixed IP address from your
provider.

Dynamic IP address

Every device which dials itself into the Internet (and does not have a fixed IP address) is
automatically given a dynamic IP address by the Internet Service Provider. The address will
change every time the connection is established. This is why the IP Control cannot be reached
under a dynamic IP address.

Even if the IP Control remains constantly connected to the Internet via a router it is not certain
that the current IP address will remain valid. Some ISPs automatically disconnect the
connection every 24 hours.

[il Free services are available on the Internet (e.g. berkerexample.dyndns.org:81), which link
dynamic IP addresses to a domain. Here you are given your own domain address (e.g.
berkerexample.dyndns.org), under which you can always reach your IP Control. In order to
take advantage of this service you will need a router which is capable of autonomously
dialing into the Internet and connecting to the DNS service. Please refer to the operating
manual which was supplied with your router.
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12 Changing the language settings

To switch over the language in the IP Control visualisation, a parameter in the Java VM
software needs to be changed or added. Proceed as follows:

= |n Windows, click on Start -> Settings -> Control Panel.
®=  Double-click on the Java symbol.
=  Click on the Java tab.

=101

Allgemein  Java | Sicherheitl Erweitertl

T Java-Applet-Laufzeiteinstellungen

Die Laufzeiteinstellungen werden bei der Ausfibrung eines Applets im
Browser verwendet,

 Laufzeiteinstellungen Fir Java-Anmsendungen

Die Laufzeiteinstellungen werden beim Starten won Java-Anwendungen
oder -Applets per Java Metwark Launching Prokocal {IMLPY verwendet,

Anzeigen. .. |

QK | Abbrechen | Anwenden |

Fig. 103: Java Control Panel

=  Click on Displays in the Java Applet Runtime Settings field.

The Java Runtime Settings window will open.

Java Runtime-Einstellungen |

Java Runtime-Yersionen

Produkknarms Warsion Adresse Jawa Runtime-Parameker
RE 1.6.0_03 NProgramme’ Javaljrel.6.0_03  |-xmx256M -Duser language=de

oK I Abbrechen |

Fig. 104: Java runtime settings

= Enter the required language in the column Java Runtime Parameters:

German-Duser.language=de
English-Duser.language=en
Swedish-Duser.language=se
French-Duser.language=fr
Spanish-Duser.language=es
Dutch-Duser.language=nl|
Italian-Duser.language=it
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[i] If you have installed several different versions of Java over time, make sure that the
parameter is entered on all versions.

Click on OK to close the Java Control Panel.
Close the browser and all other programs which use Java.
The chosen language is displayed after restarting the browser and calling up IP Control.
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13 Applications

With the numerous available jobs, a wealth of applications can be realised quickly and easily. A
number of ideas are described in more detail below.

13.1 IP Control — IRTrans

Together with the IRTrans, the IP Control can transmit infrared signals via the IRTrans as a
function of group addresses. This means that all devices which can be controlled via an IR
remote control can also be operated via the KNX and the visualisation. The IP Control makes
the job UDP transmitter available for this purpose. For this application the IR Trans Ethernet
with database is required.

Fig. 105: IR control layout

IRTrans Ethernet with DB

IRTrans can be seen as a learning-capable IR remote control with a network connection.
IRTrans interprets the UDP datagrams received via the LAN with the aid of its database. The
previously learned commands are located in the database of the IRTrans. The process of
learning the commands and loading them into the memory of the IRTrans is performed via an

IRTrans PC software tool.

[i] Newly learned commands will not become active until the database of the IRTrans is
flashed.

[i] Information, operating instructions and software for IRTrans can be found on the Internet at
www.irtrans.de.

Check the port settings for the recipient, in particular the ports and broadcast settings. In the
case of IRTrans, you can do this via the web interface of the device.

[i] You can access the web interface by entering the IP address in your Internet Browser.
There, you will also be able to change all other settings for the IRTrans.
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Setting up an IR remote control for the control of several rooms

Proceed as follows if you want to use a remote control in several rooms but you want the
system to be set up so that the buttons you press only affect the room you are currently in:

=  Create the remote control with commands via the IRTrans software and then load (flash)
the database into all of the IRTrans modules.

=  Setup an IRTrans receiver job for every room in which an IRTrans is installed. Here,
disable the entry IRTrans Broadcast and enter the name of the IRTrans belonging to the
room to establish the link between the room and the IRTrans.

[i] The settings for the port (21001) can be left unchanged provided the settings of the
IRTrans module have not been changed.

= |f you have set up multiple remote controls to work in a room then you need to enable the
option RC Broadcast.

= Select the assignment of IR command and group address. Here, several EIS types are
available (refer to the section "IRTrans receiver").

= Afterwards enter the names of the commands which were assigned when the IR
commands were "learned".

= Save the settings.
The IR remote control is now fully set up.

It goes without saying that any other concept of your choice can also be realised. For example,
you could use the enabling object to selectively enable or block the use of individual IR remote
controls.

13.2 Music control with Squeezebox

With IP Control you have the option of controlling music via the KNX. The job xPL Sender is
available for this purpose. After receiving a group address, this job sends a command such as
play, stop, skip, back ... in the form of an xPL datagram to SlimServer, which in turn controls the
Squeezebox. In this way, volume and playback can be controlled via KNX buttons or via the
visualisation.

Another function of the music control is to display information about the music currently playing,
such as the name of the artist, song titles etc. These can be displayed in the visualisation or on
KNX displays. This function is also implemented via the SB Control job.

Fig. 106: Music control setup
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Server

The server contains SlimServer, a free server program. With the aid of SlimServer you can
manage the MP3 files and playlists saved on the server.

Squeezebox

The Squeezebox is a network player which plays back MP3 files saved on the server. It can be
controlled via SlimServer. Integration into the network is performed either via cables or W-LAN.

PC playback device

MP3 files can also be played back on a PC. Softsqueeze, a free software version of
Squeezebox, is available for this purpose.

[il The xPL setting must be enabled for SlimServer. This can be enabled via the web browser.
Go to http://localhost:9000/ to access SlimServer. The xPL settings can be found under
Server Settings > Network.

To use this function, you will need to have installed the xPL Hub service both on the server
and on all involved PCs (see also Appendix xxx: XPL requirements). The xPL Hub service
must be launched before SlimServer.

13.3 Further Squeezebox applications

Controlling lights with the Squeezebox remote control

With the Squeezebox, you can send IR commands from the Squeezebox remote control as xPL
datagrams into the network. The IP Control then translates this xPL datagram to a group
address. To do this, all you need to do is set up and parameterise the job XxPL Remote.Basic
Receiver. Notes on the xPL settings can be found in Appendix xxx: XPL requirements.

Squeezebox as a display device

As well as displaying track information, the display of the Squeezebox can also be used to
display text messages.

Example: door bell
When the door bell rings, the display of the Squeezebox shows the text message "Front door".

This application is also realised with the xPL Sender job. The configuration of this job is
performed in the same way as for the music playback controls (see xPL Sender), except that a
different scheme needs to be chosen.

Fig. 107: xPL scheme, shown here for the "Door bell" example
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The OSD.Basic scheme provides commands for controlling the Squeezebox display. Values

can also be output for the value object. This is done with the aid of the control character (see
Appendix 2).

13.4 Calling up web pages from the visualisation

In order to be able to call up specific Internet pages from the visualisation you will just need to
insert the Camera element into the visualisation. As the URL you should enter the
corresponding Internet address of the website you would like to call up from the visualisation. In
this way, with a single click you can view e.g. the latest weather forecast information from the
Internet on the visualisation.

[il You need to enable the option As Icon, and your browser settings must allow popups from
this source (IP Control).

Order no. 7571 00 04 page 145/176



ComponentBuilder

14 ComponentBuilder

The ComponentBuilder is an additional piece of software which can be found on the CD
enclosed with the device under ..\Deutsch\Software\Berker_ComponentBuilder.jar.

14.1 Application

With the aid of the ComponentBuilder you can create control panels with freely definable, static
display and control elements. The control panels can be inserted as visualization elements in
the IP Control and linked to group addresses. In this way you will obtain a personalised
visualisation with your own chosen elements to suit your requirements.

[i] It takes time to get used to working with the ComponentBuilder software. It is expressly not
intended for novice users. Please follow the instructions carefully and pay attention to all
additional notes and information.

14.2 Program window

The program window is split into 3 areas:

(1)

2 (3)

Fig. 108: Program window

Switch preview (1)

In this part of the program window you can see the individual segments of the panel. These can
be selected for configuration.

Configuration (2)

The size of the segments can be adjusted in the configuration. If a segment is selected then
detailed configuration options for this segment will appear.
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Data pools (3)

All of the required data for the current panel are created and managed in the data pools. These
include pictures, addresses, character strings and fonts.

14.3 The File menu

Open Opens a panel with the suffix.btn
Save Saves a panel with the suffix.btn
Close Exits the program

14.4 Defining a panel

A panel comprises between 1 (minimum) and 100 (10 x 10) (maximum) individual buttons and is
represented by a grid. Each box represents a segment and can be defined as one of the four
element types.

Fig. 109: Definition of the grid

Grid settings
Grid width No. of columns (max.: 10)
Grid height No. of rows (max.: 10)

Block size (Px) Height/width of a segment, 200 pixels max. Does not apply
if the cell height or column width has been changed.

Display grid Displays/hides the grid net

Information Width and height of the selected cell

Change column width
= Click on the yellow bar above a column.
=  Select the width in the input field.

Change cell height
= Click on the yellow bar to the left of a cell.
= Select the height in the input field.

Order no. 7571 00 04 page 147/176



ComponentBuilder

Fig. 110: Grid settings

Connecting segments

Multiple segments can be connected.

®  To do this, press and hold the Control key whilst selecting the corresponding segments
with the mouse.

=  Right-clicking on the selected segments will open up a popup menu with the option
Connect. You can also restore previously joined segments to their original separate status
by clicking on the menu operation Separate.

[i] You can only connect segments which are adjacent to each other and form a rectangle
together.

Fig. 111: Segment handling

14.5 Data pool

The data pool is used to manage all the data required for the current switch. These data include
graphics, addresses, character strings and fonts. The data first need to be created in the
individual tools before they can be used to generate the panels.

Images

Pictures and images for a panel can be individually loaded into the pool. They are then available
in the graphics selection and can be used as the background for the segments. All of the
images can be grouped together and saved in an Images pool. This file has the suffix.pool and
can subsequently be loaded for other switches as well.

The following image file formats are supported:

- .Jpeg
- Jpg
- .qgif
- .png
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Fig. 112: Managing the images/pictures pool

[i] Images can be deleted again from the Images pool by right-clicking on them.

Addresses

In the Addresses pool, address descriptions are assigned which are then replaced by the real
group addresses in the Visualisation Editor. An address is defined by the EIS type, factor and
offset.

The following EIS types are supported:

- EIS1: 1 bit, switching

- EIS3: 3 bytes, time (factor: 1, offset: 0)
- EIS 4: 3 bytes, date (factor: 1, offset: 0)
- EIS5: 2 bytes, floating point

- EIS6: 1byte, 0-100 %

- EIS9: 4 bytes, floating point

— EIS10: 2 bytes integer

- EIS11: 4 bytes integer

- EIS14: 1 byte, 0-255

Fig. 113: Address assignment, EIS type
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The character strings can also represent values from address objects. To do this, the address is
selected and the number of digits before and after the decimal point is defined. Afterwards, the
Insert value into string is used to insert the text at the cursor position.

[il The specified text can still be changed later on in the Visualisation Editor, for example it
can be translated into a different language.

Fig. 114: String assignment

Fonts

Here you can set up various fonts for the texts and character strings.

The preview shows the currently selected font in the specified font size and style (bold or italic).
We recommend mostly using standard fonts, as this will ensure that the visualisation looks the
same on different operating systems.

Fig. 115: Font properties
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14.6 Background & lettering

The way in which the elements are represented with regard to the background and the lettering
can be defined for all element types.

Background

Fig. 116: Background definition

Background type
Transparent

The button is shown transparent. This means that any elements underneath the panel in the
visualisation or the page background can still be seen.

Colour

You can choose a background colour from the colour charts.
Graphic

You can use a graphic (JPG or GIF) as the background.

Colour
u Click on the button Choose Colour and select a colour.

[i] This function is only available if Colour is chosen as the background type.

Graphic

=  Click on the arrow and select an image from the menu.

or

®=  Click on the plus symbol and insert an image from the hard disk.

[i] The menu contains all of the graphics from the data pool. This function is only available if
Graphic is chosen as the background type.

Text selection

Here you can select the text and font for a label/lettering. The different character strings and
fonts can be defined in the data pool.

Text
=  Click on the arrow and select an existing text previously created in Data pool / Character
strings.
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Font
= Click on the arrow and select a previously defined font from Data pool / Fonts.

Text colour
u Click on the button and select a text colour.

Fig. 117: Selecting the text colour

14.7 Static element

On the one hand, static elements are used for the graphic design of control panels. For
example, e.g. very narrow static elements can form a frame around a switch element or serve
as a visual separating bar between different active elements.

With the background type Transparent, the elements behind the control panels or the
background of the visualisation page are made visible.

You can also insert graphics and images. On the other hand, static elements can also be used
as labelling fields.

Defining a static element

Fig. 118: Element types

=  Click in a segment and activate the element type Static Element.
The parameters Background and Text Selection can be defined.

[il For more information, read the section entitled Background & lettering.
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[i] After making any changes during configuration, click on the Accept button at the bottom
edge of the window, as otherwise the changes will be discarded.

14.8 Display element

Display elements are used to signal states and display text and values (e.g. temperatures).
States can be signalled by means of colours, graphics and text with values. The way in which a
display element is displayed is governed by rules, whereby you can define rules for specific
states (e.g. ON) and threshold values (e.g. greater than 20).

Defining a display element

=  Click on a segment and activate the element type Display Element.

Fig. 119: Element types

[i] After making any changes during configuration, click on the Accept button at the bottom
edge of the window, as otherwise the changes will be discarded.

Configuring rules

Rules are used to define which display of the segment applies at which values. With every rule
a display/representation is saved for the relevant segment. If a rule is satisfied then the segment
adopts this display/representation. In this way, rules can be created for particular values (1; 2;
10; 2.25), threshold values (<20; >2.5) and value ranges.

Default rule:This rule applies when no other rule is satisfied, and in this case it defines the
display/representation of the element. This rule can be configured but not deleted.

Edit
By clicking on a rule in the Editing column the Parameters window will open up, allowing you to
edit the parameters for the rule.

Delete
Clicking on a rule in the Delete column deletes the rule.

Edit as New

Clicking on a rule in the column Edit as New will create a new rule on the basis of the existing
rule.

New Rule

You can create new or additional rules via the button New Rule.
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Fig. 120: Rules

Selecting arule
= Click on the field Value to access the rule selection

[i] In the rule selection you will have access to a comprehensive selection of conditions. The
rule definition in the lower part of the window will change to match the chosen rule format.

®=  To define a rule you first need to select an address. Click on the arrow to display the
selection of available addresses (all of the addresses contained in the data pool).

Fig. 121: Rule selection window

®= In the field on the right you can enter the values for the rule.
®=  Click on OK to use this rule.

[il The settings for the background and the test selection are described in the section entitled
Background & lettering.

= To create the new rule click on the Save button.
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Displaying arule

All of the defined rules are listed in the Display rule menu under the Rule Editor. The display of
the selected rule is shown in the editor. This makes it possible to check the different
displays/representations of the switching states of elements.

[il After making any changes during configuration, click on the Accept button at the bottom
edge of the window, as otherwise the changes will be discarded.

Order of priority

If several rules are satisfied at the same time then the rule with the highest priority takes effect.
Priorities are defined as follows:

1. Fixed comparisons (inputl = x)

2. Value ranges (X < inputl >y)

3. Greater/less than (inputl < x)

If the priority is identical then the rules are weighted via a ranking system:

— In the case of a value range, the rule which defines a narrower value range has a higher
ranking.

— Inthe case of "greater/less than" ranges the rule with the smaller difference to the value
at Inputl takes priority.

If the ranking of different rules is also identical then the rule which comes first in the list takes
priority.

14.9 Control element - simple

The Control element - simple option is used to create switches and buttons. One status can
be transmitted when an element is pressed and released. The representation of a simple control
element can be defined for the following states:

—  Standard
— Mouseover (i.e. when the mouse pointer is pointing at the element) and
— Mouse pressed (i.e. when the user clicks on the element)

Defining a simple control element

=  Click on an element and enable the element type Control element - simple.

Fig. 122: Element types

[i] After making any changes during configuration, click on the Accept button at the bottom
edge of the window, as otherwise the changes will be discarded.
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Basic configuration

Fig. 123: Rule selection example

Upon pressing
Here you specify the value which is to be sent when the button is pressed. This could be a fixed
value or a calculated value.

= Click on the field Upon pressing to display a selection of options.
The lower part shows the selection of available addresses (all in the data pool).

Fig. 124: Rule selection

In the example shown above (Fig. x), a "1" is sent to the address "output” whenever the
control element is pressed.

However, it is also possible to send the differences or the sum of an address and a fixed
value x via the output.
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Upon release

The settings for the value which is to be sent when the button is released are selected in the
same way as for when the button is pressed.

By combining these two functions, it is for example possible to configure a switch which
transmits a "1" when it is pressed and a "0" as soon as it is released.

Appearance

Here you can define the displays for the three states described below. The Enable option must
be selected before the display/representation can be changed.

Fig. 125: Rule selection example

Standard

These settings for the background and text selection apply under normal
conditions.

Mouseover

This display/representation becomes visible in the visualisation when the mouse pointer rolls
over the control element. For example, the current value/status can be displayed in the form a
character string.

Mouse pressed
This display/representation applies when the element is actuated.

For information about parameterisation of the background and the text selection please refer to
the section entitled Background & lettering.

[i] After making any changes during configuration, click on the Accept button at the bottom
edge of the window, as otherwise the changes will be discarded.

14.10 Control element - complex

This element is used to realize complex control elements. This control element is a combination
of a display element and a simple control element. It is an input-dependent control element. It
can be used for example to create a shutter switch which deactivates its function if a wind alarm
is issued.

Rules are used to define which values are sent when the element is operated. These rules also
determine how the element is displayed/represented.

Defining a complex control element

= Click on an element and enable the element type Control element - complex.

[i] After making any changes during configuration, click on the Accept button at the bottom
edge of the window, as otherwise the changes will be discarded.
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Configuration

In order to make it as easy as possible to understand handling this element, setting options
were taken over from the other element types. The configuration and process for creating rules
are the same as for the display element - refer to the chapter entitled Display element.

For details on configuration of the control functions refer to the section entitled Control element
- simple.

Additional information for the complex control element

The complex control element has an additional parameter.

Keep value

When this parameter is set, the current rule also applies if the input value changes between
when the mouse button is pressed and when it is released.

14.11 Saving the project
After configuration the project is saved.

= Under the File menu select the option Save and give the panel a name.
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15 Firmware Updates with IP Control Update Tool

It is possible to load new firmware into the device by means of the IP Control Update Tool. The
Update Tool is a Java program that can run on all operating systems. During this procedure, it is
extremely important to read and observe the following information carefully If the update
procedure fails, IP Control might have to be returned to the manufacturer.

15.1 Important measures:

First create a current backup of your project if it has not already been done anyway. IP Control
is reset to the factory settings by an update, the project data are therefore lost.

[i] Please note that the passwords of the visualisation users are not copied during recovery.
Please note that you can reenter these after the update procedure and project recovery.

®=  For an update you need the Update Tool and the desired firmware image. This is delivered
as a zip file together with a checksum file in order to check the correct transfer and avoid
any errors. Both of these can be downloaded in the download area at http://www.berker.de.
Both files have to be unzipped in a directory.

= We strongly recommend that you carry out the firmware update only within sight of the IP
Control. IP Control reproduces a status feedback via its five LEDs during the update
procedure. A firmware update via one or more networks is not possible, they must be in the
same physical and logical network as the IP Control.

= |f you operate your IP Control with DHCP, you should switch this off and assign IP Control
a fixed IP address.

[i] For the update you need the IP Control string and password of the user "admin"”.

[il During the firmware update, IP Control is reset to the factory settings, i.e. it retains its old IP
address xXx.XXX.XxXx.Xxx but has been overwritten with the password "berker".

[il The entire update procedure lasts approximately 15 min.

15.2 Procedure

If all the necessary measures have been made, please proceed as follows:

[il Switch off all security software and/or firewall for the update procedure since this might
disturb the communication. (The communication takes place on the UDP port 1735).

= Creating backup
If you have not already done so, make a backup of the current project.

=  Opening update tool
Open the update tool. All relevant information and tips are summarised in the help text of
the update tool.

= Selecting IP Control
Select the desired IP Control in the left column and enter the IP Control string and admin
password on the right.

[i] Selecting IP Control
Select the desired IP Control in the left column and enter the IP Control string and admin
password on the right. If the device is in the same network, the text has a green
background, if it is not in the same network, it has a yellow background. Below the display
is a display of the necessary IP Control parameters. Experienced IP Control users will
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know this from the Discovery Tool. If several IP Control are installed, the IP Control can be
identified visually by means of the "LED Test".

= Starting rescue system
Press the button "Start in rescue system”.

[i] In the status window below, you will be shown which actions are being executed. If the IP
Control system is already installed with a rescue system, it will be restarted with this. If the
device has not yet been equipped with the system, this step will first be executed.

[i] The selected device first appears in the list of the IP Control with a blue background. If the
rescue mode is active, it appears there with a green background and with a red cross. On
the device itself, the power LED orange lights up at this moment, the LAN LED flashes
depending on the network traffic and the BMX LED flashes red.

= Selecting firmware file
If the IP Control is in rescue mode, the view in the Update Tool changes and the request to
select the correct firmware file appears on the right. When opening the image file, the
Update Tool checks whether the firmware image was transferred correctly during download
by means of the md5-checksum included.

The update procedure can now be started by pressing the button "Start IP Control Update”.
After the firmware file is loaded into the device, the IP Control is busy checking the file for
approx. 5 min. Now the BMX and EIB LED flash red simultaneously.

After successful checking, the installation begins. This procedure takes approx. 5 minutes
again. During this time, the three middle LEDs flash red.

[i] IP Control should not be disconnected from the power supply under any
circumstances during the entire procedure. This can cause irreparable damage to
the software, the device must be returned.

=  Factory settings
If the firmware is installed, the IP Control restarts. Afterwards, it is in the network with the
factory settings. It therefore has the IP address assigned by you xxx.Xxx.XxX.xxx but the
password for the user "admin" is now "berker".

= Recovering backup file
Load your current backup into the device. All the settings are recovered, and the device
restarts. Afterwards, it is available with all known settings but new firmware.

[i] Please note that the backup file does not contain any information about the IP address
settings. During the backup, only the port settings are saved but not the IP address settings
(except for NTP timeserver)!

®=  Recovering user administration
The user passwords must be reentered so that the user login on the Visualisation works
perfectly again. Afterwards, the project must be saved once again.

[il During the recovery of your project file, please bear in mind that no projects from
newer firmware versions may be loaded into older versions.
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Appendix 1: Status LED

Description of the LED functionality

The current operating status of the IP Control is signalled by means of an LED which is
positioned on the front panel of the device.

[i] During the boot-up phase the POWER LED lights up orange for approx. 30 seconds. The
end of the boot-up phase is indicated by a test of all LEDs. After the end of the boot-up
phase the POWER LED lights up green.

The LEDs also indicate the following states:

POWER LED
OFF

GREEN
ORANGE

Flashing every 1 second

Flashing every 2 seconds

BMX LED
OFF

RED

RED, flashing
GREEN
ORANGE
KNX LED
OFF

RED, flashing
GREEN
ORANGE
LAN LED
OFF

GREEN
ORANGE

The device is ready for operation.
There is no operating voltage present.

The device is ready for operation.
The IP Control is still in the boot-up phase (approx. 30 seconds).

The BCU is not yet configured, or it is incorrectly configured
with the ETS.

The BCU has been configured with illogical data
(implausible IP parameters, MSN, password).

No data exchange with the IP Control program kernel
Device in ETS mode

ETS traffic

Data exchange with the IP Control program kernel
Fallback from ETS mode to BMX mode

The IP Control has no connection to the KNX.

The IP Control is attempting to establish contact to the KNX.
The IP Control has contact to the KNX.

The IP Control is exchanging data with the KNX.

The IP Control has no connection to the LAN.
The IP control has a physical connection to the LAN.
The IP Control is exchanging data with the LAN.
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Appendix 2: Control characters for values in text
messages

IP Control can send out values. To do this, control characters need to be inserted into the body
of the text according to the relevant EIS value. First of all the corresponding EIS type needs to
be parameterised.

Vales are displayed by placeholder characters % (always without quotation marks) within the
text. The following format is used for all numerical values:

%|[No. of digits before decimal point. No. of decimal places after decimal point]f
These placeholder characters can be inserted anywhere in the body of the text.
Examples:

A floating point number with five digits and two decimal places is to be displayed. The following
is entered in the text:

“... Text %5.2f Text ..."

If the sign is also to be displayed in the text then the entry must appear as follows. The following
is entered in the text:

“.. Text -5.2f Text..."

If exactly the matching number of digits is to be displayed in the text then the entry must appear
as follows. The following is entered in the text:

“... Text %.1f Text..."

If the percentage symbol is to be displayed within the text then the text must be entered as
follows: %%. Example of a text entry:

"The tank is %.1f%% full."

The following text would then be displayed in the text (e.g. e-mail):
"The tank is 82.3% full."

If a value of type EIS3 (time) or EIS4 (date) is selected then the following character combination
needs to be placed in the text: %s.
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Appendix 3: Technical data

Operating voltage: 10-30V
Power draw: <=5VA
Bus voltage: via KNX

[i] The IP Control is equipped with a gold cap condenser for data buffering. This guarantees
buffering of the internal clock for an operating voltage failure of approximately 30 minutes.
The data remain permanently saved in the flash memory.

Climate resistant: acc. to EN 50090-2-2
Ambient temperature: 0-35°C
Storage temperature: -20 - +700

Rel. humidity (non-condensing) 5% - 80%

Mechanical data

Dimensions: DIN rail mounted device; (8 modular widths @ 18 mm)
Housing: Plastic
Weight: approx. 0.4 kg
Mounting: Top hat rail (acc. to EN 50022)
Protection system: IP20 (acc. to EN 60529)
Other features of the device:
Operating system Embedded Linux
Java version 1.5 or higher required
Processor 586DX, AMD Elan
Interfaces KNX, Ethernet
Software Integrated browser visualisation;

Integrated startup software;
WAP gateway
EIBlib/IP and KNXnet/IP

Memory 64 Mbyte RAM
KNX data points Administration of all KNX group addresses
KNX memory History memory (20,000 telegrams)
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Appendix 4: Network and browser settings

The IP Control supports Internet browsers in conjunction with a run capable Java Virtual
Machine (VM) version 1.5 or higher.

Fast network installation

The connection between the PC and IP Control is normally established via Port 80 (HTTP) and
Port 1735 (Java Applet data traffic). Access to these ports must be provided at all times, for
example when you have integrated a router or firewall between the Client Browser and the IP
Control.

In the event of any connection problems, we strongly recommend first setting up an installation
with a crossover cable connected directly between the PC and the IP Control.

Fig. 126: TCP/IP properties

An IP address in the same subnetwork is assigned to the PC (this means that only the last digit
in the IP address is different between the PC and the IP Control — based on the use of a
subnet mask of 255.255.255.0).

The default IP address of the IP Control is 192.168.1.10. Assign an IP address of e.g.
192.168.1.25 to the network card of your (under Network Settings -> TCP-IP Properties).

[i] Important! In our example, it is vital that the first three segments of the IP address are the
same and that the last segment is different.

IP-Control 192.168.1.10
PC 192.168.1.25
Subnet mask 255.255.255.0

For more information about network configurations please refer to the handbook for your firewall
and/or router, or ask you system administrator.

[i] Important! A connection must be provided between the Browser Client and the IP Control
via Port 80 and Port 1735 (default setting).
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ETS

To use the IP Control as an interface for the KNX programming, it must be ensured that the
IETS server is activated in the configuration tool. This can be checked under System >
Configuration > extended EIB (yabus) or (bxd) Settings. The EIBLib/IP server must be activated.
Furthermore, the IP Control must have a valid gateway address. And a DNS server must be
entered (under: System > Configuration > Network settings).

Fig. 127: ETS - Interface configuration

The protocol must be selected in the interface configuration of the ETS. Under: Extras > Options
> Communication, a new interface can be configured.

The interface must be given a unique name. For server, the IP address or dynDNS address
must be entered, under which the IP Control is reachable. Protocol (TCP) and the ports (50000-
50002) are preset.

[il The connection of the ETS must always be terminated properly (Offline-Button and File >
Terminate). Otherwise, the IP Control may remain in iETS mode and no services or
switching operations will be executed.
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Appendix 5: Camera

With IP Control you can have images from network cameras displayed directly in the
visualisation or in a dedicated window. With the Event Camera function, the system
automatically switches to the visualisation page with the camera image or places the window
with the camera image on top whenever triggered by the corresponding group address.

Integrating a camera

Every network capable camera can be integrated in the visualisation.

Displaying a camera feed in a dedicated window

"  |nsert a new camera element and enable the option "As icon".

= Inthe URL field, enter the full network path to the camera, preceded by HTTP:// (e.qg.
HTTP://192.168.1.2).

Displaying a camera image as an image in the visualisation

" |nsert a new camera element. The option As icon must not be enabled.

= |nthe URL field, enter the full network path to the image memory of the camera, preceded
by HTTP:// (e.g. HTTP://192.168.1.2/record/current.jpg).

MJPEG camera

®=  |n order to embed an MJPEG stream in the visualisation, select the MJPEG camera option
and enter the network path for the camera.

Event camera

In order to automatically display the camera image in a separate window when triggered by the
corresponding group address, enable the option "As icon".

® Inthe URL field, enter the full network path to the camera, preceded by HTTP:// (e.g.
HTTP://192.168.1.2).

In order to automatically change to the page with the camera when triggered by the
corresponding group address, the option As icon must not be enabled.

= |nthe URL field, enter the full network path to the image memory of the camera, preceded
by HTTP:// (e.g. HTTP://192.168.1.2/record/current.jpg).

[i] For the image-in-image function the camera will need to have an intermediate memory in
which the images are saved as JPEG files. The image memory path depends on the
manufacturer. Please refer to the manual supplied with your camera.
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Appendix 6: Certificate

In order to ensure that the IP Control visualisation works, a Java Applet needs to be transmitted
from the IP Control to the PC. This Java Applet is signed by Berker. When you open the editor
or the visualisation for the first time after launching the Internet browser the following security
warning will be displayed.

= Confirm the warning by clicking on Run.

[i] If you would prefer not to see the warning every time, check the option Always trust
content from this originator.

Fig. 128: Security warning
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Appendix 7: xPL requirements

In order to be able to utilise the functions of the xPL sender and receiver, the xPL Hub service
needs to be installed.

xPL Hub

The xPL Hub is part of the Windows xPL installation and required for any type of xPL
application. This service listens to the xPL telegrams from the network and passes them on to
the xPL program. The hub can support several xPL programs at the same time.

[i] Important! The xPL Hub uses the Port 3865, which must be enabled in the firewall.

xPL Hal Manager

The xPL Manager allows you to see all of the XPL participants in the network. In the xPL Hal
Manager you can also find the values for xPL Manufacturer, xPL Device and xPL Instance
under xPL Devices. The manager also provides a monitor and a send function in order to test
the settings. The xPL Hal Manager is not absolutely essential for the SlimServer function, as it
only makes it easier to adjust and test the settings.

"ﬂ, x®PLHal Manager

Eile Wiew Tools Help

-2 192168 51.200 Wendar | Device [ Instance
E-Ld| Seripts BERKER IP-COMTROL BTO120019
g Determinators SLIMDEY SLIMSERY 192168512
- Ewvents
-l %10
] <L Devices
[ Globals

Fig. 129: xPL Hal Manager window

Further information about installation and settings, as well as links for downloading the xPL Hub
and the xPL Hal Manager, can be found on the Internet under www.xplhal.org.

Addressing the xPL devices

The address of the xPL devices looks like this:
[manufacturer]-[device].[instance]

For the SlimServer, this corresponds to the following address:
Oslimdev-slimserv.instance

The IP Control always transmits under the address
Oberker-1P-Control.[serial number]

These values can be found in the xPL Hal Manager under xPL device. The instance
corresponds to the name of the Squeezebox, e.g. LIVING ROOM. When assigning a name to
the Squeezebox, please note that it must not exceed a length of 15 characters. The names of
the Squeezeboxes can be assigned via the SlimServer (Settings > Player).

[i]l If a Squeezebox has not yet been given a name then the xPL Hub will take the numerical
sequence from the IP address as its name. Subsequent changes to the IP address will not
be carried over by the xPL Hub, so it is important to give each Squeezebox a clear and
unigue name. This is done with the aid of the SlimServer under Settings -> Player.
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xPL settings

It is easiest to access the xPL settings via the monitor of xPL Hal Manager. There you can see
all of the xPL datagrams in the network and derive the individual parameters. The screenshot
below shows part of the monitor. All of the required information is contained in the lower part of
the window.

Fig. 130: xPL Monitor
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Appendix 8: E-mail provider

As well as setting up the configuration, you also need to set up an e-mail provider before you
can send e-mails. The set-up is performed in the configuration tool, along with the associated
settings.

=  Click on the Configuration tab.
= In the left-hand column, click on E-mail.

=  The window for managing and setting up e-mail providers (Figure 35) will open.

Fig. 131: E-mail configuration

u Click on the Add button.

The IP Control will create a new blank form in which the following parameters need to be
entered.

[i] The settings chosen here will depend on your e-mail provider/e-mail server.
=  Use the following settings to create an e-mail provider:
Entry

This entry contains the created e-mail provider in the IP Control. This entry
needs to be specified when configuring the e-mail job.

Provider name

This is the name under which the provider will be displayed and managed in the configuration
tool.

Active

This entry is used to enable or disable individual providers.
Default entry

Select this to use the current provider as the default provider.
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SMTP server

The name of the SMTP server (outgoing mail server) should be entered here, e.g.: mail.gmx.de
SMTP port

Enter the name of the port here which is used by the SMPT server.

User authentication

Depending on the SMTP server, authentication may be required. This entry must be enabled if
this is the case.

Use TLS

This entry should be enabled if you would like the connection to the SMTP server to be
encrypted.

Requires TLS

This entry should be enabled if the SMTP server requires an encrypted connection. This also
depends on your provider and the server settings.

SMTP server user name

This is the user name (e-mail account name) which is used by the IP Control to log on to the
SMTP (outgoing mail server).

SMTP server password

Enter the password which belongs to the e-mail account here. You will be asked to enter it a
second time for verification.

"Realm"

Enter the realm to be used for the authentication here. This entry is not required for every
provider or outgoing mail server in order to send out e-mails. Ask your provider or the
administrator of the outgoing mail server.

"From:" Actual name

This is the name under which the e-mail is dispatched if no name was specified during the
configuration of the e-mail job.

"From:" Address

The e-mail is dispatched via this e-mail address if no address was specified during the
configuration of the e-mail job.

Company and signature
These are both optional pieces of information which are inserted into the e-mail.

[i] You can send test e-mails via the already created providers in order to test the network
side of the installation. If you are unsure about the settings for an e-mail provider, the
easiest thing to do is to test them with one of the commonly used e-mail programs
(Outlook, Thunderbird).

To do this, simply create an account with the same settings. Please note that the settings in
the IP Control only affect the outgoing mail server, as it only sends out e-mails but cannot
receive e-mails. With the network settings, enter a DNS server for your Internet provider.
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Appendix 9: URL parameters

When connecting to the IP Control, it is possible to transmit login parameters directly in the
URL. The following URL will take you directly to the visualisation:

<IP-Control>/bmxJava2/visuPlain.php

The familiar default page can be reached via the following URL:
<IP-Control>bmxJava2/default.php

<IP-Control> = IP address/name of the IP Control

The start page options can be configured in the configuration tool (refer to Start page in the
section entitled Configuration tool).

Login parameters

The following syntax needs to be followed when attaching parameters to the URL. Here, the
parameters are separated from each other by the ampersand symbol (&) and from the URL with
a question mark (?).

Example:

IP-Control = 192.168.1.10
Username: username = xXXx
Password: password = yyy
Login autologin = true / false

Example URL:
192.168.1:10/bmxJava2/visuPlain?username=xxx&password=yyy&autologin=true

The autologin parameter is an optional parameter. Its default value is "true".

— If autologin = true then the user is logged in without any further queries.
— If autologin = false then the fields in the login dialog are filled in with the specified user
name/password. These need to be confirmed to log in.

[i] In some cases it is possible to log in under a different name.
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Appendix 10: Expanded clock options

The jobs Week time switch and Year time switch can be used to switch group addresses at
certain times (e.g. for automatic lighting).

Monitoring time jumps

If the switching time is skipped (e.g. due to a new clock time from an NTP server) then the
group addresses are not switched. You can prevent this by enabling the Monitor time jumps
option in the Job Editor.

Once this is done group addresses will still be switched if their switching time is in a period of
time which has been skipped.

Local operation

If this checkbox is activated then local operation is not possible. The telegram value of the
output address is only defined by the clock.

Initialise clock

When this checkbox is activated the clock sends the current telegram value after an initialisation
phase (restart of the IP Control, changes to the clock parameters). If this function is not enabled
then the telegram value is only transmitted at the defined switching points.
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Appendix 11: EIS 15 Multiplexer

The job EIS 15 Multiplexer can be used to send pre-defined texts on the basis of EIS 14
values.

Input object

Triggering object of the service. Format: EIS 14

Active

Enables or disables the relevant command.

Wildcard

When this checkbox is selected the command is sent for every input value.
Trigger

The command is sent when the entered value is received.

Overwrite

When this checkbox is selected the output object can be overwritten with the text.
Text

This EIS 15 text is transmitted.

EIS 15 output

The text is transmitted to this group address.
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Item |EIS type |[Description Resolution |Datatype |Valuerange
1 EIS1 Switching 1 bits DPT 1.001 |[0..1]
2 EIS 2 Switching 1 bits DPT 1.001 [0 .. 1]
3 EIS 2 Dimming (relative) 4 bits DPT 3.007 |[Brighter .. darker .. stop]
4 EIS 2 Dimming value (absolute) 1 bytes DPT 5.001 ([0% .. 100%]
(increment size 0.4%)
5 EIS 3 Time 3 bytes DPT 10.001
6 EIS 4 Date 3 bytes DPT 11.001
7 EIS5 Floating point number 2 bytes DPT 9.xxx |[-671088.64 .. 670760.96]
8 EIS 6 Scaling 1 bytes DPT 5.xxx  |[0x .. 255xX]
(increment size x)
9 EIS 6 Percentage 1 bytes DPT 5.001 |[0% .. 100%]
(increment size 0.4%)
10 EIS 6 Angle 1 bytes DPT 5.003 ([0° .. 360°]
(increment size 1.41°)
11 EIS7 Drive control, moving (direction) 1 bits DTP 1.008 |([Up (O) .. Down (1)]
12 EIS 7 Drive control, step (direction) / stop 1 bits DTP 1.007 |([Up (O) .. Down (1)]
13 EIS9 Floating point number 4 bytes DPT 14.xxx |[- 3.4028*10"38 ..
(high accuracy) 3.4028*10"38]
14 EIS 10 Integer without sign 2 bytes DPT 7.001 ([0 .. 65536]
15 EIS 10 Integer with sign 2 bytes DPT 8.001 |[-32768 .. 32767]
16 EIS 11 Integer without sign 4 bytes DPT 12.001 ([0 .. 4294967296]
(large value range)
17 EIS 11 Integer with sign 4 bytes DPT 13.001 |[-2147483648 .. 2147483647]
(large value range)
18 EIS 14 Integer without sign 1 bytes DPT 5.010 ([0 .. 255]
(small value range)
19 EIS 14 Integer with sign 1 bytes DPT 6.001 |[-128 .. 127]
(small value range)
20 EIS 15 Character string 14 bytes DPT 16.000

(14 ASCII characters)
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Iltem |Data type Description Resolution [EIS type |Value range
1 DPT 1.001  |Switching 1 bits EIS 1 [0..1]
2 DPT 1.001  |Switching 1 bits EIS 2 [0..1]
3 DTP 1.007 |Drive control, step (direction) / |1 bits EIS 7 [Up (O) .. Down (1)]
stop
4 DTP 1.008 |Drive control, moving (direction) |1 bits EIS 7 [Up (0) .. Down (1)]
5 DPT 3.007 |Dimming (relative) 4 bits EIS 2 [Brighter .. darker .. stop]
6 DPT 5.xxx Scaling 1 bytes EIS 6 [Ox .. 255x] (increment size X)
7 DPT 5.001 |Dimming value (absolute) 1 bytes EIS 2 [0% .. 100%]
(increment size 0.4%)
8 DPT 5.001 |Percentage 1 bytes EIS 6 [0% .. 100%]
(increment size 0.4%)
9 DPT 5.003 |Angle 1 bytes EIS6 [0° .. 360°]
(increment size 1.41°)
10 DPT 5.010 |Integer without sign (small value |1 bytes EIS 14 [0 .. 255]
range)
11 DPT 6.001 [Integer with sign (small value 1 bytes EIS 14 [-128 .. 127]
range)
12 DPT 7.001 |Integer without sign 2 bytes EIS 10 [0 .. 65536]
13 DPT 8.001 |Integer with sign 2 bytes EIS 10 [-32768 .. 32767]
14 DPT 9.xxx  |Floating point number 2 bytes EIS 5 [-671088.64 .. 670760.96]
15 DPT 10.001 |Time 3 bytes EIS 3
16 DPT 11.001 |Date 3 bytes EIS 4
17 DPT 12.001 |Integer without sign (large value |4 bytes EIS 11 [0..4294967296]
range)
18 DPT 13.001 |[Integer with sign (large value 4 bytes EIS 11 [-2147483648 .. 2147483647]
range)
19 DPT 14.xxx |Floating point number 4 bytes EIS 9 [- 3.4028*10"38 .. 3.4028*10"38]
O(high accuracy)
20 DPT 16.000 |Character string 14 bytes EIS 15

(14 ASCII characters)
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